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 Welcome to Teachucomp, Inc.’s Mastering Windows 

Made Easy v. 8-Vista course. This course is designed to 

introduce the new computer user to the concepts and skills 

necessary to operate in the Windows environment.  

 Microsoft Windows is an operating system that controls 

the overall activity of your computer. Many software 

applications, such as Word- a word processing program, 

Excel- a spreadsheet program, and Access- a database 

program, operate in a Windows environment.  

 Mastering Windows is essential in today’s world of fast-

paced technology growth. Windows is one of the most 

commonly used operating systems for Desktop computers. 

Now, however, mobile computing can be performed on 

Desktop computers, laptops, and tablets. Starting with 

Windows 8, which can be installed on many of your 

devices, you can now share a more standardized and 

unified computing experience between your devices. 

 This class is designed to give you a general overview 

of the functionality of Windows in the versions of Windows 

called Windows 8 through Windows Vista. In this course, 

we will explore the basics of using these versions of 

Windows: working with files, saving documents, 

customizing your computer and using the Internet. 

Introduction and Overview 
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Introduction to Windows 

1.1- About Windows: 

 

 Windows is a family of operating systems developed by Microsoft Corporation. Windows provides a 

graphical user interface (GUI), virtual memory management, multitasking, and support for many peripheral 

devices. Starting in Windows 8, you also have a new “Windows 8” style interface that provides a standard 

user interface across your computing devices to create a unified user environment. The name Windows 

describes the basic function of the operating system- it lets you look into the content of your computer, just 

like looking through a window. 

 Windows helps you organize all of the files and programs within your computer. For new users, one 

way to think of Windows as a large paper filing cabinet. Within the filing cabinet, there are hanging files 

labeled in a logical order. Within those hanging files, there are manila file folders that contain sub-sets of 

information. Windows allows you to accomplish the same filing system in an electronic format. You can 

open, sort, move, print, rename, find or delete files easily by using Windows. In addition to managing the 

computer’s files, folders, hardware settings, and software applications, Windows has much more to offer. 

Windows offers basic text and image editing software, as well email and a web browser called “Internet 

Explorer.” 
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Introduction to Windows 

1.2- The Start Screen in Windows 8: 

 

 The Start screen is a new addition to Windows 8. This is the interface that is available on desktops, 

laptops, as well as tablet PCs. Within the Start screen, you can scroll across the tiles shown in order to view 

the programs on your computer. Each tile represents an application, which is often shortened to “app.” 

Apps, or applications, are all simply software programs that run on your computer. Some app tiles within the 

Start screen are called “Live Tiles,” and display information about the particular app, such as the number of 

unread emails in your “Mail” application tile. You can acquire new apps for your computer by accessing the 

new Windows “Store” app within the Start screen. To open an app within the Start screen, simply click on 

the desired app icon shown. Older applications that run in a Desktop environment will still need to be run 

within the Desktop- which is now treated as if it were just another Windows 8-style app. There have been 

many other changes to using the traditional computer Desktop, as well. However, we will review the 

changes to the Desktop in Windows 8 within the section on the Desktop environment within Windows 8. 

 This Start screen is based on the Windows 8 screen style that was popularized on the Windows 

phone and incorporated into the Xbox screen. Now it is making its appearance in Windows 8, which allows 

for a more consistent user experience whether you are using a Windows Phone, an Xbox gaming system, 

or a computing device. 

 When using the Start screen, you can navigate using either a mouse or touch-based interface such 

as a tablet screen or touchpad. The Start screen uses hotspots within the corners of the screen to allow you 

to access other areas of your computer. For example, you can place your pointer to the upper-left side of 

the screen to display a small tile window of the most recent opened application. You can then slide your 

mouse pointer down the left side of the screen to then display any other opened app windows in a tiled 

sidebar that then appears. You can then click on the desired app window tile to open it in full-screen mode. 

Within any app, you can roll to the hotspot in the lower-left corner and click to return to the Start screen. 

Alternately, you can press the Windows key on your keyboard to display the Start screen at any time. 

 You can access a charm bar at the right side of the window by simply rolling your mouse pointer 

over to the upper-right or lower-right corners of the screen. The charm bar will then appear and you can roll 

your mouse pointer over it in order to access its content. You can also open it by swiping in from the right 

edge of a touch screen, or by simply pressing the Windows + C keys on your keyboard. This will often allow 

you to perform actions such as sharing and saving content between your app and online storage, such as 

SkyDrive, which is included in Windows 8. The default icons shown within the charm bar when viewing the 

Start Screen are “Search,” “Share,” “Start,” “Devices,” and “Settings.” 

 Some apps, such as the Windows 8 Internet Explorer 10, also allow you to switch between opened 

browser windows by placing your pointer at the top of the app screen, and then right-clicking to display the 

opened windows within the app in a separate bar at the top of the app window. You can then click on the 

browser window that you want to display. 

 When you have an app opened in the Start screen, you can close it by clicking at the top of the app 

window to grab the app window, and then dragging it off the bottom of the screen. You can also simply drag 

the app window to either the right or left sides of the interface to dock the app to keep it open while running 

other apps. Also note that for users of the tablet versions of Windows 8, you have access to an on-screen 

keyboard that you can use for text entry to replace the traditional keyboard. 

  For Desktop users, you can access the Desktop by clicking the tile icon for it within the Start screen. 

Also, if you click on any app icon for any legacy software applications that require the Desktop, Windows 8 

will automatically switch to the Desktop in order to run the associated program. You can always return to the 

Start screen by rolling your pointer to the lower-left corner and then clicking the Start screen icon that 

appears. The Desktop app works in much the same way as it always has in prior versions of Windows- with 

the notable exception of the “Start” button in the lower-left corner being replaced by the Start screen. Sa
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Introduction to Windows 

1.3- Customizing the Start Screen in Windows 8: 

 

 You can customize the appearance of the Start screen in numerous ways. You can control the 

placement and grouping of the app tiles, as well as name the tile groupings that you create. You can also 

customize the appearance of many of the individual app tiles themselves within the Start screen. In this 

lesson, we will examine how to make these types of customizations to the Start screen. 

 When you install apps from the Windows Store, you will see a new tile for the app appear on the 

Start screen. You can also add tiles to the Start screen for legacy Desktop applications if you are upgrading 

to Windows 8. To do this simply find the executable or application icon for which you want to add a Start 

screen tile within the Desktop, and then right-click the icon. From the pop-up menu that appears, select the 

“Pin to Start” command to add a tile for that program to the Start screen in the next available tile icon 

position within the most recent tile group. If you can’t find the application through the Desktop, you can find 

it through the Start screen. You can display tile icons for all of the applications on your computer by right-

clicking in the empty space within the Start screen. At the bottom of the Start screen, an options bar will 

appear. Click the “All apps” icon within this bar to display a listing of all of the available apps within the Start 

screen. You can then find the app that you want to pin to the Start screen within this list. Then right-click on 

the desired app to display the options bar at the bottom of the screen again. This time, click the “Pin to 

Start” icon within the options bar to pin the selected app to the Start screen. Note that if you right-click on an 

app by mistake, you can right-click it again to hide the options bar that appears. 

 You can remove an app from the Start screen by right-clicking the app to remove to display the 

options bar. Then click on the “Unpin from Start” icon within the bar to remove the app from the tile grouping 

within the Start screen. 

 You can arrange the app tiles within the Start screen by simply clicking and dragging them to the 

desired location, then releasing them when they are in the desired position within the tile group. You can 

also create new tile groups by clicking and dragging the app’s tile icon to the far right side of the Start 

screen, past the thin bar that then appears once you have dragged it as far to the right as possible, and 

then releasing the app tile to create a new tile grouping. 

 You can also name the app tile groupings that you create so that you can easily tell what types of 

apps are located within a group. For example, you could create a “Microsoft Office” tile grouping for your 

Microsoft Office application tiles within the Start screen. After creating the tile group, you can name the 

group by clicking the small button that appears at the far right end of the scroll bar at the bottom of the Start 

screen. The app tiles will then be shrunk down and displayed by grouping across the screen. Simply right-

click on the grouping that you want to name to display the options bar. Then click the “Name group” button 

within the bar. Then type a name for the group of tiles into the text box that appears, and click the “Name” 

button to finish naming the tile grouping. You can also click and drag on the tile groupings that appear to 

reorder the tile groupings on your Start screen. When you are finished managing your tile groupings, simply 

click on the Start screen to return to the normal Start screen view. 

 You can also customize the settings of the individual app tiles within the Start screen. To do this, 

simply right-click on any app tile to display the options bar at the bottom of the screen. You can then click on 

any option shown within this bar to apply the desired setting. The settings will vary, depending upon the app 

tile that you selected. However, common option include “Smaller,” “Larger,” and “Uninstall.” Note that if you 

do not want to make any changes to the selected app tile, you can right-click on it again to make the option 

bar disappear. 
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Introduction to Windows 

1.4- Using the Charm Bar in Windows 8: 

 

 You can use the Charm Bar that appears at the right side of the Windows 8 application to search for 

content, share content within apps, return to the “Start” screen from an app, manage connected devices, 

and access your device settings. You can access the Charm Bar at the right side of the window by simply 

rolling your mouse pointer over to the upper-right or lower-right corners of the screen. The charm bar will 

then appear and you can roll your mouse pointer over it in order to access its content, displayed as buttons 

within the Charm Bar. You can also open it by swiping in from the right edge of a touch screen, or by simply 

pressing the Windows + C keys on your keyboard. 

 To search for content on your computer, click the “Search” button within the Charm Bar. This will 

display a “Search” pane at the right side of the window. To search for an item, type the text that you are 

searching for into the text box shown at the top of the “Search” pane. You will then see any matching results 

for the three categories of results shown immediately below the text box. These categories are “Apps,” 

“Settings,” and “Files.” The number shown to the right of each category shows the number of matches 

within that category. You can click on any category shown to then display the matching results in the 

window to the left of the search pane. You can then click into this window to hide the search pane and scroll 

through the results. For “Files” you will also see the results, broken down by general file type as 

subcategories, displayed at the top of the “Files” window. You can click on any one of the subcategories to 

further filter the matching results shown. When you find the item you want, simply click on the result to open 

the associated file. If you don’t find a match, you can open the Charm Bar to search again, or simply click 

the “Start” screen in the lower-left corner of the screen to exit. 

 Within apps that support sharing, such as “Photos” or “Videos,” you can select a photo, video, or 

other shareable item, and then click the “Share” button within the Charm Bar to open a side pane to the 

right that shows the available apps that you can use to share the selected item. Simply click on the name of 

the app that you want to use to share the selected item in order to open that app and attach the selected 

item for sharing. Note that if you click the “Share” button within the Charm Bar within an app that doesn’t 

support sharing, such as the “Desktop” app, you will see that information displayed in a message within the 

side pane that appears. You can then click into the area of the window where the pane does not appear to 

hide the side pane again. 

 You can click the “Start” button within the Charm Bar to display the “Start” screen again whenever 

you need it. 

 You can click the “Devices” button within the Charm Bar to display a listing of any connected 

devices whose settings you can change. For example, if you happen to be running dual monitors, you can 

click the “Devices” button to display the secondary monitor. You can then click on any device shown to alter 

its available settings within this pane. Using the example of a secondary monitor, you could then choose 

how you wish to extend your primary display onto the secondary monitor. 

 You can click the “Settings” button within the Charm Bar to display a listing of computer settings at 

the bottom of the side pane that appears. You can also click on the commands shown at the top of the pane 

to open the various “Control Panel” windows for the associated computer settings, or to access “Help” 

within Windows 8. 
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Introduction to Windows 

1.5- The Windows Desktop: 

 

 The main window in which you perform your tasks in Windows 7 and Vista is the Desktop. In 

Windows 8, the “Desktop” is simply another app that you can access from the Start screen. However, the 

Desktop is used in much the same way between all versions of Windows. In Windows 8, the “Start” button is 

removed from the Desktop, as many of the features that it provided are replaced by the Start screen. Also, 

many older programs will be opened within the Desktop app when you open older apps within the newer 

Windows 8. For example, if you add an app icon for a Microsoft Word 2007 installation to the Start screen in 

Windows 8, then Windows will open the application within the Desktop environment when you launch the 

program from the Start screen. 

 On your Desktop, you can place shortcuts to your favorite files, folders, and programs. These 

shortcuts are displayed as icons on your Desktop. The icons shown on the Desktop can be customized for 

each user account on the computer. 

 One icon that is commonly shown icon on the Desktop is the Recycle Bin. This is where files that 

have been deleted from your computer’s “C:” drive will be temporarily stored until you decide to permanently 

delete them. Note that when you delete files from removable media or network locations those files are not 

sent to the Recycle Bin, but are permanently deleted instead. So it is important when working on a network 

that you do not assume that files and folders you delete from network drives will go to the Recycle Bin. Be 

careful with the files that you delete from your computer. 

 In Windows 7 and Windows Vista, you can access many programs and files by clicking the “Start” 

button in the lower left corner of the Desktop. This will display the “Start” menu. You can select one of the 

many commonly accessed areas of your computer by clicking on a command in the listing at the far right 

side of the “Start” menu. To view all of the programs you have available, you can click the “All Programs” 

command to change the display of the left side of the panel to a listing of the programs that are available on 

your computer. You can then click on an application to launch it. 

 In the “Start” button’s menu, you can click the “Documents” command to open your default user 

folder where you can save the files that you create. Saving your files to the “Documents” folder gives you a 

consistent location to save your files, making it less likely to “lose” them on your computer’s folder system. 

When at work, you may have a different location to which you must save your files, as directed by your 

system administrator or supervisor. You should then save to that folder instead of the “Documents” folder. 

However, when at home, feel free to store your documents here. When you are finished examining the 

“Documents” folder, you can click the “X” in the upper right corner to close the window. 

  Another command button that you can access form the “Start” button’s menu is the “Computer” 

command. You can click this command to open a window that allows you to navigate through the drives, 

folders, and files that are available to your computer through Windows Explorer. 
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Introduction to Windows 

1.6- The Mouse: 

 

 One way to navigate through the Windows environment is by using your mouse. A mouse is a 

device that you control with your hand. You roll it around on a pad. This allows you to move the mouse 

pointer, usually an “arrow” icon, on your screen to select files and folders. There are many variations of the 

mouse, but they are all designed to perform the same basic functions.  

 When you move your mouse while it is on your desk, the pointer on your screen moves in the same 

direction. The mouse pointer can also assume different shapes, depending upon your location on the 

Desktop and what type of tasks you are performing. 

 To control the mouse, position your hand on the mouse with your thumb at the side and your two 

closest fingers resting easily over the two buttons at the top of the mouse. Your two fingers are used to 

press the buttons, or perform the “clicks,” of the mouse. 

 Your mouse has four basic actions to master. They are “click,” “double-click,” “right-click” and “click 

and drag” (or “drag and drop”). The different actions and what they are used for are illustrated in this table. 

Name: Movement: What it is used for: 

 

Left-click or “click” A single “press and release”  Selecting objects and executing toolbar  

 of the left mouse button button functions. 

 

Double-click Two quick “press and  Running program and applications. Also used to 

 release” movements with  open folders and files. 

 the left mouse button in  

 rapid succession. 

 

Click and drag A single press of the left  Moving file and folders. Selecting objects and text.  

 mouse button that you hold  

 down as you roll the mouse  

 to a new location and then  

 release it.  

 

Right-click A single “press and release”  Shows a pop-up menu of commands that are 

  of the right mouse button. available for the object that you right-clicked. 
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Introduction to Windows 

1.7- Touch Gestures in Windows 8: 

 

 Starting in Windows 8, many of the actions for which you previously would use a mouse can now be 

performed by using gestures on a touch screen for computing devices that support this behavior. In this 

lesson, we will examine the various gestures that are available in Windows 8 for touch screen devices, and 

which gestures translate to the traditional mouse clicks and movements. 

Name: Movement: What it is used for: 

 

“Tap” or “Touch” Tap once onscreen Opens or selected item that is tapped. Similar to a 

  left-mouse click. 

 

Press and hold Touch onscreen and hold Displays information about the selected item, or 

 your finger in position opens a menu specific to what you’re doing. Similar 

  to a right-click with a mouse. 

 

Pinch or Stretch Touch the screen with two fingers Shows different levels of information. Zooms in or out 

 and then either bring them closer to magnify items displayed onscreen. 

 together (Pinch), or further away 

 from each other (Stretch)  

 

Rotate Touch the screen with two fingers Rotates onscreen items in the direction specified. 

 and then turn your hand clockwise Not all items can be rotated. 

 or counterclockwise  

 

Slide Move your finger or fingers across Moves through onscreen content. Similar to scrolling 

 the screen with the wheel of a mouse. When used on a selected 

  item, can move the selected item. Similar to clicking 

  and dragging with your mouse. 

 

Swipe Move your finger or fingers a short If you swipe across an app tile or other selectable 

 distance across the screen item contrary to the direction the page scrolls, it will

  select the item. You can also swipe in from the right 

  edge of the screen to open the Charm Bar, swipe in 

  from the left edge to show open apps, or swipe in 

  from the bottom edge to display basic file commands. 

  You can swipe from the top of an app to the bottom 

  edge to close an app by dragging it off screen. 
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Introduction to Windows 

1.8- App Snapping in Windows 8: 

 

 While the ability to “snap” an app window to the side of the screen was introduced in earlier versions 

of Windows, you will find that snapping apps to the side of the Desktop screen is even easier in Windows 8. 

This feature allows you to lock two app windows to the sides of the Desktop so that you can have multiple 

windows open at the same time without having to toggle between them or having them overlap one another. 

 Note that in order to have app snapping enabled in Windows 8, you must be using a screen 

resolution of at least 1366 by 768. If using Windows 8, open the “Desktop” app by clicking the “Desktop” tile. 

To snap an open app window, slide the app window from the left edge, or move your mouse pointer to the 

upper-left corner of the screen until a preview window appears. When you can see the app window preview, 

drag it until a border appears, and then move the app where you want it to be positioned. Note that just as 

when you are switching between open apps, you can see a listing of the opened apps at the left side of the 

screen, and then click and drag to snap the app window that you want into position. 

1.9- Using a Microsoft User Account in Windows 8: 

 

 Windows 8 contains a new feature that allows you to use a “Microsoft” user account versus a “Local” 

user account. When you sign-in to your computer using a Microsoft user account, you will have many more 

features available to you. If you already have an old Hotmail e-mail address, an XBOX Live e-mail, a 

Windows phone, or a Windows Live e-mail, you can use those e-mail addresses as your Microsoft Account 

e-mail address. If you want to create a new e-mail address, you can sign-up for a free e-mail account at the 

new “Outlook.com” website, which used to be “Hotmail.” The website address is http://www.outlook.com. 

You can sign-in to Windows 8 using an email address and password. This email address will then become 

your Microsoft account. Note that this account can be either a “Standard” or “Administrator” account on the 

local PC on which it is entered. 

 When you sign-in to Windows 8 on a device with a Microsoft account, you will be connected to a 

computer network referred to as the “cloud.” That will allow the following features to be enabled. First, any 

social networking and email applications associated with the email address, such as Outlook.com, 

Facebook or Twitter will be updated automatically. You will also be able to access and share files on the 

web though providers such as SkyDrive or Facebook. Also, your Windows 8 settings will be synced to any 

device running Windows 8 that you sign into using the same email address. You can also get apps in the 

Windows Store and use them on any Windows 8 computing device that you sign into with the account. 
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Introduction to Windows 

1.10- Starting a Program in Windows 7 & Vista: 

 

 You can start a program in Windows 7 and Windows Vista in one of two ways. The first is to double-

click on the icon or shortcut for the application that you want to open on your Desktop. The second way is to 

go through the “Start” button’s pop-up menu. To open a program using the “Start” button, click the “Start” 

button in the lower left corner of your Desktop. You will see a pop-up menu of various choices you can 

make. Roll your mouse pointer up to the “All Programs” command. When you click it, the listing at the left 

side of the pop-up menu will change to show you the various programs installed on your computer. Roll 

over any program icon to highlight it, and then click to open it. If the program is located within a folder in the 

menu, roll your mouse pointer over the folder and then click once to see the contents of the selected folder. 

Then roll over the program that you want to open, and click it to start the application. 

 It is important to note that not every program installed on your computer makes a Desktop shortcut, 

but they all make an entry in the “All Programs” list within the “Start” menu. This can be a useful way of 

viewing the software available to you on a computer. 
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Introduction to Windows 

1.11- Resizing a Desktop Window: 

 

 The window is the basic element of the Windows operating system. You perform all of your activities 

in different windows in the application. Windows that appear within the Desktop will most often share a 

similar structure and layout. In this lesson, we will examine the features and functions that are commonly 

found within a standard Desktop window. 

 Desktop windows will appear within a frame. At the top of the frame is the “Title Bar.” The Title Bar 

will usually display the name of the window or its contents. You also use the title bar to control the size and 

placement of the window in your Desktop environment. 

 One of the most basic functions of the Title Bar is resizing windows. You can have several windows 

open at the same time in Windows, and to efficiently multi-task on your computer it is important for you to 

control the size and placement of the windows on your Desktop. A window can be opened either in 

Maximized mode, Restore mode, or Minimized mode. 

 If you look at the right end of the Title Bar within an open Desktop window, you will see a three-

button group. They are, from left to right: “Minimize,” “Maximize/Restore,” and “Close.” You can click the 

Minimize button in the Title Bar of an open window to send the window down to the Windows taskbar at the 

bottom of the Desktop. Although cannot see the content of the window, it is still open and active. You may 

choose to minimize a window to access information in a different window behind the one that you 

minimized. Minimizing a window will temporarily get it out of your way. To bring the window back, click on 

the entry for the window within the Windows taskbar. That will bring it back onscreen exactly as it was when 

you minimized it. 

 In Windows 7, when you minimize folders within your computer’s system, such as the “Documents” 

folder, the folders will often be grouped within the “Libraries” icon within the Windows taskbar. You can click 

on this icon within the Windows taskbar to then open a small pop-up window that shows you the opened 

system folders. You can then click on the one you wish to view again in order to restore the selected folder’s 

onscreen display. 

 “Maximizing” a window means making it large enough to fill your entire computer screen. If your 

window does not fill the entire screen, then click the middle button of the three located at the right end of the 

Title Bar in that window to maximize its display. This allows you to view more of the information within a 

window. Many users like to work in this mode, as it has the most available room for each window. However, 

if you have multiple windows open and they are all maximized, you cannot view them simultaneously. To 

switch between multiple maximized windows, click on the Windows taskbar icon for the window that you 

want to view. That will bring that window to the forefront of the stack of windows, above any other opened 

windows which then recede behind it. Doing this is called “toggling” between the open windows, and is a 

technique that is also necessary to master if you need to work with more than one window at a time. 

 If your window is already maximized, clicking the middle button of the three at the right end of the 

title bar will instead change the window to its “Restore” mode. The Restore window is a smaller window that 

allows you to change its size and position within the Desktop area. When the window is in Restore mode, 

you can place your mouse pointer over the border of the window’s frame and then wait until you see a 

double-pointed arrow. When you see this icon appear, you can click and drag with the mouse to change the 

size of the window. You can also click and drag directly in the middle of the Title Bar of a window to move it 

to a different area within the Desktop. This mode is useful when you have files that you wish to copy from 

one window into another. The Restore window mode allows you to place opened windows side-by-side to 

make the drag and drop copying easier. 

 The last button at the right end of the title bar has a big “X” in it. This is the “Close” button, and 

clicking it will close the window. Sa
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Introduction to Windows 

1.12- Scrolling a Window: 

 

 In longer web pages or documents that you have opened, you will need to use the available scroll 

bars within the window to move through the information. Scroll bars will appear at the right and bottom sides 

of a window if all of the window’s contents cannot be displayed at once. To scroll through the content within 

a window, you can click the arrows located at either end of the scroll bars to scroll the window in that 

direction. You can also click and drag the box inside the scroll bars to the desired location in the window 

and then release it to scroll through the content. The location of the scroll box inside of the scroll bar 

indicates your position within the content of the window. 

1.13- Shutting Down Windows: 

 

 When you need to turn off your computer, it is very important to do so properly. Do not simply 

unplug the computer or interrupt its power source! Doing so could possibly corrupt the information 

in your computer! 

 To properly shut down a computer using Windows 8, open the Charm Bar at the right side of the 

screen and then click the “Settings” button to display the “Settings” pane to the right of the screen. Then 

click the “Power” button at the bottom of the “Settings” pane to view a pop-up menu of choices. To shut 

down the computer, select the “Shut down” command from the pop-up menu. 

 To properly shut down a computer using Windows 7 or Windows Vista, place your mouse pointer 

over the “Start” button and click it to open the pop-up menu of choices. Roll your mouse pointer over to the 

right-pointing arrow in the lower right corner of the pop-up menu and click it. From the side menu that 

appears, select the “Shut Down” command to shut down Windows. In Windows 7, if the “Shut Down” 

command is shown next to the right-pointing arrow, then there is no need to click the arrow to select it. 

Instead, simply click directly on the “Shut Down” command, instead. 

 It may take a few moments before Windows will shut down entirely, so be patient. Once Windows 

has completely powered off and the computer is shut down, then it is permissible to shut off the power 

supply for the computer or unplug it if necessary. 

Scroll Box within 

a Scroll Bar 
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ACTIONS- 

Introduction to Windows 
THE START SCREEN IN WINDOWS 8: 

 

1. Within the Start screen, you can scroll across the tiles shown in order to view the programs on your 

computer. Each tile represents an application, which is often shortened to “app.” Apps, or applications, 

are all simply software programs that run on your computer. 

2. You can acquire new apps for your computer by accessing the new Windows Store app within the Start 

screen. 

3. Older applications that run in a Desktop environment will still need to be run within the Desktop- which is 

now treated as if it were just another Windows 8-style app. 

4. To open an app within the Start screen, simply click on the desired app icon shown. 

5. When using the Start screen, you can navigate using either a mouse or touch-based interface such as a 

tablet screen or touchpad. 

6. The Start screen uses “hotspots” within the corners of the screen to allow you to access other areas of 

your computer. For example, you can place your pointer to the upper-left side of the screen to display a 

small tile window of the most recent opened application. You can then slide your mouse pointer down 

the left side of the screen to then display any other opened app windows in a tiled sidebar that then 

appears. You can then click on the desired app window tile to open it in full-screen mode. 

7. Within any app, you can roll to the hotspot in the lower-left corner and click to return to the Start screen. 

Alternately, you can press the Windows key on your keyboard to display the Start screen at any time. 

8. You can access a charm bar at the right side of the screen by simply rolling your mouse pointer over to 

the upper-right or lower-right corners of the screen. The charm bar will then appear and you can roll 

your mouse pointer over it in order to access its content. You can also open it by swiping in from the 

right edge of a touch screen, or by simply pressing the Windows + C keys on your keyboard. The default 

icons shown within the charm bar when viewing the Start Screen are “Search,” “Share,” “Start,” 

“Devices,” and “Settings.” 

9. Some apps, such as the Windows 8 Internet Explorer 10, also allow you to switch between opened 

browser windows by placing your pointer at the top of the app screen, and then right-clicking to display 

the opened windows within the app in a separate bar at the top of the app window. You can then click 

on the browser window that you want to display. 

10. When you have an app opened in the Start screen, you can close it by clicking at the top of the app 

window to grab the app window, and then dragging it off the bottom of the screen. 

11. You can also simply drag the app window to either the right or left sides of the interface to dock the app 

to keep it open while running other apps. 

12. Also note that for users of the tablet versions of Windows 8, you have access to an on-screen keyboard 

that you can use for text entry to replace the traditional keyboard. 

13. For Desktop users, note that you can access the Desktop by simply clicking the tile icon for it within the 

Start screen. 

14. Also, if you click on any app icon for any legacy software applications that require the Desktop, 

Windows 8 will automatically switch to the Desktop in order to run the associated program. You can 

always return to the Start screen by rolling your pointer to the lower-left corner and then clicking the 

Start screen icon that appears. The Desktop app works in much the same way as it always has in prior 

versions of Windows- with the notable exception of the “Start” button in the lower-left corner being 

replaced by the Start screen. 
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ACTIONS- 

Introduction to Windows 
CUSTOMIZING THE START SCREEN IN WINDOWS 8: 

 

1. When you install apps from the Windows Store, you will see a new tile for the app appear on the Start 

screen. 

2. You can also add tiles to the Start screen for legacy Desktop applications if you are upgrading to 

Windows 8. To do this simply find the executable or application icon for which you want to add a Start 

screen tile within the Desktop, and then right-click the icon. 

3. From the pop-up menu that appears, select the “Pin to Start” command to add a tile for that program to 

the Start screen in the next available tile icon position within the most recent tile group. 

4. If you can’t find the application through the Desktop, you can find it through the Start screen. You can 

display tile icons for all of the applications on your computer by right-clicking in the empty space within 

the Start screen. 

5. At the bottom of the Start screen, an options bar will appear. 

6. Click the “All apps” icon within this bar to display a listing of all of the available apps within the Start 

screen. You can then find the app that you want to pin to the Start screen within this list. 

7. Then right-click on the desired app to display the options bar at the bottom of the screen again. This 

time, click the “Pin to Start” icon within the options bar to pin the selected app to the Start screen. 

8. Note that if you right-click on an app by mistake, you can right-click it again to hide the options bar that 

appears. 

9. You can remove an app from the Start screen by right-clicking the app to remove in order to display the 

options bar. 

10. Then click on the “Unpin from Start” icon within the bar to remove the app from the tile grouping within 

the Start screen. 

11. You can arrange the app tiles within the Start screen by simply clicking and dragging them to the 

desired location, then releasing them when they are in the desired position within the tile group. 

12. You can also create new tile groups by clicking and dragging the app’s tile icon to the far right side of 

the Start screen, past the thin bar that then appears once you have dragged it as far to the right as 

possible, and then releasing the app tile to create a new tile grouping. 

13. You can also name the app tile groupings that you create so that you can easily tell what types of apps 

are located within a group. After creating the tile group, you can name the group by clicking the small 

button that appears at the far right end of the scroll bar at the bottom of the Start screen. 

14. The app tiles will then be shrunk down and displayed by grouping across the screen. 

15. Simply right-click on the grouping that you want to name to display the options bar. 

16. Then click the “Name group” button within the bar. 

17. Then type a name for the group of tiles into the text box that appears, and click the “Name” button to 

finish naming the tile grouping. 

18. You can also click and drag on the tile groupings that appear to reorder the tile groupings on your Start 

screen. 

19. When you are finished managing your tile groupings, simply click on the Start screen to return to the 

normal Start screen view. 

20. You can also customize the settings of the individual app tiles within the Start screen. To do this, simply 

right-click on any app tile to display the options bar at the bottom of the screen. 

21. You can then click on any option shown within this bar to apply the desired setting. The settings will 

vary, depending upon the app tile that you selected. However, common option include “Smaller,” 

“Larger,” and “Uninstall.” 

22. Note that if you do not want to make any changes to the selected app tile, you can right-click on it again 

to make the option bar disappear. Sa
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ACTIONS- 

Introduction to Windows 
USING THE CHARM BAR IN WINDOWS 8: 

 

1. You can use the Charm Bar that appears at the right side of the Windows 8 application to search for 

content, share content within apps, return to the “Start” screen from an app, manage connected devices, 

and access your device settings. 

2. You can access the Charm Bar at the right side of the window by simply rolling your mouse pointer over 

to the upper-right or lower-right corners of the screen. 

3. The charm bar will then appear and you can roll your mouse pointer over it in order to access its 

content, displayed as buttons within the Charm Bar. 

4. You can also open it by swiping in from the right edge of a touch screen, or by simply pressing the 

Windows + C keys on your keyboard. 

5. To search for content on your computer, click the “Search” button within the Charm Bar. This will display 

a “Search” pane at the right side of the window. 

6. To search for an item, type the text that you are searching for into the text box shown at the top of the 

“Search” pane. 

7. You will then see any matching results for the three categories of results shown immediately below the 

text box. These categories are “Apps,” “Settings,” and “Files.” The number shown to the right of each 

category shows the number of matches within that category. 

8. You can click on any category shown to then display the matching results in the window to the left of the 

search pane. 

9. You can then click into this window to hide the search pane and scroll through the results. 

10. For “Files” you will also see the results, broken down by general file type as subcategories, displayed at 

the top of the “Files” window. 

11. You can click on any one of the subcategories to further filter the matching results shown. 

12. When you find the item you want, simply click on the result to open the associated file. 

13. If you don’t find a match, you can open the Charm Bar to search again, or simply click the “Start” screen 

in the lower-left corner of the screen to exit. 

14. Within apps that support sharing, such as “Photos” or “Videos,” you can select a photo, video, or other 

shareable item, and then click the “Share” button within the Charm Bar to open a side pane to the right 

that shows the available apps that you can use to share the selected item. 

15. Simply click on the name of the app that you want to use to share the selected item in order to open that 

app and attach the selected item for sharing. Note that if you click the “Share” button within the Charm 

Bar within an app that doesn’t support sharing, such as the “Desktop” app, you will see that information 

displayed in a message within the side pane that appears. 

16. You can then click into the area of the window where the pane does not appear to hide the side pane 

again. 

17. You can click the “Start” button within the Charm Bar to display the “Start” screen again whenever you 

need it. 

18. You can click the “Devices” button within the Charm Bar to display a listing of any connected devices 

whose settings you can change. 

19. You can then click on any device shown to alter its available settings within this pane. 

20. You can click the “Settings” button within the Charm Bar to display a listing of computer settings at the 

bottom of the side pane that appears. 

21. You can also click on the commands shown at the top of the pane to open the various “Control Panel” 

windows for the associated computer settings, or to access “Help” within Windows 8. 
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ACTIONS- 

Introduction to Windows 
THE WINDOWS DESKTOP: 

 

1. The main window in which you perform your tasks in Windows 7 and Vista is the Desktop. In Windows 

8, the “Desktop” is simply another app that you can access from the Start screen. However, the Desktop 

is used in much the same way between all versions of Windows. In Windows 8, the “Start” button is 

removed from the Desktop, as many of the features that it provided are replaced by the Start screen. 

Also, many older programs will be opened within the Desktop app when you open older apps within the 

newer Windows 8. For example, if you add an app icon for a Microsoft Word 2007 installation to the 

Start screen in Windows 8, then Windows will open the application within the Desktop environment 

when you launch the program from the Start screen. 

2. On the Desktop, you can place shortcuts to your favorite files, folders, and programs. These shortcuts 

are displayed as icons on your Desktop. The icons shown on the Desktop can be customized for each 

user account on the computer. 

3. One icon that is commonly shown icon on the Desktop is the Recycle Bin. This is where files that have 

been deleted from your computer’s “C:” drive will be temporarily stored until you decide to permanently 

delete them. Note that when you delete files from removable media or network locations those files are 

not sent to the Recycle Bin, but are permanently deleted instead. So it is important when working on a 

network that you do not assume that files and folders you delete from network drives will go to the 

Recycle Bin. Be careful with the files that you delete from your computer. 

4. In Windows 7 and Windows Vista, you can access many programs and files by clicking the “Start” 

button in the lower left corner of the Desktop. This will display the “Start” menu. 

5. You can select one of the many commonly accessed areas of your computer by clicking on a command 

in the listing at the far right side of the “Start” menu. 

6. To view all of the programs you have available, you can click the “All Programs” command to change 

the display of the left side of the panel to a listing of the programs that are available on your computer. 

7. You can then click on an application to launch it. 

8. In the “Start” button’s menu, you can click the “Documents” command to open your default user folder 

where you can save the files that you create. Saving your files to the “Documents” folder gives you a 

consistent location to save your files, making it less likely to “lose” them on your computer’s folder 

system. When at work, you may have a different location to which you must save your files, as directed 

by your system administrator or supervisor. You should then save to that folder instead of the 

“Documents” folder. 

9. When you are finished examining the “Documents” folder, you can click the “X” in the upper right corner 

to close the window. 

10. Another command button that you can access form the “Start” button’s menu is the “Computer” 

command. You can click this command to open a window that allows you to navigate through the drives, 

folders, and files that are available to your computer through Windows Explorer. 
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ACTIONS- 

Introduction to Windows 
USING THE MOUSE: 

 

1. To control the mouse, position your hand on the mouse with your thumb at the side and your two closest 

fingers resting easily over the two buttons at the top of the mouse. Your two fingers are used to press 

the buttons, or perform the “clicks,” of the mouse. 

2. When you move your mouse while it is on your desk, the pointer on your screen moves in the same 

direction. 

3. You can “click” your mouse, which is a single “press and release” of the left mouse button to select 

objects and executing toolbar button functions. 

4. You can “double-click” your mouse, which is two quick “press and release” movements with the left 

mouse button in rapid succession, to open folders and files. 

5. You can “click and drag” your mouse, which is a single press of the left mouse button that you hold 

down as you roll the mouse to a new location and then release it, to move file and folders and select 

objects and text. 

6. You can “right-click” your mouse, which is a single “press and release’ of the right mouse button, to 

show a pop-up menu of commands that are available for the object that you right-clicked. 

TOUCH GESTURES IN WINDOWS 8: 

 

1. Starting in Windows 8, many of the actions for which you previously would use a mouse can now be 

performed by using gestures on a touch screen for computing devices that support this behavior. 

2. You can “Tap” or “Touch” onscreen, which is when you tap once onscreen, to open or select the item 

that is tapped. Similar to a left-mouse click. 

3. You can “Press and hold,” which is when you touch onscreen and hold your finger in position, to display 

information about the selected item, or open a menu specific to what you’re doing. Similar to a right-click 

with a mouse. 

4. You can “Pinch” or “Stretch,” which is when you touch the screen with two fingers onscreen and then 

either bring them closer together (Pinch), or further away from each other (Stretch). Doing this shows 

different levels of information. It is also used to zoom in or out to magnify items displayed. 

5. You can “Rotate,” which is when you touch the screen with two fingers and then turn your hand 

clockwise or counterclockwise, to rotate onscreen items in the direction specified. Not all items can be 

rotated. 

6. You can “Slide,” which is when you move your finger or fingers across the screen. This moves through 

onscreen content. It is similar to scrolling with the wheel of a mouse. When used on a selected item, it is 

used to move the selected item. Similar to clicking and dragging with your mouse. 

7. You can “Swipe,” which is when you move your finger or fingers a short distance across the screen. If 

you swipe across an app tile or other selectable item contrary to the direction the page scrolls, it will 

select the item. You can also swipe in from the right edge of the screen to open the Charm Bar, swipe in 

from the left edge to show open apps, or swipe in from the bottom edge to display basic file commands. 

You can swipe from the top of an app to the bottom edge to close an app by dragging it off screen. 
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ACTIONS- 

Introduction to Windows 
APP SNAPPING IN WINDOWS 8: 

 

1. Note that in order to have app snapping enabled in Windows 8, you must be using a screen resolution 

of at least 1366 by 768. If using Windows 8, open the “Desktop” app by clicking the “Desktop” tile. 

2. To snap an open app window, slide the app window from the left edge, or move your mouse pointer to 

the upper-left corner of the screen until a preview window appears. 

3. When you can see the app window preview, drag it until a border appears, and then move the app 

where you want it to be positioned. 

4. Note that just as when you are switching between open apps, you can see a listing of the opened apps 

at the left side of the screen, and then click and drag to snap the app window that you want into position. 

USING A MICROSOFT USER ACCOUNT IN WINDOWS 8: 

 

1. Windows 8 contains a new feature that allows you to use a “Microsoft” user account versus a “Local” 

user account. When you sign-in to your computer using a Microsoft user account, you will have many 

more features available to you. 

2. You can sign-in to Windows 8 using an email address and password. This email address will then 

become your Microsoft account. Note that this account can be either a “Standard” or “Administrator” 

account on the local PC on which it is entered. 

3. When you sign-in to Windows 8 on a device with a Microsoft account, you will be connected to a 

computer network referred to as the “cloud.” That will allow the following features to be enabled. 

4. First, any social networking and email applications associated with the email address, such as Hotmail, 

Facebook or Twitter will be updated automatically. 

5. You will also be able to access and share files on the web though providers such as SkyDrive or 

Facebook. 

6. Also, your Windows 8 settings will be synced to any device running Windows 8 that you sign into using 

the same email address. 

7. You can also get apps in the Windows Store and use them on any Windows 8 computing device that 

you sign into with the account. 
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ACTIONS- 

Introduction to Windows 
STARTING A PROGRAM IN WINDOWS 7 AND VISTA: 

 

1. You can start a program in Windows 7 and Windows Vista in one of two ways. The first is to double-click 

on the icon or shortcut for the application that you want to open on your Desktop. 

2. The second way is to go through the “Start” button’s pop-up menu. To open a program using the “Start” 

button, click the “Start” button in the lower left corner of your Desktop. 

3. You will see a pop-up menu of various choices you can make. Roll your mouse pointer up to the “All 

Programs” command and click it. 

4. When you click it, the listing at the left side of the pop-up menu will change to show you the various 

programs installed on your computer. 

5. Roll over any program icon to highlight it, and then click to open it. 

6. If the program is located within a folder in the menu, roll your mouse pointer over the folder and then 

click once to see the contents of the selected folder. 

7. Then roll over the program that you want to open, and click it to start the application. 

RESIZING A DESKTOP WINDOW: 

 

1. At the top of most desktop windows is the “Title Bar.” The Title Bar will usually display the name of the 

window or its contents. One of the most basic functions of the Title Bar is resizing windows. 

2. If you look at the right end of the Title Bar within an open Desktop window, you will see a three-button 

group. They are, from left to right: “Minimize,” “Maximize/Restore,” and “Close.” 

3. You can click the Minimize button in the Title Bar of an open window to send the window down to the 

Windows taskbar at the bottom of the Desktop. Although cannot see the content of the window, it is still 

open and active. Minimizing a window will temporarily get it out of your way. 

4. To bring the window back, click on the entry for the window within the Windows taskbar. That will bring it 

back onscreen exactly as it was when you minimized it. 

5. In Windows 7, when you minimize folders within your computer’s system, the folders will often be 

grouped within the “Libraries” icon in the Windows taskbar. You can click this icon within the Windows 

taskbar to then open a small pop-up window that shows you the opened system folders. You can then 

click on the one you wish to view again in order to restore the selected folder’s onscreen display. 

6. “Maximizing” a window means making it large enough to fill your entire computer screen. If your window 

does not fill the entire screen, then click the middle button of the three located at the right end of the 

Title Bar in that window to maximize its display. 

7. To switch between multiple maximized windows, click on the Windows taskbar icon for the window that 

you want to view. That will bring that window to the forefront of the stack of windows, above any other 

opened windows which then recede behind it. Doing this is called “toggling” between the open windows. 

8. If your window is already maximized, clicking the middle button of the three at the right end of the title 

bar will instead change the window to its “Restore” mode. 

9. The Restore window is a smaller window that allows you to change its size and position within the 

Desktop area. When the window is in Restore mode, you can place your mouse pointer over the border 

of the window’s frame and then wait until you see a double-pointed arrow. 

10. When you see this icon appear, click and drag with the mouse to change the size of the window. 

11. You can also click and drag directly in the middle of the Title Bar of a window to move it to a different 

area within the Desktop. 

12. The last button at the right end of the title bar has a big “X” in it. This is the “Close” button, and clicking it 

will close the window. Sa
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ACTIONS- 

Introduction to Windows 
SCOLLING A WINDOW: 

 

1. To scroll through the content within a window, you can click the arrows located at either end of the scroll 

bars to scroll the window in that direction. 

2. You can also click and drag the box inside the scroll bars to the desired location in the window and then 

release it to scroll through the content. 

3. The location of the scroll box inside of the scroll bar indicates your position within the content of the 

window. 

SHUTTING DOWN WINDOWS: 

 

1. When you need to turn off your computer, it is very important to do so properly. Do not simply unplug 

the computer or interrupt its power source! Doing so could possibly corrupt the information in 

your computer! 

2. To properly shut down a computer using Windows 8, open the Charm Bar at the right side of the screen 

and then click the “Settings” button to display the “Settings” pane to the right of the screen. 

3. Then click the “Power” button at the bottom of the “Settings” pane to view a pop-up menu of choices. 

4. To shut down the computer, select the “Shut down” command from the pop-up menu. 

5. To properly shut down a computer using Windows 7 or Windows Vista, place your mouse pointer over 

the “Start” button and click it to open the pop-up menu of choices. 

6. Roll your mouse pointer over to the right-pointing arrow in the lower right corner of the pop-up menu and 

click it. 

7. From the side menu that appears, select the “Shut Down” command to shut down Windows. 

8. In Windows 7, if the “Shut Down” command is shown next to the right-pointing arrow, then there is no 

need to click the arrow to select it. Instead, simply click directly on the “Shut Down” command, instead. 

9. It may take a few moments before Windows will shut down entirely, so be patient. Once Windows has 

completely powered off and the computer is shut down, then it is permissible to shut off the power supply 

for the computer or unplug it if necessary. 
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EXERCISES- 

Introduction to Windows 
Purpose: 

 

1. To familiarize the student with the Windows 8 environment. 

Exercises for Windows 8: 

 

1. Login to your Windows 8 computer using either a local account or your Microsoft account. 

2. Locate the “Internet Explorer” app tile located within the “Start” screen. 

3. Click the “Internet Explorer” app tile within the “Start” screen to display Internet Explorer. 

4. Click and drag from the top to the bottom of the “Internet Explorer” app window to close the app. 

5. Slide your mouse pointer to the lower-right corner of the screen or swipe in from the right to display 

the “Charm Bar” at the right side of the “Start” screen. 

6. Roll your mouse pointer up the “Charm Bar” and then click the “Settings” charm in order to open the 

“Settings” panel at the right side of the screen. 

7. Click into the “Start” screen in order to hide the display of the “Settings” panel. 

8. Right-click on the “Weather” app tile within the “Start” screen to display the Options Bar at the 

bottom of the screen. 

9. Click the “Turn live tile off” command within the Options Bar to turn off the weather display within the 

tile. 

10. Right-click on the “Weather” app tile within the “Start” screen to display the Options Bar at the 

bottom of the screen. 

11. Click the “Turn live tile on” command within the Options Bar to turn on the weather display within the 

tile. 

12. Click the “Desktop” app tile within the “Start” screen to display the “Desktop” app. 

13. Roll your mouse pointer into the lower-left corner of the “Desktop” screen until you see the icon of 

the “Start” screen appear. 

14. Click the icon for the “Start” screen to switch back to the “Start” screen. 

15. Roll your mouse pointer into the lower-left corner of the “Start” screen until you see the icon of the 

“Desktop” screen appear. 

16. Click the icon for the “Desktop” screen to switch back to the “Desktop” screen. 
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EXERCISES- 

Introduction to Windows 
Purpose: 

 

1. To familiarize the student with the Windows 7 and Windows Vista environments. 

Exercises for Windows 7 and Windows Vista: 

 

1. Locate the “Start” button located in the lower left corner of the Windows taskbar, and click it once 

with the left mouse button. For all examples, unless indicated otherwise, all “click” commands are a 

left click with the mouse. 

2. Click the “Documents” command from the commands shown at the right side of the pop-up menu to 

open the “Documents” window for your user account. 

3. Click the “Minimize” button in the upper right area of the “Document” window’s title bar.     

4. Click on the “Documents” entry that is now in the Windows taskbar to show the window onscreen 

again. Note that this entry is located within the “Libraries” icon within the Windows taskbar if using 

Windows 7. 

5. Click on the “Maximize” button in the upper right area of the title bar of the “Documents” window. 

6. Click on the “Close” button in the upper right area of the title bar in the “Documents” window. 

7. Right-click into the empty space in your Windows Desktop to display a pop-up menu of command 

choices available for the Desktop. Left-click in the blank area of the Windows Desktop to cancel the 

menu. 
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CHAPTER 2- 

Windows Explorer 

2.1- Windows Explorer in Windows 8 

 

2.2- Navigating Folders 

 

2.3- Changing Folder Views 

 

2.4- Sorting Folder Contents 

 

2.5- Selecting Files 

 

2.6- Opening a File 

 

2.7- Opening a Recently Accessed File or Folder 

 

2.8- Creating a New Folder 

 

2.9- Renaming Files and Folders 

 

2.10- Cutting, Copying, and Pasting Files and Folders 

 

2.11- Burning a CD or DVD 

 

2.12- Deleting Files 

 

2.13- Managing Libraries in Windows 8 

 

2.14- Managing the Computer and Disks in Windows 8 
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Windows Explorer 

2.1- Windows Explorer in Windows 8: 

 

 Windows Explorer has been available in Windows for many, many years. However, in Windows 8, it 

appearance and functionality have been enhanced. In this lesson, we will examine using Windows Explorer 

in Windows 8. Windows Explorer is simply a window that allows you to explore the files and folders 

contained within your computer. It is often opened when you wish to manage your files and folders. When 

you open a library folder within Windows 8, for example, the content will be displayed within a Windows 

Explorer window. 

 You can start Windows Explorer as an app in Windows 8, under the “All apps” category that you can 

access by right-clicking in the empty area within the Start screen. You can access it from the Desktop by 

clicking the icon for “Windows Explorer” that appears within the taskbar at the bottom of the screen. Starting 

in Windows 8, however, you will see a new set of tabs appear at the top of this window that allows you to 

perform many functions on files and folders that you select within the main Windows Explorer screen. Let’s 

examine the different features and functions shown within a typical Windows Explorer screen in Windows 8. 

Navigation Pane 

Back, Forward, 

and Up Buttons 

Tabs within the Ribbon 

Address Bar 

Files and Folders 

Column Names 

Search Box 

Status Bar 

 Within Windows Explorer, the Navigation Pane is used to select folders, drives, and navigate the 

computers, folders, and files on your network. You can expand and collapse the areas shown within the 

Navigation Pane, which include your Libraries, Computer, and Network. 

 You can use the Back, Forward, and Up Buttons to navigate within the different screens that you 

browse within Windows Explorer. You can click the Back button to return to the last page viewed, the 

Forward button to move forward again after pressing the Back button, and the Up button to move up a level 
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Windows Explorer 

2.1- Windows Explorer in Windows 8- (cont'd.): 

 

within the folder hierarchy shown within Windows Explorer. 

 The various Tabs within the Ribbon are shown at the top of Windows Explorer. You will find all of 

your file and folder management commands shown within the area. When you select an item within the 

Files and Folders listing shown within Windows Explorer, the available commands will be shown on the 

tabs that comprise the Ribbon. You can click on the tabs to see the functions available within each group. 

 The Address Bar shows the currently selected location within your computer or network. You can 

also click into the Address Bar and enter a folder location, if desired. The Files and Folders listing shows the 

contents of the Address Bar location that is currently selected. 

 If you are viewing the “Details” view of a folder location shown within the Address Bar, then the 

details of the files and folders will be shown within columns. At the top of each column, you will see a 

Column Name that displays the type of information shown within that column. 

 You can view summary information for selected files and folders within the Status Bar at the bottom 

of Windows Explorer. You can see the number of items within a selected folder location, or the number of 

selected items within a location and their total file size. 

 If you wish to search for a specific file or folder within a selected folder location, you can use the 

Search Box to accomplish this. Simply type the name of the file or folder, or the first few letters in the name 

of the file or folder, into the Search Box to then search within the currently selected folder location for the 

text that you enter. Searching begins immediately as you begin typing into the Search Box. 

2.2- Navigating Folders: 

 

 You use Windows Explorer to navigate through the files and folders on your computer. Within the 

large pane at the right side of Windows Explorer, you will see the contents of the currently selected drive or 

folder. Within this pane at the right, you can double-click on a drive or folder icon to open it. Windows will 

then display its contents in the pane at the right side, showing you any folders and files within that selected 

drive. You can then repeat this process, moving through the folders within the computer in order to explore 

the files and folders within your computer. 

 You can also use the hierarchical display pane at the left side of the Windows Explorer window to 

navigate the drives and folders on your computer. Whatever item you select in the pane at the left side of 

the Windows Explorer window will display its contents in the pane to the right. For example, you can click 

the “Computer” icon shown within the left pane to display the drives within your computer in the pane to the 

right. Note that in the left pane there is also a collapsible and expandable arrow icon shown at the left of 

each icon. If needed, you can click the arrow to expand the containers shown next to the icon, which will 

then be displayed in a hierarchical listing beneath their parent container. For example, you can click the 

arrow next to the “Computer” icon to show the drives on your computer within the left pane. You can then 

select a drive in the left pane, such as the “Local Disk (C:)” drive, in order to display the folders within your 

computer’s hard drive in the pane to the right. Also note that this drive icon has an arrow next to it within the 

left pane which you can click to collapse and expand the folders within the drive in the left pane, as well. 

 To open a file shown in the right pane, simply double-click on the file. Windows will then open the file 

with whatever software it thinks is best to open files of that type. If it doesn’t know what program to use to 

open the file type, it will display a message window that will allow you to select the type of program that you 

want Windows to use to attempt to open the selected file type. 

 If you wish to view information about a file within the pane at the right side of the Windows Explorer 

window, you can click it to select it. In Windows 7 and Vista, its file properties and information will appear in 

a small pane at the bottom of the window, provided that the window is not sized too small. In Windows 8, 
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Windows Explorer 

2.2- Navigating Folders (cont'd.): 

 

you will need to click the “View” tab within the top of the window after selecting the file, and then click the 

“Details pane” button within the “Panes” button group at the left side of the tab to display properties and 

information about the selected file in a pane at the far right side of the Windows Explorer window. You can 

choose to leave this pane on, if you prefer, or you can hide it again when you are finished viewing the file’s 

properties by clicking the “Details pane” button again to hide its display. 

 Within Windows Explorer, if you display the contents of a folder in the pane at the right and then 

realize that you are looking in the wrong folder, you can click the “Back” button in the toolbar below the 

Ribbon to simply move back into the last folder that you viewed. You can then click the “Forward” button to 

move forward again into the folder that you just left, if needed. If instead of moving back to the last viewed 

folder, you would prefer to move up one folder level within the folder hierarchy, as shown in the pane at the 

left, you can click the “Up” button to move up one folder level. 

2.3- Changing Folder Views: 

 

 Windows allows you to change the display of the files and folders that are shown in the right side of 

the Windows Explorer window. This is just a matter of personal preference. Your options are to display 

folder items as “Icons,” “List,” “Details,” “Tiles,” or “Content” in Windows 8. Note that if you choose to display 

“Icons,” you can select the size of the icons displayed within Windows Explorer. 

 To change the view settings of the currently displayed folder within Windows Explorer in Windows 8, 

click the “View” tab within the Ribbon. Then click on the desired view style button shown within the listing 

displayed in the “Layout” button group. Note that you can hold your mouse pointer over any view listed to 

see a preview of how it would appear in the window below. You can then click on the choice that you prefer 

to apply it to the current folder. 

 To switch the folder view in Windows 7 or Vista, click the drop-down button next to the “Change your 

view” button in Windows 7, or the “Views” button in Windows Vista, that appears at the top of the Windows 

Explorer window. Then select the view you wish to use from the drop-down menu that appears. When you 

click on the name of the desired view to select it, the view of the folder’s contents will change to reflect your 

choice. You can click and drag the vertical slider up and down the listing to preview your choices before 

applying one. If you do this, simply release the mouse button when you have selected the desired view. 

2.4- Sorting Folder Contents: 

 

 Windows allows you to sort items within a folder. In Windows, you can sort by any file or folder 

attributes that are available, regardless of the view style selected. To do this in Windows 8, display the 

contents of the folder to sort within Windows Explorer. Then click the “View” tab within the Ribbon. Then 

click the “Sort by” drop-down button within the “Current view” button group on this tab. You can then select 

the attribute by which you wish to sort from the drop-down menu that appears. You can also click the button 

again and choose either the “Ascending” or “Descending” choice within the menu to sort by the selected 

attribute in either ascending (a-z, 0-9) or descending (z-a, 9-0) order. 

 In Windows 7 and Vista, you can sort the contents of a displayed folder by right-clicking into the 

blank area within the folder to view a pop-up menu of choices. Roll your mouse pointer over the “Sort by” 

command to display a side menu of attribute choices by which you can sort the folder’s contents. Click on 

the desired attribute to sort the contents. You can also select either the “Ascending” or “Descending” choice 

within the side menu that appears to sort by the selected attribute in either ascending (a-z, 0-9) or 
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Windows Explorer 

2.4- Sorting Folder Contents (cont'd.): 

 

descending (z-a, 9-0) order. Note that this method of sorting is also available in Windows 8. 

 In all versions of Windows, if you are using the “Details” view of a folder’s content within the 

Windows Explorer window, you can also easily sort the contents by using the column headings that appear 

within this view. To do this, simply click on the column heading by which you want to sort the contents within 

the folder. The items will be sorted by the information within the column in either ascending order or 

descending order. Each time you click the same column heading, it will reverse the sort order. The column 

that is used for sorting as well as its sort order will be indicated by a small upward or downward pointing 

arrow within the column heading. 

 Note that Windows Explorer sorts folders separately from files when sorting folder content. For 

example, if you sort a folder’s content by “Name,” the folders and files will be sorted alphabetically by name 

within two separate groupings within the view. 

2.5- Selecting Files: 

 

 In order to perform many of the functions that you need in order to manage files within Windows 

Explorer, you must first learn how to select files. You can select a single file in Windows Explorer by clicking 

on it once. It will then be highlighted. The highlight indicates that the file is selected. When a file is selected, 

it has the focus of the Windows application, and any commands that you subsequently perform will be 

applied to the selected file only. 

 In order to deselect a file selection that you have made, you must click into the blank or empty area 

within the window shown in Windows Explorer. 

 You can also select multiple files in a window simultaneously. How you do this depends on how the 

files are arranged within the window. If the files are non-adjacent, meaning not next to each other, then 

select the first file within the window as normal. Then press the “Ctrl” key on your keyboard while you click 

on any other files that you wish to select, in order to select them as well as retain the initially selected file. 

You can then release the “Ctrl” key after you have selected all of the necessary files. 

 If the files are adjacent, meaning that they are located next to each other, then you simply click on 

the first file to select it. Then press the “Shift” key on your keyboard. Then click on the last file that you want 

to select. At this point all of the files including and between the first and last files that you clicked upon 

should be selected. You can then release the “Shift” key when finished. 

 Another way to select adjacent files is to use a selection marquee. To do this, click and drag starting 

in the blank area that is adjacent to the file or files that you wish to select. As you click and drag with the 

mouse pointer, you will see a light blue selection marquee appear. Continue to click and drag the selection 

marquee over the files that you wish to select. Any file touched by the selection marquee will be selected 

within the window. Then release the mouse pointer once the files you desire have been selected. 

 If you are using Windows 8, you can also make use of the new selection tools shown within the 

“Home” tab of the Ribbon in Windows Explorer to assist in making file and folder selections. You can click 

the “Select all” button in the “Select” group on the “Home” tab in the Ribbon to select all items within a folder 

displayed in Windows Explorer. The keyboard shortcut to do this same action, which works in all versions of 

Windows, is “Ctrl” + “A” on your keyboard. You can click the “Select none” button in the “Select” group on 

the “Home” tab in the Ribbon to cancel any selections made within Windows Explorer. This corresponds to 

clicking into the empty or blank area within a window. Finally, you can click the “Invert selection” button in 

the “Select” group on the “Home” tab in the Ribbon to invert your current selection. This selects all non-

selected files and de-selects all selected files within a window. Sa
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Windows Explorer 

2.7- Opening a Recently Accessed File or Folder: 

 

 Windows records the history of files and folders that you have recently accessed. If you want to 

open a recently accessed file or folder, you can use either Windows Explorer in Windows 8 or the “Start” 

button’s menu within Windows 7 and Vista. 

 To view the recently accessed folders on your computer, click the “Recent places” icon that appears 

below the “Favorites” icon within the pane at the left side of the Windows Explorer window. The pane to the 

right will then show folders that you have recently displayed in Windows Explorer. 

 If you are using Windows 7 or Vista, you can find recently accessed files by clicking the “Start” 

button and then rolling your mouse pointer over the “Recent Items” command. A side menu will then appear 

listing the most recently accessed files on your computer. Simply click on the file in this side menu that you 

want to open to access it. 

 If you do not see “Recent Items” in your “Start” menu in Windows 7 or Vista, you can easily add it. 

Right-click on the “Start” button and choose “Properties.” If using Windows Vista, in this window, check the 

“Store and display a list of my most recently opened files.” If using Windows 7, click the “Customize…” 

button and then check the “Recent Items” checkbox. Once that is done, click the “OK” button to add the item 

to the “Start” menu. Then click the “OK” button in the “Taskbar and Start Menu Properties” dialog box to 

apply the changes. 

2.8- Creating a New Folder: 

 

 After you begin to create and save files, you may wish to create additional folders and subfolders to 

help you organize your saved materials. You can create a folder within almost any other folder on your 

computer’s hard drive. Sometimes you may also do this on shared network drives, assuming that you have 

the required network permission to do so. 

 To create a new folder, first open the folder within which you want to create a subfolder in Windows 

Explorer so that its contents are displayed in the pane at the right. Then, if using Windows 8, click the “New 

folder” button within the “New” button group on the “Home” tab in the Ribbon. If using Windows 7, instead 

click the “New folder” button in the toolbar at the top of the Windows Explorer window. If using Windows 

Vista, click the “Organize” button within the toolbar and then choose the “New Folder” command. 

 Once this has been accomplished, Windows will create a new folder within the current folder window 

shown in the right pane and highlight the name, which is usually “New folder,” by default. You simply need 

to type the name that you want to give to the folder, and then click outside of the folder’s name box into the 

blank area of the window or press the “Enter” key on your keyboard, to set the new folder’s name. 

2.6- Opening a File: 

 

 To open a file that is shown within the Windows Explorer window, you can double-click on the file. 

Alternately, you can right-click on the file to display a pop-up command menu. You can then click on the 

“Open” command within the pop-up menu to open the selected file or files. 

 If you are using Windows 8, you can select a file within Windows Explorer and then click the “Open” 

or “Edit” buttons that appears within the “Open” button group on the “Home” tab within the Ribbon to open a 

selected file. Note that the “Edit” button will only appear active for editable files selected within the window. 
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Windows Explorer 

2.9- Renaming Files and Folders: 

 

 You can rename the files and folders that you have created to reflect changes made to the contents 

or to correct typos made when creating the files or folders. However, you should only rename files that you 

have created. Many of the files and folders in your computer are used by Windows applications, and 

renaming these could cause those programs to stop working. You could possibly even accidentally disable 

Windows itself! However, if you are the creator of the file or folder, you can rest assured that you are free to 

rename any files or folders that you have created. 

 To rename a file or folder, select the file or folder to rename within Windows Explorer. If using 

Windows 8, click the “Rename” button within the “Organize” button group on the “Home” tab within the 

Ribbon. If using Windows 7 or Vista, click the “Organize” button and choose the “Rename” command. 

 Doing this will highlight the currently selected file or folder name and place a thin border around it. 

Simply type the new name of the file into the name box, and then click outside of the name box into the 

blank area within the window or press the “Enter” key on your keyboard, to set the new file or folder name. 

2.10- Cutting, Copying, and Pasting Files and Folders: 

 

 Once you’ve decided to start organizing your files and folders, you will want to move files or folders 

around or copy them to a new folder location. There is a difference between moving and copying files and 

folders. When you move a file or folder, you place the item into a different location on your computer. When 

you copy a file or folder, you make an exact copy of a selected file or folder, and then put the copy into a 

new place on your computer. When you move a file, it is often referred to as “cutting and pasting.” When 

you copy a file, it is referred to as “copying and pasting.” 

 You can cut or copy and then paste files in several different ways. One way is to navigate to the file 

or folder that you want to cut or copy within Windows Explorer, so that you can see the icon for the file or 

folder that you want to move or copy in the pane at the right side of the window. Make sure that you change 

the Windows Explorer window’s size to “Restore” so that it is not maximized. Now open a second Windows 

Explorer window and use this window to navigate to the folder where you want to paste the item that you 

copy or move from the first window. Once again, ensure that this window is using the “Restore” window 

size, and then place it next to the first window. At this point you can simply click and hold down on the file or 

folder from the first window and then drag it into the second window and drop it there by releasing your 

mouse button. If the files are located on the same computer drive then doing this will “cut and paste,” or 

move, the item. If they are on different computer drives, then doing this will “copy and paste” the item. If you 

wanted to copy the item regardless of which drive the files are located within, then simply hold down the 

“Ctrl” key on your keyboard as you drag and drop the selected file or folder. You will notice a small plus sign 

(+) appear next to your mouse pointer as you drag the item between the windows. That icon indicates that 

the file or folder is being copied versus being cut. 

 Another way to cut, copy, and paste is to click on an item in a Windows Explorer window that you 

want to cut or copy to select it. Next, if using Windows 8, click either the “Copy” or “Cut” buttons, as desired, 

shown within the “Clipboard” group on the “Home” tab in the Ribbon. If using Windows 7 or Vista, click the 

“Organize” button in the toolbar at the top of Windows Explorer and choose either the “Cut” or “Copy” 

command, as desired. 

 Next, navigate into the folder that you want to paste the item that you just cut or copied using 

Windows Explorer. You may use the same window, if desired. If using Windows 8, then click the “Paste” 

button within the “Clipboard” group on the “Home” tab in the Ribbon to paste the item. If using Windows 7 or 

Vista, click the “Organize” button in the toolbar at the top of the Windows Explorer window and choose the 

“Paste” command from the drop-down menu that appears to paste the item into the current window. Sa
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Windows Explorer 

2.10- Cutting, Copying, and Pasting Files and Folders (cont'd.): 

 

 Another way to cut, copy, and paste is also available if you are using Windows 8. Using this method, 

you simply select the file or folder to cut or copy within the Windows Explorer window. Then you can click 

either the “Move to” or “Copy to” buttons shown within the “Organize” group on the “Home” tab in the 

Ribbon depending on whether you wish to move or copy the selected item. From the drop-down menu that 

appears, you can then select the name of one of the recently accessed folders or libraries to paste the item 

into the selected folder. You can also click the “Choose location…” command at the bottom of either drop-

down menu to open a “Move Items” or “Copy Items” window. Within this window, you use the hierarchical 

folder navigation shown to select the destination folder where you want the selected item to be moved or 

copied. You use this window to select a folder, just as you use the navigator in the pane at the left side of 

Windows Explorer. Once you select the destination folder within this window, click either the “Move” or 

“Copy” button that appears at the bottom of the “Move Item” or “Copy Item” window to move or copy the 

selected item and close the window. 

 One last way to cut, copy, and paste files and folders is by using the keyboard. To do this, first select 

the item you want to copy or move within Windows Explorer and then press either the “Ctrl” + “C” keys on 

your keyboard to copy the item or the “Ctrl” + “X” keys on your keyboard to cut the item. Then navigate into 

the folder where you want to paste the item that you just selected. To then paste the item that you just cut or 

copied into the selected folder, press the “Ctrl” + “V” keys on your keyboard. The paste command works the 

same way regardless of whether the initially selected item was cut or copied. 

2.11- Burning a CD or DVD: 

 

 Most new computers have a CD or DVD drive that can write to recordable CDs or DVDs so that you 

can save content from your computer onto removable media for transfer. To burn a CD or DVD using files 

from your computer, you must first insert a blank, recordable CD or DVD into the recording drive. 

 In Windows 8, a small message box appears in the Start screen telling you to tap the message box 

in order to determine what Windows 8 should do when a blank CD or DVD is inserted. Once you tap or click 

on the message box another window appears showing you the actions that your computer can take using 

the software programs that are available. In Windows 7 and Vista, an “AutoPlay” window will appear 

onscreen when you insert the CD or DVD, offering you the same choices. In this lesson, we will examine 

what will occur if you select the “Burn files to disc (using Windows Explorer)” command in either window. 

 In the “Burn a disc” window that then appears, start by typing a name for the disc into the “Disc title:” 

text box. If using Windows Vista, you may need to click the “Show formatting options” button to select a 

format for the disc. In Windows 8 and 7, these options appear automatically within the “Burn a disc” window. 

 If you select the “Like a USB flash drive” choice (“Live File System” in Windows 7 and Vista), you will 

format the disc to behave like a removable drive to which you can add and erase files, just like a USB drive. 

This disc may not work on computers using versions of Windows prior to Windows XP, however. 

 You can select the “With a CD/DVD player” choice (“Mastered” in Windows 7 and Vista) to create a 

standard, recordable disc that will play on most computers and CD players. Once you have made, your 

selection, click the “Next” button to continue. 

 If you selected the “Like a USB flash drive” choice, Windows will format the disc and then display it 

within a Windows Explorer window when it is finished formatting it. You can then use the disc as if it were 

any other folder on your system. You can copy files to the disc and delete them when you are finished. 

 If you selected the “With a CD/DVD player” option, then you will next view an empty Windows 

Explorer window where you will need to copy the files and folders that you want to burn to the CD or DVD. If 

using Windows 8, you can then click the “Burn to disc” button within the “Send” button group on the “Share” 
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Windows Explorer 

2.11- Burning a CD or DVD (cont'd.): 

 

tab within the Ribbon to burn the selected files to the disc. If using Windows 7 or Vista, click the “Burn to 

disc” command button in the toolbar at the top of the Windows Explorer window to burn the contents of the 

window to the disc. 

2.12- Deleting Files: 

 

 Routinely deleting files that you no longer need can help you keep your files and folders better 

organized as well as save space on your computer. However, before you delete a file you should be 

absolutely sure you will no longer need it in the future. 

 To delete a file, use Windows Explorer to navigate to the folder that contains the file that you want to 

delete. Then select the file you want to delete within the window shown. You can then press the “Delete” or 

“Del” key on your keyboard to delete the selected files or folders. Alternately, if using Windows 8, click the 

“Delete” button in the “Organize” group on the “Home” tab in the Ribbon or if using Windows 7 or Vista, click 

the “Organize” button in the Windows Explorer toolbar and then click the “Delete” command. 

 Windows will then display a prompt where you will be asked if you are sure you want to send the file 

to the “Recycle Bin,” if you are deleting a file from your “C:” drive. Otherwise, it will ask if you want to 

permanently delete the file. If you click “Yes,” Windows will then either place the file in the “Recycle Bin” or 

delete it completely. Be sure to only delete files you created! If you delete a file that an application needs in 

order to run, you will not be able to use the associated application. The application would need to be 

reinstalled. 

 Also note changes made to the “Delete” button within Windows Explorer in Windows 8. You can 

click the drop-down arrow under the “Delete” button in the “Organize” group on the “Home” tab in the 

Ribbon to select other choices for file deletion. You can select the “Recycle” command to move the item to 

the recycle bin. You can select the “Permanently delete” command to permanently delete the file. Also, you 

can toggle the display of the warning prompt for file recycling on or off by choosing the “Show recycle 

confirmation” command. If it appears checked, the confirmation will appear onscreen when deleting files. If 

unchecked the confirmation will not appear. 

2.13- Managing Libraries in Windows 8: 

 

 At the left side of Windows Explorer in Windows 8, you can see the “Libraries” icon and the library 

groups within it. These libraries contain the different folders that you commonly use to save files on your 

computer. You can add other folders to these libraries in order to be able to search and back up the files 

within them using Windows. Note that the subfolders within these library folders are already considered part 

of the library, so you will not need to add those to the definition of the library. However, you can add other 

folders to the libraries if needed and perform other library management tasks using Windows Explorer. 

 To do this, select the “Libraries” icon within the left pane in Windows Explorer. You can then select a 

desired library to manage from the listing shown in the right pane. At the top of the application, you will then 

see a new contextual tab appear in the Ribbon named “Library Tools.” Click the “Manage” tab within this 

contextual tab in the Ribbon to see your library management commands. To choose which folders are 

included in the selected library, click the “Manage library” button to open a dialog box that allows you to 

manage the folders that are included in the selected library. 

 To add a new folder, click the “Add…” button at the right side of the dialog box to open a window 

that allows you to browse to and then select the folder for inclusion in the library. Once you have selected 
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Windows Explorer 

2.13- Managing Libraries (cont'd.): 

 

the desired folder, click the “Include folder” button to add the selected folder to your library. You can also 

remove a folder from the library by selecting a folder shown within the dialog box and then clicking the 

“Remove” button. Once you have finished selecting the desired folders for inclusion in your library, click the 

“OK” button to apply your changes. 

 You can also choose which folder within a library will be set as the default save folder for a library. 

To do this, click the “Set save location” drop-down button within the Ribbon and then choose a desired 

folder from the drop-down menu that appears. 

 You can also reset changes that you have made to a selected library by simply clicking the “Restore 

settings” button within the Ribbon to reset the selected library back to its defaults. 

2.14- Managing the Computer and Disks in Windows 8: 

 

 You can also use Windows Explorer in Windows 8 to manage your computers and its hard drive 

disks. To do this, click the “Computer” icon at the left side of Windows Explorer. If desired, you can then 

click on a hard drive disk to manage shown in the pane at the right side of the Windows Explorer window. 

 You can click the “Computer” tab shown within the Ribbon of Windows Explorer in order to access 

computer management and system commands. Computer network commands are shown in the “Network” 

button group and system management commands are shown within the “System” group. 

 In the “Network” group on the “Computer” tab you can click the “Map network drive” button to display 

a drop-down menu that allows your to create a network drive mapping or disconnect a mapped network 

drive. To create a network drive mapping, select the “Map network drive” command and then assign a drive 

letter and enter a network location into the dialog box that appears. Then click the “Finish” button to add the 

mapped network drive. You can also choose the “Disconnect network drive” command to open a dialog box 

where you can choose the mapped drive to disconnect and then click the “OK” button to remove the 

selected drive’s mapping. 

 If you want to add a shortcut to an FTP site or other network location, you can click the “Add a 

network location” button to open the “Add network location” wizard. Here you can enter the necessary 

information in order to access the desired network location and save it to your computer. 

 In the “System” group on the “Computer” tab you can click the “Open Control Panel” button to open 

the “Control Panel” for your computer. You can click the “Uninstall or change a program” button to open the 

“Programs and Features” pane within the “Control Panel” window where you can manage the software 

installed on your computer. You can click the “System properties” button to open a window that displays the 

properties of your computer. You can click the “Manage” button to open the “Computer Management” 

window that allows you to manage the devices, hard drives, and other hardware settings on your computer. 

 If you selected a hard disk drive within Windows Explorer, you can then click the “Manage” tab 

within the “Drive Tools” contextual tab within the Ribbon at the top of Windows Explorer to display disk 

management commands. You can click the “Optimize” button to defragment the selected computer hard 

drive for optimal performance. You can click the “Cleanup” button to run the “Disk Cleanup” utility on the 

selected drive. This allows you to select temporary files to remove from the selected drive in order to free 

more drive space. 
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ACTIONS- 

Windows Explorer 
USING WINDOWS EXPLORER: 

 

1. You can start Windows Explorer as an app in Windows 8, under the “All apps” category that you can 

access by right-clicking in the empty area within the Start screen. 

2. You can access Windows Explorer from the Desktop by clicking the icon for “Windows Explorer” that 

appears within the taskbar at the bottom of the screen. 

3. Within Windows Explorer, the Navigation Pane is used to select folders, drives, and navigate the 

computers, folders, and files on your network. You can expand and collapse the areas shown within the 

Navigation Pane, which include your Libraries, Computer, and Network. 

4. You can use the Back, Forward, and Up Buttons to navigate within the different screens that you browse 

within Windows Explorer. 

5. You can click the Back button to return to the last page viewed, the Forward button to move forward 

again after pressing the Back button, and the Up button to move up a level within the folder hierarchy 

shown within Windows Explorer. 

6. In Windows 8, the various Tabs within the Ribbon are shown at the top of Windows Explorer. You will 

find all of your file and folder management commands shown within the area. In Windows 7 and Vista, 

you will use the toolbar that appears at the top of Windows Explorer to access commands. 

7. The Address Bar shows the currently selected location within your computer or network. You can also 

click into the Address Bar and enter a folder location, if desired. 

8. The Files and Folders listing shows the contents of the Address Bar location that is currently selected. 

9. If you are viewing the “Details” view of a folder location shown within the Address Bar, then the details of 

the files and folders will be shown within columns. At the top of each column, you will see a Column 

Name that displays the type of information shown within that column. 

10. You can view summary information for selected files and folders within the Status Bar at the bottom of 

Windows Explorer. You can see the number of items within a selected folder location, or the number of 

selected items within a location and their total file size. 

11. If you wish to search for a specific file or folder within a selected folder location, you can use the Search 

Box to accomplish this. Simply type the name of the file or folder, or the first few letters in the name of 

the file or folder, into the Search Box to then search within the currently selected folder location for the 

text that you enter. Searching begins immediately as you begin typing into the Search Box. 

NAVIGATING FOLDERS (CONT'D.): 

 

1. Within the large pane at the right side of Windows Explorer, you will see the contents of the currently 

selected drive or folder. 

2. Within this pane at the right, you can double-click on a drive or folder icon to open it. Windows will then 

display its contents in the pane at the right side, showing you any folders and files within that selected 

drive. 

3. You can then repeat this process, moving through the folders within the computer in order to explore the 

files and folders within your computer. 

4. You can also use the hierarchical display pane at the left side of the Windows Explorer window to 

navigate the drives and folders on your computer. Whatever item you select in the pane at the left side 

of the Windows Explorer window will display its contents in the pane to the right. 

5. Note that in the left pane there is also a collapsible and expandable arrow icon shown at the left of each 

icon. If needed, you can click the arrow to expand the containers shown next to the icon, which will then 

be displayed in a hierarchical listing beneath their parent container. 
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ACTIONS- 

Windows Explorer 
NAVIGATING FOLDERS (CONT'D.): 

 

6. To open a file shown in the right pane, simply double-click on the file. 

7. Windows will then open the file with whatever software it thinks is best to open files of that type. If it 

doesn’t know what program to use to open the file type, it will display a message window that will allow 

you to select the type of program that you want Windows to use to attempt to open the selected file type. 

8. If you wish to view information about a file within the pane at the right side of the Windows Explorer 

window, you can click it to select it. 

9. In Windows 7 and Vista, its file properties and information will appear in a small pane at the bottom of 

the window, provided that the window is not sized too small. 

10. In Windows 8, you will need to click the “View” tab within the top of the window after selecting the file, 

and then click the “Details pane” button within the “Panes” button group at the left side of the tab to 

display properties and information about the selected file in a pane at the far right side of the Windows 

Explorer window. 

11. You can choose to leave this pane on, if you prefer, or you can hide it again when you are finished 

viewing the file’s properties by clicking the “Details pane” button again to hide its display. 

12. Within Windows Explorer, if you display the contents of a folder in the pane at the right and then realize 

that you are looking in the wrong folder, you can click the “Back” button in the toolbar below the Ribbon 

to simply move back into the last folder that you viewed. 

13. You can then click the “Forward” button to move forward again into the folder that you just left, if 

needed. 

14. If instead of moving back to the last viewed folder, you would prefer to move up one folder level within 

the folder hierarchy, as shown in the pane at the left, you can click the “Up” button to move up one folder 

level. 

CHANGING FOLDER VIEWS: 

 

1. Windows allows you to change the display of the files and folders that are shown in the right side of the 

Windows Explorer window. 

2. To change the view settings of the currently displayed folder within Windows Explorer in Windows 8, 

click the “View” tab within the Ribbon. 

3. Then click on the desired view style button shown within the listing displayed in the “Layout” button 

group. 

4. Note that you can hold your mouse pointer over any view listed to see a preview of how it would appear 

in the window below. You can then click on the choice that you prefer to apply it to the current folder. 

5. To switch the folder view in Windows 7 or Vista, click the drop-down button next to the “Change your 

view” button in Windows 7, or the “Views” button in Windows Vista, that appears at the top of the 

Windows Explorer window. 

6. Then select the view you wish to use from the drop-down menu that appears. 

7. When you click on the name of the desired view to select it, the view of the folder’s contents will change 

to reflect your choice. 

8. You can click and drag the vertical slider up and down the listing to preview your choices before 

applying one. If you do this, simply release the mouse button when you have selected the desired view. 
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ACTIONS- 

Windows Explorer 
SORTING FOLDERS: 

 

1. To do this in Windows 8, display the contents of the folder to sort within Windows Explorer. 

2. Then click the “View” tab within the Ribbon. 

3. Then click the “Sort by” drop-down button within the “Current view” button group on this tab. 

4. You can then select the attribute by which you wish to sort from the drop-down menu that appears. 

5. You can also click the button again and choose either the “Ascending” or “Descending” choice within the 

menu to sort by the selected attribute in either ascending (a-z, 0-9) or descending (z-a, 9-0) order. 

6. In Windows 7 and Vista, you can sort the contents of a displayed folder by right-clicking into the blank 

area within the folder to view a pop-up menu of choices. 

7. Roll your mouse pointer over the “Sort by” command to display a side menu of attribute choices by 

which you can sort the folder’s contents. 

8. Click on the desired attribute to sort the contents. 

9. You can also select either the “Ascending” or “Descending” choice within the side menu that appears to 

sort by the selected attribute in either ascending (a-z, 0-9) or descending (z-a, 9-0) order. Note that this 

method of sorting is also available in Windows 8. 

10. In all versions of Windows, if you are using the “Details” view of a folder’s content within the Windows 

Explorer window, you can also easily sort the contents by using the column headings that appear. 

11. To do this, simply click on the column heading by which you want to sort the contents within the folder. 

12. The items will be sorted by the information within the column in either ascending order or descending 

order. Each time you click the same column heading, it will reverse the sort order. 

13. The column that is used for sorting as well as its sort order will be indicated by a small upward or 

downward pointing arrow within the column heading. 

14. Note that Windows Explorer sorts folders separately from files when sorting folder content. 

OPENING A FILE: 

 

1. To open a file that is shown within the Windows Explorer window, you can double-click on the file. 

2. Alternately, you can right-click on the file to display a pop-up command menu. 

3. You can then click on the “Open” command within the pop-up menu to open the selected file or files. 

4. If you are using Windows 8, you can select a file within Windows Explorer and then click the “Open” or 

“Edit” buttons that appears within the “Open” button group on the “Home” tab within the Ribbon to open 

a selected file. Note that the “Edit” button will only appear active for editable files selected within the 

window. 

OPENING A RECENTLY ACCESSED FILE OR FOLDER: 

 

1. To view the recently accessed folders on your computer, click the “Recent places” icon that appears 

below the “Favorites” icon within the pane at the left side of the Windows Explorer window. 

2. The pane to the right will then show folders that you have recently displayed in Windows Explorer. 

3. If you are using Windows 7 or Vista, you can find recently accessed files by clicking the “Start” button 

and then rolling your mouse pointer over the “Recent Items” command. 

4. A side menu will then appear listing the most recently accessed files on your computer. 

5. Simply click on the file in this side menu that you want to open to access it. 
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ACTIONS- 

Windows Explorer 
OPENING A RECENTLY ACCESSED FILE OR FOLDER (CONT'D.): 

 

6. If you do not see “Recent Items” in your “Start” menu in Windows 7 or Vista, you can easily add it. Right-

click on the “Start” button and choose “Properties.” 

7. If using Windows Vista, in this window, check the “Store and display a list of my most recently opened 

files.” 

8. If using Windows 7, click the “Customize…” button and then check the “Recent Items” checkbox. 

9. Once that is done, click the “OK” button to add the item to the “Start” menu. 

10. Then click the “OK” button in the “Taskbar and Start Menu Properties” dialog box to apply the changes. 

CREATING A NEW FOLDER: 

 

1. To create a new folder, first open the folder within which you want to create a subfolder in Windows 

Explorer so that its contents are displayed in the pane at the right. 

2. Then, if using Windows 8, click the “New folder” button within the “New” button group on the “Home” tab 

in the Ribbon. 

3. If using Windows 7, instead click the “New folder” button in the toolbar at the top of the Windows 

Explorer window. 

4. If using Windows Vista, click the “Organize” button within the toolbar and then choose the “New Folder” 

command. 

5. Once this has been accomplished, Windows will create a new folder within the current folder window 

shown in the right pane and highlight the name, which is usually “New folder,” by default. 

6. You simply need to type the name that you want to give to the folder, and then click outside of the 

folder’s name box into the blank area of the window or press the “Enter” key on your keyboard, to set 

the new folder’s name. 

RENAMING FILES AND FOLDERS: 

 

1. To rename a file or folder, select the file or folder to rename within Windows Explorer. 

2. If using Windows 8, click the “Rename” button within the “Organize” button group on the “Home” tab 

within the Ribbon. 

3. If using Windows 7 or Vista, click the “Organize” button and choose the “Rename” command. 

4. Doing this will highlight the currently selected file or folder name and place a thin border around it. 

5. Simply type the new name of the file into the name box, and then click outside of the name box into the 

blank area within the window or press the “Enter” key on your keyboard, to set the new file or folder 

name. 
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ACTIONS- 

Windows Explorer 
CUTTING, COPYING, AND PASTING FILES AND FOLDERS: 

 

1. One way to cut or copy and then paste is to navigate to the file or folder that you want to cut or copy 

within Windows Explorer, so that you can see the icon for the file or folder that you want to move or copy 

in the pane at the right side of the window. 

2. Make sure that you change the Windows Explorer window’s size to “Restore” so that it is not maximized. 

3. Now open a second Windows Explorer window and use this window to navigate to the folder where you 

want to paste the item that you copy or move from the first window. 

4. Ensure that this window is using the “Restore” window size, and then place it next to the first window. 

5. At this point you can simply click and hold down on the file or folder from the first window and then drag 

it into the second window and drop it there by releasing your mouse button. If the files are located on the 

same computer drive then doing this will “cut and paste,” or move, the item. If they are on different 

computer drives, then doing this will “copy and paste” the item. 

6. If you wanted to copy the item regardless of which drive the files are located within, then simply hold 

down the “Ctrl” key on your keyboard as you drag and drop the selected file or folder. 

7. Another way to cut, copy, and paste is to click on an item in a Windows Explorer window that you want 

to cut or copy to select it. 

8. Next, if using Windows 8, click either the “Copy” or “Cut” buttons, as desired, shown within the 

“Clipboard” group on the “Home” tab in the Ribbon. 

9. If using Windows 7 or Vista, click the “Organize” button in the toolbar at the top of Windows Explorer 

and choose either the “Cut” or “Copy” command, as desired. 

10. Next, navigate into the folder that you want to paste the item that you just cut or copied using Windows 

Explorer. You may use the same window, if desired. 

11. If using Windows 8, then click the “Paste” button within the “Clipboard” group on the “Home” tab in the 

Ribbon to paste the item. 

12. If using Windows 7 or Vista, click the “Organize” button in the toolbar at the top of the Windows Explorer 

window and choose the “Paste” command from the drop-down menu that appears to paste the item. 

13. Another way to cut, copy, and paste is also available if you are using Windows 8. Using this method, 

you first select the file or folder to cut or copy within the Windows Explorer window. 

14. Then you can click either the “Move to” or “Copy to” buttons shown within the “Organize” group on the 

“Home” tab in the Ribbon depending on whether you wish to move or copy the selected item. 

15. From the drop-down menu that appears, you can then select the name of one of the recently accessed 

folders or libraries to paste the item into the selected folder. 

16. You can also click the “Choose location…” command at the bottom of either drop-down menu to open a 

“Move Items” or “Copy Items” window. 

17. Within this window, you use the hierarchical folder navigation shown to select the destination folder 

where you want the selected item to be moved or copied. You use this window to select a folder, just as 

you use the navigator in the pane at the left side of Windows Explorer. 

18. Once you select the destination folder within this window, click either the “Move” or “Copy” button that 

appears at the bottom of the “Move Item” or “Copy Item” window to move or copy the selected item and 

close the window. 

19. One last way to cut, copy, and paste files and folders is by using the keyboard. To do this, first select the 

item you want to copy or move within Windows Explorer and then press either the “Ctrl” + “C” keys on 

your keyboard to copy the item or the “Ctrl” + “X” keys on your keyboard to cut the item. 

20. Then navigate into the folder where you want to paste the item that you just selected. 

21. To then paste the item that you just cut or copied into the selected folder, press the “Ctrl” + “V” keys on 
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ACTIONS- 

Windows Explorer 
BURNING A CD OR DVD: 

 

1. Most new computers have a CD or DVD drive that can write to recordable CDs or DVDs so that you can 

save content from your computer onto removable media for transfer. To burn a CD or DVD using files 

from your computer, you must first insert a blank, recordable CD or DVD into the recording drive. 

2. In Windows 8, a small message box appears in the Start screen telling you to tap the message box in 

order to determine what Windows 8 should do when a blank CD or DVD is inserted. 

3. Once you tap or click on the message box another window appears showing you the actions that your 

computer can take using the software programs that are available. 

4. In Windows 7 and Vista, an “AutoPlay” window will appear onscreen when you insert the CD or DVD, 

offering you the same choices. 

5. We will examine what will occur if you select the “Burn files to disc (using Windows Explorer)” command 

in either window. 

6. In the “Burn a disc” window that then appears, start by typing a name for the disc into the “Disc title:” text 

box. 

7. If using Windows Vista, you may need to click the “Show formatting options” button to select a format for 

the disc. 

8. In Windows 8 and 7, these options appear automatically within the “Burn a disc” window. 

9. If you select the “Like a USB flash drive” choice (“Live File System” in Windows 7 and Vista), you will 

format the disc to behave like a removable drive to which you can add and erase files, just like a USB 

drive. This disc may not work on computers using versions of Windows prior to Windows XP, however. 

10. You can select the “With a CD/DVD player” choice (“Mastered” in Windows 7 and Vista) to create a 

standard, recordable disc that will play on most computers and CD players. 

11. Once you have made, your selection, click the “Next” button to continue. 

12. If you selected the “Like a USB flash drive” choice, then Windows will format the disc and then display it 

within a Windows Explorer window when it is finished formatting it. You can then use the disc as if it 

were any other folder on your system. You can copy files to the disc and delete them when you are 

finished. 

13. If you selected the “With a CD/DVD player” option, then you will next view an empty Windows Explorer 

window where you will need to copy the files and folders that you want to burn to the CD or DVD. 

14. If using Windows 8, you can then click the “Burn to disc” button within the “Send” button group on the 

“Share” tab within the Ribbon to burn the selected files to the disc. 

15. If using Windows 7 or Vista, click the “Burn to disc” command button in the toolbar at the top of the 

Windows Explorer window to burn the contents of the window to the disc. 

DELETING FILES: 

 

1. To delete a file, use Windows Explorer to navigate to the folder that contains the file that you want to 

delete. 

2. Then select the file you want to delete within the window shown. 

3. You can then press the “Delete” or “Del” key on your keyboard to delete the selected files or folders. 

4. Alternately, if using Windows 8, click the “Delete” button in the “Organize” group on the “Home” tab in 

the Ribbon or if using Windows 7 or Vista, click the “Organize” button in the Windows Explorer toolbar 

and then click the “Delete” command. 

 (cont'd.) Sa
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ACTIONS- 

Windows Explorer 
DELETING FILES (CONT'D.): 

 

5. Windows will then display a prompt where you will be asked if you are sure you want to send the file to 

the “Recycle Bin,” if you are deleting a file from your “C:” drive. 

6. Otherwise, it will ask if you want to permanently delete the file. If you click “Yes,” Windows will then 

either place the file in the “Recycle Bin” or delete it completely. Be sure to only delete files you created! 

7. Also note changes made to the “Delete” button within Windows Explorer in Windows 8. You can click 

the drop-down arrow under the “Delete” button in the “Organize” group on the “Home” tab in the Ribbon 

to select other choices for file deletion. 

8. You can select the “Recycle” command to move the item to the recycle bin. 

9. You can select the “Permanently delete” command to permanently delete the file. 

10. Also, you can toggle the display of the warning prompt for file recycling on or off by choosing the “Show 

recycle confirmation” command. If it appears checked, the confirmation will appear onscreen when 

deleting files. If unchecked the confirmation will not appear. 

MANAGING LIBRARIES IN WINDOWS 8: 

 

1. Select the “Libraries” icon within the left pane in Windows Explorer. 

2. Select a desired library to manage from the listing shown in the right pane. 

3. At the top of the application, you will then see a new contextual tab appear in the Ribbon named “Library 

Tools.” Click the “Manage” tab within this contextual tab in the Ribbon to see your library management 

commands. 

4. To choose which folders are included in the selected library, click the “Manage library” button to open a 

dialog box that allows you to manage the folders that are included in the selected library. 

5. To add a new folder, click the “Add…” button at the right side of the dialog box to open a window that 

allows you to browse to and then select the folder for inclusion in the library. 

6. Once you have selected the desired folder, click the “Include folder” button to add the selected folder to 

your library. 

7. You can also remove a folder from the library by selecting a folder shown within the dialog box and then 

clicking the “Remove” button. 

8. Once you have finished selecting the desired folders for inclusion in your library, click the “OK” button to 

apply your changes. 

9. You can also choose which folder within a library will be set as the default save folder for a library. To do 

this, click the “Set save location” drop-down button within the Ribbon and then choose a desired folder 

from the drop-down menu that appears. 

10. You can also reset changes that you have made to a selected library by simply clicking the “Restore 

settings” button within the Ribbon to reset the selected library back to its defaults. 
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ACTIONS- 

Windows Explorer 
MANAGING THE COMPUTER AND DISKS IN WINDOWS 8: 

 

1. Click the “Computer” icon at the left side of Windows Explorer. 

2. If desired, you can then click on a hard drive disk to manage shown in the pane at the right side of the 

Windows Explorer window. 

3. You can click the “Computer” tab shown within the Ribbon of Windows Explorer in order to access 

computer management and system commands. Computer network commands are shown in the 

“Network” button group and system management commands are shown within the “System” group. 

4. In the “Network” group on the “Computer” tab you can click the “Map network drive” button to display a 

drop-down menu that allows your to create a network drive mapping or disconnect a mapped network 

drive. 

5. To create a network drive mapping, select the “Map network drive” command and then assign a drive 

letter and enter a network location into the dialog box that appears. Then click the “Finish” button to add 

the mapped network drive. 

6. You can also choose the “Disconnect network drive” command to open a dialog box where you can 

choose the mapped drive to disconnect and then click the “OK” button to remove the selected drive’s 

mapping. 

7. If you want to add a shortcut to an FTP site or other network location, you can click the “Add a network 

location” button to open the “Add network location” wizard. Here you can enter the necessary 

information in order to access the desired network location and save it to your computer. 

8. In the “System” group on the “Computer” tab you can click the “Open Control Panel” button to open the 

“Control Panel” for your computer. 

9. You can click the “Uninstall or change a program” button to open the “Programs and Features” pane 

within the “Control Panel” window where you can manage the software installed on your computer. 

10. You can click the “System properties” button to open a window that displays the properties of your 

computer. 

11. You can click the “Manage” button to open the “Computer Management” window that allows you to 

manage the devices, hard drives, and other hardware settings on your computer. 

12. If you selected a hard disk drive within Windows Explorer, you can then click the “Manage” tab within 

the “Drive Tools” contextual tab within the Ribbon at the top of Windows Explorer to display disk 

management commands. 

13. You can click the “Optimize” button to defragment the selected computer hard drive for optimal 

performance. 

14. You can click the “Cleanup” button to run the “Disk Cleanup” utility on the selected drive. This allows 

you to select temporary files to remove from the selected drive in order to free more drive space. 
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EXERCISES- 

Windows Explorer 
Purpose: 

 

1. To be able to use Windows Explorer to navigate through the folders in your computer. 

Exercises: 

 

1. If using Windows 8, click the “Desktop” app within the “Start” screen to open the “Desktop.” 

2. Click the “Windows Explorer” button shown in the lower left corner of the screen within the Windows 

Taskbar to open the “Windows Explorer” window. 

3. If using Windows 7 or Vista, click the “Start” button in the lower left corner of the “Desktop” and 

then click the “Computer” command in the pop-up menu that appears to open the “Windows 

Explorer” window. 

4. At the left side of the “Windows Explorer” window, click the “Computer” icon shown in the 

“Navigation Bar.” 

5. The contents of your computer will then display in the pane at the right side of the “Windows 

Explorer” window. 

6. Double-click on the “(C:)” drive that is displayed in the pane at the right side of the window under the 

“Hard Disk Drives” category to display the content’s of your computer’s “C:” drive. 

7. Within the pane at the right side of the “Windows Explorer” window, double-click on the “Users” 

folder icon in order to display the folders of the users on your computer in the pane at the right. 

8. Within the pane at the right side of the “Windows Explorer” window, double-click on the “Public” 

folder icon in order to display the public folders on your computer in the pane at the right. 

9. Click the “Back” button shown within the “Back, Forward, and Up” button group to go back to the 

“Users” folder you were just viewing. 

10. Click the “Up” button shown within the “Back, Forward, and Up” button group to go up one level 

within the folder hierarchy to the “C:” drive. 

11. Click the “Documents” icon under the “Libraries” icon within the “Navigation Bar” at the left side of 

the “Windows Explorer” window. 

12. Close the “Windows Explorer” window by clicking the red “X” button in the far upper-right corner of 

the window. 
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CHAPTER 3- 

Windows 8 Settings 

3.1- Accessing Settings in Windows 8 

 

3.2- Personalizing Windows 8 

 

3.3- Managing Users in Windows 8 

 

3.4- Notifications in Windows 8 

 

3.5- Managing Search Settings in Windows 8 

 

3.6- Managing Sharing Settings in Windows 8 

 

3.7- General Settings in Windows 8 

 

3.8- Privacy Settings in Windows 8 

 

3.9- Managing Devices in Windows 8 

 

3.10- Wireless Options in Windows 8 

 

3.11- Ease of Access Settings in Windows 8 

 

3.12- Sync Settings in Windows 8 

 

3.13- Homegroup Settings in Windows 8 

 

3.14- Windows Update in Windows 8 

 

3.15- File History in Windows 8 
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Windows 8 Settings 

3.1- Accessing Settings in Windows 8: 

 

 You can access the settings in Windows 8 through the Charm Bar that can be shown within the Start 

screen. These settings allow you to control many aspects of apps within your computer, laptop, or tablet. To 

show the settings for the currently displayed app on your computer, roll your pointer to the upper-right or 

lower-right corners of the Windows 8 screen until the Charm Bar appears. Then roll your pointer over the 

Charm Bar until it appears solid. You can also open it by swiping in from the right edge of a touch screen, or 

by simply pressing the Windows + C keys on your keyboard. Then click the “Settings” button within the 

Charm Bar to display the settings in a pane at  the right side of the window. 

 At the top of the “Settings” panel you can click the links shown in order to access settings for the 

currently displayed app within Windows 8. For example, if viewing the Start screen, then these commands 

are “Tiles” and “Help.” However, if viewing the Desktop, then these choices are “Control Panel,” 

Personalization,” “PC info” and “Help.” You will see the name of the currently displayed app followed by the 

different settings available for that app at the top of the “Settings” panel. 

 At the bottom of the panel you can see icons that represent general computer settings, such as your 

internet connection, audio, display settings, notification settings, power settings, and default language. At 

the very bottom of the pane, you can click the “Change PC settings” command in order to display all of your 

available computer settings in a full-screen window. If you simply wish to hide the “Settings” panel without 

making any changes, click back into the middle of the screen again to hide the side panel. 

 If you click the “Change PC settings” command at the bottom of the “Settings” panel, you will see the 

“PC settings” window appear. Here you can adjust your computer’s settings to customize your Windows 8 

experience. Within this window, you can click on the categories shown at the left side in order to change the 

various settings within that category to the right. The categories shown for most computing devices include 

“Personalize,” “Users,” “Notifications,” “Search,” “Share,” “General,” “Privacy,” “Devices,” “Wireless,” “Ease 

of Access,” “Sync your settings,” “HomeGroup,” and “Windows Update.” In the lessons within this chapter, 

we will discuss changing many of these settings to customize your Windows 8 experience. 

 When you have finished changing any settings that you want and wish to close the settings window, 

you close it as you would any other app within Windows 8. Roll to the top of the window, and then click and 

drag the application off the bottom of the screen to close the “PC settings” app window. 
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Windows 8 Settings 

3.2- Personalizing Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Personalize” category at the 

left side of the screen to display the personalization options in the area to the right. Within this category, the 

options are grouped into three main subcategories listed as commands shown at the top of the right side: 

“Lock screen,” “Start screen,” and “Account picture.” 

 If you click the “Lock screen” command, you will see a picture of your current lock screen shown 

below it. This is the screen shown when you have locked your account or logged off of Windows 8. You can 

select a new lock screen picture by selecting one of the choices shown below the current lock screen, or 

you can click the “Browse” button to display the picture files on your computer within a “Files” window where 

you can click on your choice, and then click the “Choose picture” button. You can also click the “Cancel” 

button within the “Files” screen to return to the “PC settings” window without making a picture selection. 

 Once you have returned to the “Lock screen” section within the “PC settings” app window, note that 

you can right-click on either the picture of the lock screen or the sample pictures shown, and then click the 

“Revert to defaults” button that appears to revert either group back to their default settings, if needed. 

 Below the lock screen pictures, you can see the “Lock screen apps” category shown. Here you 

select which of the apps that you have installed in Windows 8 will be allow to show summary or detail 

information on the lock screen when it is displayed. Click on one of the small plus signs shown in this area 

to then select the app whose information you wish to display in the lock screen from a pop-up menu that 

appears. You can also click on an app icon shown here and then select the “Don’t show quick status here” 

command from the pop-up menu to remove an app from this section. You can also select an app from which 

you want to show detailed status updates by clicking the icon under the “Choose an app to display detailed 

status” section, and then choosing your desired app from the pop-up menu shown. 

 At the top of the “Personalize” category, you can then click the “Start screen” command in order to 

customize settings for the display of your Windows 8 Start screen. You can choose a background by 

clicking on your desired choice from the listing shown. You can then select a desired background color by 

choosing one from the color strip shown. 

 Finally, you can click the “Account picture” command at the top of the “Personalize” window to select 

an account picture to use for your Windows login. You can click the “Browse” button to open the “Files” 

window where you can select an image. You can click the “Files” command to display a listing of available 

folders you can search for images within, if needed. Then select an image and click the “Choose image” 

button to use the selected image as your account picture. You can click the “Cancel” button if you decide not 

to select an account picture and wish to return to the “Account picture” screen. On this screen, if you have 

an app installed that you can use to create an account picture, you can select the desired app under the 

“Create an account picture” section to use the selected app to create your account picture. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



49 Mastering Windows Made Easy v. 8-Vista ©TeachUcomp, Inc. 

Windows 8 Settings 

3.3- Managing Users in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Users” category at the left side 

of the screen to display the user management options in the area to the right. Within this category, the 

options are grouped into three main subcategories listed at the right side: “Your account,” “Sign-in options,” 

and “Other users.” 

 Under the “Your account” section, you will see your account picture displayed. If you are using a 

local account, you can click the “Switch to a Microsoft account” and then follow the onscreen prompts in 

order to use a Microsoft account in order to login to Windows 8. You can then set your Windows 8 settings 

on one device and synchronize them across all of your other Windows 8 devices that use the same login. 

 Under the “Sign-in options” section, you can change your login settings for your login. You can 

change your password to login by clicking the “Change your password” button and then following the 

onscreen prompts to reset your login password. For touch screen devices, such as a tablet PC, you can 

click the “Create a picture password” button and then follow the onscreen prompts to create a picture that 

you must click in specific areas in order to login to a touch screen computing device. You can click the 

“Create a PIN” button and then follow the onscreen prompts in order to create four-digit PIN number that 

can also be used to allow access to touch screen devices in conjunction with a picture password for added 

security. 

 Under the “Other users” section, you can click the “Add a user” button and then follow the onscreen 

prompts in order to create additional user accounts on your computer. 

3.4- Notifications in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Notifications” category at the 

left side of the screen to display the notification options in the area to the right. Within this category, the 

options are grouped into two main subcategories listed at the right side: “Notifications” and “Show 

notifications from these apps.” 

 Under the “Notifications” section, you can click each switch shown to toggle its settings to either “On” 

or “Off” for the three settings shown in this area. The settings are “Show app notifications,” “Show app 

notifications on the lock screen,” and “Play notification sounds.” You can turn these on or off to customize 

the appearance of notifications from apps within Windows 8. 

 Under the “Show notifications from these apps” section, you can decide from which apps you wish to 

receive notifications. This allows you to further customize the number and type of notifications that you 

receive from apps when using Windows 8. For each app listed, you can click the “On” and “Off” switch to 

toggle the notifications on or off for each app shown. 
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Windows 8 Settings 

3.5- Managing Search Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Search” category at the left 

side of the screen to display the search options in the area to the right. Within this category, the options are 

grouped into two main subcategories listed at the right side: “Search history” and “Use these apps to 

search.” 

 Under the “Search history” section, you can click the “On” and “Off” toggle switches shown in order 

to enable or disable each search feature listed. Your options are “Show the apps I search most often at the 

top” and “Let Windows save my searches as future search suggestions.” You can also click the “Delete 

history” button to delete your search history in Windows 8. 

 Under the “Use these apps to search” section, you can click the “On” and “Off” switch to toggle the 

search feature on or off for each searchable app listed. This will either allow or disallow Windows from 

searching for any search terms that you enter within the content stored in these apps. 

3.6- Managing Sharing Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Share” category at the left side 

of the screen to display the sharing options in the area to the right. Within this category, the options are 

grouped into two main subcategories listed at the right side: “Frequent” and “Use these apps to share.” 

 Under the “Frequent” section, you can click the “On” and “Off” toggle switch shown in order to enable 

or disable whether or not you want to display a list of the ways that you share most often in Windows 8. If 

you do want to maintain a list, then select the number of items to display in the list from the adjacent drop-

down menu. If you enable the list you can then click the “On/Off” switch to enable or disable sorting of the 

apps that you use most often to share under the “Show apps I use most often at the top of the app list” 

option. 

 Under the “Use these apps to share” section, you can click the “On” and “Off” switch to toggle the 

sharing feature on or off for each shareable app listed. This will either allow or disallow Windows from using 

these apps to share content from your computer using the “Share” icon within the Charm Bar in Windows 8. 

3.7- General Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “General” category at the left 

side of the screen to display general Windows options in the area to the right. Within this category, the 

options are grouped into eight main subcategories listed at the right side: “Time,” “App switching,” “Spelling,” 

“Language,” “Available storage,” “Refresh your PC without affecting your files,” “Remove everything and 

reinstall Windows,” and “Advanced Startup.” 

 Under the “Time” section, you can select your time zone from the drop-down menu. You can also 

click the “On/Off” switch to enable or disable the “Adjust for daylight savings time automatically” option. 

 Under the “App switching” section, you can click the “On” and “Off” switch to toggle app switching on 

or off within Windows 8. You can also choose if you want Windows to switch to your most recently used app 

when you swipe in from the left edge. If you have app switching enabled, you can click the “Delete history” 

button to delete the history of apps that you have recently used within Windows 8. 

 Under the “Spelling” category, you can click the “On/Off” switch to enable or disable the “Autocorrect 

misspelled words” and “Highlight misspelled words” options. 

 Under the “Language” section, you can choose which language to use by default in Windows 8 by 

clicking the “Language Preferences” command to open the “Control Panel” window which will allow you to 
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Windows 8 Settings 

3.7- General Settings in Windows 8 (cont'd.): 

 

select a default language to use for Windows 8. 

 Next, under the “Available Storage” section, you can see how much space is being used by the apps 

installed on your hard drive. You can click the “View app sizes” button to open a separate window that 

displays the current storage sizes of all of the apps installed on your computer. 

 If needed, you can click the “Get started” button under the “Refresh your PC without affecting your 

files” section and then follow the onscreen prompts to allow windows to perform a clean-up of your system 

without having to lose files that you have created. 

 If you plan on giving away your PC or you wish to trash all of the content on your computer and start 

over, then you can click the “Get started” button under the “Remove everything and reinstall Windows” 

section and then follow the onscreen prompts to erase and reset your computer. Note that this is an extreme 

choice that will completely wipe out all of the files and settings on your computer, forcing you to start over 

from scratch. You should only do this if you are planning to give the computer away and only after you have 

safely backed up all files and folders that you wish to keep from your PC, first. 

 If you need to change the way that Windows 8 boots up by default, you can change the boot and 

startup settings by clicking the “Restart now” button under the “Advanced startup” section. This is 

sometimes used by computer professionals in order to allow Windows 8 to boot from an alternate device, 

such as a USB dive, and is not often needed by most users. 

3.8- Privacy Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Privacy” category at the left 

side of the screen to display the privacy options in the area to the right. Here you can click the “On” and “Off” 

toggle switch shown in order to enable or disable privacy settings in Windows 8. The privacy settings that 

you can enable or disable are “Let apps use my location,” “Let apps use my name and account picture,” and 

“Help improve Windows Store by sending URLs for the web content that apps use.” You can also click the 

“Privacy statement” command to read Microsoft’s Windows 8 privacy statement in your default web browser. 

3.9- Managing Devices in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Devices” category at the left 

side of the screen to display a listing of connected peripheral devices in the area to the right. You can click 

the “Add a device” button to manually search for devices, such as USB-connected devices, if needed. You 

should see all connected devices displayed within this list. You can click on a device shown in the listing to 

select it. You can then click the small minus sign at the right end of it to remove the connected device, if 

needed. You will need to click the “Yes” button in the confirmation box that appears. 

3.10- Wireless Options in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Wireless” category at the left 

side of the screen to display the wireless options in the area to the right. Here you can click the “On” and 

“Off” toggle switch shown in order to enable or disable the wireless options shown in Windows 8. The 

wireless options that you can enable or disable are “Airplane mode” and “Wireless Devices.” You can 

enable “Airplane mode” to disable wireless communication when flying, and you can turn your wireless 

connection on and off using the “Wireless devices” setting. Sa
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Windows 8 Settings 

3.11- Ease of Access Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Ease of Access” category at 

the left side of the screen to display accessibility settings in the area to the right. You can click the “On” and 

“Off” toggle switches shown in order to enable or disable the accessibility settings shown. The settings that 

you can enable or disable are “High contrast” and “Make everything on your screen bigger.” You can then 

select what you want “Pressing Windows + Volume Up will turn on” to do by selecting a choice from the 

drop-down menu. By default, this enables the Narrator feature. You can also select how long you want to 

“Show notifications for” from the adjacent drop-down. You can also set the default “Cursor thickness” from 

the drop-down that is shown. 

3.12- Sync Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Sync your settings” category 

at the left side of the screen to display Windows 8 synchronization settings in the area to the right. Within 

this category, the options are grouped into three main subcategories listed at the right side: “Sync your 

settings,” “Settings to sync,” and “Sync over metered connections.” Note that in order to change any settings 

shown within this category, you must first sign-in to your Windows computer using a Microsoft user account, 

versus a local user account, and you must also have internet connectivity. 

 Within this category, you can click the “On” and “Off” toggle switches shown in order to enable or 

disable the settings shown. To enable Microsoft user account syncing, enable the “Sync settings on this PC” 

option. You can then choose what options to synch by enabling or disabling the following settings: 

“Personalize,” “Desktop personalization,” “Passwords,” “Ease of Access,” “Language preferences,” “App 

settings,” “Browser,” and “Other Windows settings.” Under the “Sync over metered connections” section you 

can enable or disable the “Sync settings over metered connections” and “Sync settings over metered 

connections even when I’m roaming” options. You can enable the “Metered Internet connections” setting to 

sync data usage settings amongst devices to help prevent extra charges. 

3.13- HomeGroup Settings in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “HomeGroup” category at the 

left side of the screen to display Windows 8 HomeGroup settings in the area to the right. You can click the 

“Create” button shown here to enable these settings and create a HomeGroup if they are not displayed. 

Once the settings are displayed, the options are grouped into three main subcategories listed at the right 

side: “Libraries and devices,” “Media devices,” and “Membership.” The options shown here allow you to 

change your home networking configuration and file sharing options. 

 You can click the “On” and “Off” toggle switches shown within the “Libraries and devices” section in 

order to enable or disable sharing of the files, folders, and devices listed. These settings are: “Documents,” 

“Music,” “Pictures,” “Videos,” and “Printers and devices.” You can enable sharing of content with TVs and 

gaming consoles by enabling the “Media devices” “On/Off” switch. In the “Membership” section, you can 

view the “HomeGroup” password, which is required by any devices that wish to join your home network. If 

you want to remove your computer from the HomeGroup network, you can click the “Leave” button to leave. 
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Windows 8 Settings 

3.14- Windows Update in Windows 8: 

 

 Within the “PC settings” app window in Windows 8, you can click the “Windows Update” category at 

the left side of the screen to display Windows Update information in the area to the right. If you have 

configured Windows Update to automatically check for updates, that information will be displayed here. You 

can also view when the last check for updates occurred. You can click the “Check for updates” button to 

manually check for updates, if desired.  

3.15- File History in Windows 8: 

 

 File History in Windows 8 allows you to backup files on your computer that you have saved into your 

libraries, contacts, favorites, and Desktop folders. To ensure that you are backing up the files you want to 

save, be sure to save your files into your libraries, such as your “Documents” folder, or copy files into these 

folders to ensure that they are backed up properly. You should also backup your files to an external hard 

drive for safekeeping, or to a network location, but not on your computer’s hard drive as all data could be 

lost in the event of a hard drive failure. 

 You can open File History by opening the Control Panel on your computer. You can then click the 

“Save backup copies of your files with File History” hyperlink under the “System and Security” section within 

the Control Panel. To enable File History, click the “Turn on” button at the right side of the screen. You 

should see the external hard drive or network location to where the files will be saved shown at the top of 

the screen. 

 You can change the location to where the files will be saved by clicking the “Select drive” command 

at the left side of the screen. Here you can select an external dive from the listing shown at the top of the 

window, or you can click the “Add network location” button to open a “Select Folder” window where you can 

choose a network location. Once you have selected a network location, click the “Select Folder” button to 

set it. You can then click the “OK” button within the “Select Drive” window to save the selected location. 

 If you need to restore a saved file, note that you can click the “Restore personal files” command at 

the left side of the “File History” window to do so. You can then follow the onscreen prompts that appear in 

the new window that opens in order to select a File History backup to use for the file restoration. 
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ACTIONS- 

Windows 8 Settings 
ACCESSING SETTINGS IN WINDOWS 8: 

 

1. To show the settings for the currently displayed app on your computer, roll your pointer to the upper-

right or lower-right corners of the Windows 8 screen until the Charm Bar appears. 

2. Then roll your pointer over the Charm Bar until it appears solid. 

3. You can also open it by swiping in from the right edge of a touch screen, or by simply pressing the 

Windows + C keys on your keyboard. 

4. Then click the “Settings” button within the Charm Bar to display the settings in a pane at  the right side 

of the window. 

5. At the top of the “Settings” panel you can click the links shown in order to access settings for the 

currently displayed app within Windows 8. You will see the name of the currently displayed app followed 

by the different settings available for that app at the top of the “Settings” panel. 

6. At the bottom of the panel you can see icons that represent general computer settings, such as your 

internet connection, audio, display settings, notification settings, power settings, and default language. 

7. At the very bottom of the pane, you can click the “Change PC settings” command in order to display all 

of your available computer settings in a full-screen window. 

8. If you simply wish to hide the “Settings” panel without making any changes, click back into the middle of 

the screen again to hide the side panel. 

9. If you click the “Change PC settings” command at the bottom of the “Settings” panel, you will see the 

“PC settings” window appear. 

10. Within this window, you can click on the categories shown at the left side in order to change the various 

settings within that category to the right. The categories shown for most computing devices include 

“Personalize,” “Users,” “Notifications,” “Search,” “Share,” “General,” “Privacy,” “Devices,” “Wireless,” 

“Ease of Access,” “Sync your settings,” “HomeGroup,” and “Windows Update.” 

11. When you have finished changing any settings that you want and wish to close the settings window, roll 

to the top of the window, and then click and drag the application off the bottom of the screen to close the 

“PC settings” app window. 

PERSONALIZING WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Personalize” category at the left 

side of the screen to display the personalization options in the area to the right. 

2. Within this category, the options are grouped into three main subcategories listed as commands shown 

at the top of the right side: “Lock screen,” “Start screen,” and “Account picture.” 

3. If you click the “Lock screen” command, you will see a picture of your current lock screen shown below 

it. This is the screen shown when you have locked your account or logged off of Windows 8. 

4. You can select a new lock screen picture by selecting one of the choices shown below the current lock 

screen, or you can click the “Browse” button to display the picture files on your computer within a “Files” 

window where you can click on your choice, and then click the “Choose picture” button. 

5. You can also click the “Cancel” button within the “Files” screen to return to the “PC settings” window 

without making a picture selection. 

6. Once you have returned to the “Lock screen” section within the “PC settings” app window, note that you 

can right-click on either the picture of the lock screen or the sample pictures shown, and then click the 

“Revert to defaults” button that appears to revert either group back to their default settings, if needed. 

 (cont'd.) Sa
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ACTIONS- 

Windows 8 Settings 
PERSONALIZING WINDOWS 8 (CONT'D.): 

 

7. Below the lock screen pictures, you can see the “Lock screen apps” category shown. Here you select 

which of the apps that you have installed in Windows 8 will be allow to show summary or detail 

information on the lock screen when it is displayed. 

8. Click on one of the small plus signs shown in this area to then select the app whose information you 

wish to display in the lock screen from a pop-up menu that appears. 

9. You can also click on an app icon shown here and then select the “Don’t show quick status here” 

command from the pop-up menu to remove an app from this section. 

10. You can also select an app from which you want to show detailed status updates by clicking the icon 

under the “Choose an app to display detailed status” section, and then choosing your desired app from 

the pop-up menu shown. 

11. At the top of the “Personalize” category, you can then click the “Start screen” command in order to 

customize settings for the display of your Windows 8 Start screen. 

12. You can choose a background by clicking on your desired choice from the listing shown. 

13. You can then select a desired background color by choosing one from the color strip shown. 

14. Finally, you can click the “Account picture” command at the top of the “Personalize” window to select an 

account picture to use for your Windows login. 

15. You can click the “Browse” button to open the “Files” window where you can select an image. 

16. You can click the “Files” command to display a listing of available folders you can search for images 

within, if needed. 

17. Then select an image and click the “Choose image” button to use the selected image as your account 

picture. 

18. You can click the “Cancel” button if you decide not to select an account picture and wish to return to the 

“Account picture” screen. 

19. On this screen, if you have an app installed that you can use to create an account picture, you can 

select the desired app under the “Create an account picture” section to use the selected app to create 

your account picture. 

MANAGING USERS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Users” category at the left side of 

the screen to display the user management options in the area to the right. 

2. Within this category, the options are grouped into three main subcategories listed at the right side: “Your 

account,” “Sign-in options,” and “Other users.” 

3. Under the “Your account” section, you will see your account picture displayed. If you are using a local 

account, you can click the “Switch to a Microsoft account” and then follow the onscreen prompts in order 

to use a Microsoft account in order to login to Windows 8. You can then set your Windows 8 settings on 

one device and synchronize them across all of your other Windows 8 devices that use the same login. 

4. Under the “Sign-in options” section, you can change your login settings for your login. 

5. You can change your password to login by clicking the “Change your password” button and then 

following the onscreen prompts to reset your login password. 

6. For touch screen devices, such as a tablet PC, you can click the “Create a picture password” button and 

then follow the onscreen prompts to create a picture that you must click in specific areas in order to 

login to a touch screen computing device. 

 (cont'd.) Sa
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ACTIONS- 

Windows 8 Settings 
MANAGING USERS IN WINDOWS 8 (CONT'D.): 

 

7. You can click the “Create a PIN” button and then follow the onscreen prompts in order to create four-

digit PIN number that can also be used to allow access to touch screen devices in conjunction with a 

picture password for added security. 

8. Under the “Other users” section, you can click the “Add a user” button and then follow the onscreen 

prompts in order to create additional user accounts on your computer. 

SETTING NOTIFICATIONS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Notifications” category at the left 

side of the screen to display the notification options in the area to the right. 

2. Within this category, the options are grouped into two main subcategories listed at the right side: 

“Notifications” and “Show notifications from these apps.” 

3. Under the “Notifications” section, you can click each switch shown to toggle its settings to either “On” or 

“Off” for the three settings shown in this area. 

4. The settings are “Show app notifications,” “Show app notifications on the lock screen,” and “Play 

notification sounds.” You can turn these on or off to customize the appearance of notifications from apps 

within Windows 8. 

5. Under the “Show notifications from these apps” section, you can decide from which apps you wish to 

receive notifications. 

6. For each app listed, you can click the “On” and “Off” switch to toggle the notifications on or off for each 

app shown. 

MANAGING SEARCH SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, click the “Search” category at the left side of the 

screen to display the search options in the area to the right. 

2. Within this category, the options are grouped into two main subcategories listed at the right side: 

“Search history” and “Use these apps to search.” 

3. Under the “Search history” section, you can click the “On” and “Off” toggle switches shown in order to 

enable or disable each search feature listed. Your options are “Show the apps I search most often at the 

top” and “Let Windows save my searches as future search suggestions.” 

4. You can also click the “Delete history” button to delete your search history in Windows 8. 

5. Under the “Use these apps to search” section, you can click the “On” and “Off” switch to toggle the 

search feature on or off for each searchable app listed. This will either allow or disallow Windows from 

searching for any search terms that you enter within the content stored in these apps. 
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ACTIONS- 

Windows 8 Settings 
MANAGING SHARING SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Share” category at the left side of 

the screen to display the sharing options in the area to the right. Within this category, the options are 

grouped into two main subcategories listed at the right side: “Frequent” and “Use these apps to share.” 

2. Under the “Frequent” section, you can click the “On” and “Off” toggle switch shown in order to enable or 

disable whether or not you want to display a list of the ways that you share most often in Windows 8. 

3. If you do want to maintain a list, then select the number of items to display in the list from the adjacent 

drop-down menu. 

4. If you enable the list you can then click the “On/Off” switch to enable or disable sorting of the apps that 

you use most often to share under the “Show apps I use most often at the top of the app list” option. 

5. Under the “Use these apps to share” section, you can click the “On” and “Off” switch to toggle the 

sharing feature on or off for each shareable app listed. This will either allow or disallow Windows from 

using these apps to share content from your computer using the “Share” icon within the Charm Bar in 

Windows 8. 

MANAGING GENERAL SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, click the “General” category at the left side of the 

screen to display general Windows options in the area to the right. 

2. Within this category, the options are grouped into eight main subcategories listed at the right side: 

“Time,” “App switching,” “Spelling,” “Language,” “Available storage,” “Refresh your PC without affecting 

your files,” “Remove everything and reinstall Windows,” and “Advanced Startup.” 

3. Under the “Time” section, you can select your time zone from the drop-down menu. You can also click 

the “On/Off” switch to enable or disable the “Adjust for daylight savings time automatically” option. 

4. Under the “App switching” section, you can click the “On” and “Off” switch to toggle app switching on or 

off within Windows 8. You can also choose if you want Windows to switch to your most recently used 

app when you swipe in from the left edge. If you have app switching enabled, you can click the “Delete 

history” button to delete the history of apps that you have recently used within Windows 8. 

5. Under the “Spelling” category, you can click the “On/Off” switch to enable or disable the “Autocorrect 

misspelled words” and “Highlight misspelled words” options. 

6. Under the “Language” section, you can choose which language to use by default in Windows 8 by 

clicking the “Language Preferences” command to open the “Control Panel” window. 

7. Under the “Available Storage” section, you can see how much space is being used by the apps installed 

on your hard drive. You can click the “View app sizes” button to open a separate window that displays 

the current storage sizes of all of the apps installed on your computer. 

8. If needed, you can click the “Get started” button under the “Refresh your PC without affecting your files” 

section and then follow the onscreen prompts to allow windows to perform a clean-up of your system 

without having to lose files that you have created. 

9. If you plan on giving away your PC or you wish to trash all of the content on your computer and start 

over, then you can click the “Get started” button under the “Remove everything and reinstall Windows” 

section and then follow the onscreen prompts to erase and reset your computer. You should only do this 

if you are planning to give the computer away and only after you have safely backed up all files and 

folders that you wish to keep from your PC, first. 

10. If you need to change the way that Windows 8 boots up by default, you can change the boot and startup 

settings by clicking the “Restart now” button under the “Advanced startup” section. Sa
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ACTIONS- 

Windows 8 Settings 
MANAGING PRIVACY SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Privacy” category at the left side 

of the screen to display the privacy options in the area to the right. 

2. Here you can click the “On” and “Off” toggle switch shown in order to enable or disable privacy settings 

in Windows 8. 

3. The privacy settings that you can enable or disable are “Let apps use my location,” “Let apps use my 

name and account picture,” and “Help improve Windows Store by sending URLs for the web content 

that apps use.” 

4. You can also click the “Privacy statement” command to read Microsoft’s Windows 8 privacy statement in 

your default web browser, if desired. 

DEVICE SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Devices” category at the left side 

of the screen to display a listing of connected peripheral devices in the area to the right. 

2. You can click the “Add a device” button to manually search for devices, such as USB-connected 

devices, if needed. 

3. You should see all connected devices displayed within this list. You can click on a device shown in the 

listing to select it. 

4. You can then click the small minus sign at the right end of it to remove the connected device, if needed. 

5. You will need to click the “Yes” button in the confirmation box that appears to safely remove the device 

from your computer. 

WIRELESS SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Wireless” category at the left side 

of the screen to display the wireless options in the area to the right. 

2. Here you can click the “On” and “Off” toggle switch shown in order to enable or disable the wireless 

options shown in Windows 8. 

3. The wireless options that you can enable or disable are “Airplane mode” and “Wireless Devices.” You 

can enable “Airplane mode” to disable wireless communication when flying, and you can turn your 

wireless connection on and off using the “Wireless devices” setting. 

EASE OF ACCESS SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Ease of Access” category at the 

left side of the screen to display accessibility settings in the area to the right. 

2. You can click the “On” and “Off” toggle switches shown in order to enable or disable the accessibility 

settings shown. The settings that you can enable or disable are “High contrast” and “Make everything on 

your screen bigger.” 

3. You can then select what you want “Pressing Windows + Volume Up will turn on” to do by selecting a 

choice from the drop-down menu. By default, this enables the Narrator feature. 

4. You can also select how long you want to “Show notifications for” from the adjacent drop-down. 

5. You can also set the default “Cursor thickness” from the drop-down that is shown. Sa
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ACTIONS- 

Windows 8 Settings 
SYNC SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Sync your settings” category at 

the left side of the screen to display Windows 8 synchronization settings in the area to the right. 

2. Within this category, the options are grouped into three main subcategories listed at the right side: “Sync 

your settings,” “Settings to sync,” and “Sync over metered connections.” Note that in order to change 

any settings shown within this category, you must first sign-in to your Windows computer using a 

Microsoft user account, versus a local user account, and you must also have internet connectivity. 

3. Within this category, you can click the “On” and “Off” toggle switches shown in order to enable or 

disable the settings shown. To enable Microsoft user account syncing, enable the “Sync settings on this 

PC” option. 

4. You can then choose what options to synch by enabling or disabling the following settings: 

“Personalize,” “Desktop personalization,” “Passwords,” “Ease of Access,” “Language preferences,” “App 

settings,” “Browser,” and “Other Windows settings.” 

5. Under the “Sync over metered connections” section you can enable or disable the “Sync settings over 

metered connections” and “Sync settings over metered connections even when I’m roaming” options. 

You can enable the “Metered Internet connections” setting to sync data usage settings amongst devices 

to help prevent extra charges. 

HOMEGROUP SETTINGS IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “HomeGroup” category at the left 

side of the screen to display Windows 8 HomeGroup settings in the area to the right. 

2. You can click the “Create” button shown here to enable these settings and create a HomeGroup if they 

are not displayed. 

3. Once the settings are displayed, the options are grouped into three main subcategories listed at the 

right side: “Libraries and devices,” “Media devices,” and “Membership.” The options shown here allow 

you to change your home networking configuration and file sharing options. 

4. You can click the “On” and “Off” toggle switches shown within the “Libraries and devices” section in 

order to enable or disable sharing of the files, folders, and devices listed. These settings are: 

“Documents,” “Music,” “Pictures,” “Videos,” and “Printers and devices.” 

5.  You can enable sharing of content with TVs and gaming consoles by enabling the “Media devices” 

“On/Off” switch. 

6. In the “Membership” section, you can view the “HomeGroup” password, which is required by any 

devices that wish to join your home network. 

7. If you want to remove your computer from the HomeGroup network, click the “Leave” button to leave. 

WINDOWS UPDATE IN WINDOWS 8: 

 

1. Within the “PC settings” app window in Windows 8, you can click the “Windows Update” category at the 

left side of the screen to display Windows Update information in the area to the right. 

2. If you have configured Windows Update to automatically check for updates, that information will be 

displayed here. 

3. You can also view when the last check for updates occurred. 

4. You can click the “Check for updates” button to manually check for updates, if desired. Sa
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ACTIONS- 

Windows 8 Settings 
FILE HISTORY IN WINDOWS 8: 

 

1. File History in Windows 8 allows you to backup files on your computer that you have saved into your 

libraries, contacts, favorites, and Desktop folders. You can open File History by opening the Control 

Panel on your computer. 

2. You can then click the “Save backup copies of your files with File History” hyperlink under the “System 

and Security” section within the Control Panel. 

3. To enable File History, click the “Turn on” button at the right side of the screen. 

4. You should see the external hard drive or network location to where the files will be saved shown at the 

top of the screen. 

5. You can change the location to where the files will be saved by clicking the “Select drive” command at 

the left side of the screen. 

6. Here you can select an external dive from the listing shown at the top of the window, or you can click the 

“Add network location” button to open a “Select Folder” window where you can choose a network 

location. 

7. Once you have selected a network location, click the “Select Folder” button to set it. 

8. You can then click the “OK” button within the “Select Drive” window to save the selected location. 

9. If you need to restore a saved file, note that you can click the “Restore personal files” command at the 

left side of the “File History” window to do so. 

10. You can then follow the onscreen prompts that appear in the new window that opens in order to select a 

File History backup to use for the file restoration. 
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EXERCISES- 

Windows 8 Settings 
Purpose: 

 

1. To be able to find various types of settings within the Windows 8 environment. 

Exercises for Windows 8 Only: 

 

1. Ensure that you are viewing the “Start” screen within Windows 8. 

2. Roll your mouse pointer to the lower-right corner of the “Start” screen until the “Charm Bar” appears. 

3. Roll your mouse pointer up to the “Settings” charm and click it to reveal the “Settings” panel at the 

right side of the “Start” screen. 

4. Click the “Change PC Settings” command at the bottom of the “Start” panel to view the settings for 

your computer. 

5. With the “Personalize” category selected at the left side of the “PC Settings” window, select a picture 

to show within the “Lock Screen” to the right by clicking on the desired picture to use. 

6. Click the “Users” category shown at the left side of the “PC Settings” window to display the users 

that you have created on this computer in the area to the right. 

7. Click the “General” category shown at the left side of the “PC Settings” window to display the 

general settings for this computer in the area to the right. 

8. Click and drag from the top to the bottom of the “PC Settings” window to drag it off the bottom of the 

screen and close it 
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CHAPTER 4- 

Control Panel Settings 

4.1- The Control Panel 

 

4.2- Personalizing the Desktop 

 

4.3- Changing Screen Resolution 

 

4.4- Backup and Restore in Windows 7 

 

4.5- Backup and Restore in Windows Vista 

 

4.6- System Restore 

 

4.7- Creating Users in Windows 7 and Vista 

 

4.8- Audio Adjustment 

 

4.9- Adding Devices and Printers 

 

4.10- Installing and Uninstalling New Software 
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Control Panel Settings 

4.1- The Control Panel: 

 

 Warning: Making changes to some of the items in the control panel can seriously alter your 

computer and how it functions. It may even cause the computer to not function properly. Do not 

make changes to any of the settings if you do not fully understand the implications of changing the 

settings. 

 The Control Panel is used to change settings in the Windows operating system and the computer. In 

this screen you can change settings for the computer’s audio, display colors and resolution, security 

settings, and many other aspects of your computer. 

 To access the Control Panel in Windows 8, right-click in the blank area within the Start screen to 

display the “All apps” button in the bar at the bottom of the window. Then click the “All apps” button to 

display all of the apps in your computer. Under the “Windows System” category, click the Control Panel icon 

to open the Control Panel within the Desktop app. 

 To access the Control Panel in Windows 7 and Vista, click on the Start button on the Windows 

taskbar and select “Control Panel” from the pop-up menu. 

 When you first open the Control Panel, you will see some of the most commonly used Control Panel 

items, organized by category. To show more information about an item in the “Control Panel” while in 

category view, hold your mouse pointer over the icon or category name and read the text that appears. 

 To open one of these items, click its icon or category name. Some of these items will open a list of 

tasks that you can perform, as well as a selection of individual Control Panel items. For example, if you click 

“Appearance and Personalization” within the Control Panel, you will see a list of related tasks such as 

“Personalization,” along with other related Control Panel items. 

 If you open the Control Panel in Windows Vista and do not see the Control Panel item that you want 

to access, you can click the “Classic View” button at the left side of the Control Panel window. In Windows 8 

and Windows 7, you can click the drop-down next to the words “View by:” in the upper-right corner of the 

Control Panel window and then select to see all of the Control Panel items displayed as either “Large icons” 

or “Small icons” by selecting your desired choice from the drop-down menu that appears. 

 At this point in all versions of Windows, you can then see all of the individual Control Panel items 

that you can change. To open an item shown, double-click its Control Panel icon. To find out more about an 

item within the Control Panel window while viewing all of the available icons, hold your mouse pointer over 

the icon and read the text that appears. 
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Control Panel Settings 

4.2- Personalizing the Desktop: 

 

 It is easy to personalize your Desktop by changing its display. Display properties include the 

background image shown on the Desktop, the screen saver used, the sound scheme and more. To 

personalize the Desktop, right-click anywhere within the empty space on the Desktop and then click the 

“Personalize” command in the pop-up menu that appears. Alternately, you can click the “Appearance and 

Personalization” link within the Control Panel window and then click the “Personalization” link to display the 

same “Personalization” screen where you can change these Desktop settings. 

 Within the “Personalization” screen in the Control Panel, you can click the “Desktop Background” 

icon to display the “Desktop Background” screen. In this screen, you can select a background image or 

color for your Windows Desktop. You can select a choice from the “Picture location” drop-down, which is 

called the “Location” drop-down in Windows Vista, to select from the pictures shown. You can also click the 

“Browse…” button to open a window that allows you to navigate to the folder that contains the image that 

you want to use as the background. Once you have selected the folder, the images will display in the listing 

within this screen. You can then select the desired image to use for the background. At the bottom of the 

window, you can select the desired option to choose how to position the picture or video in the Desktop 

background. When you are done, you can click the “Save Changes” button in Windows 8 and 7 or the “OK” 

button in Windows Vista to apply the background. You can then click the “Back” button at the top of the 

screen to return to the “Personalization” screen. 

 In the “Personalization” screen, you can click the “Color” icon, which is called “Window Color and 

Appearance” in Windows Vista, to select a color to use in the Desktop. This color will be used within the 

Windows Explorer window and on the Windows Taskbar. If your PC is capable of enabling transparency, 

then you can check the “Enable transparency” hyperlink to enable transparent window display within 

Windows. You can also use the “Color intensity:” slider to set the intensity of color selected. When you are 

finished, you can click the “Save Changes” button in Windows 8 and 7 or the “OK” button in Windows Vista 

to apply the changes to the color scheme. You can then click the “Back” button at the top of the screen to 

return to the “Personalization” screen. 

 You can click the “Sounds” icon within the “Personalization” screen to open the “Sounds” tab within 

the “Sounds” dialog box. You can use the “Sound scheme:” drop-down within this dialog box to set a new 

default sound scheme to use for the events that occur within Windows. Simply click the “OK” button when 

you are done here to return to the “Personalization” screen. 

 You can click the “Screen Saver” hyperlink within the “Personalization” screen to open the “Screen 

Saver Settings” dialog box. A screen saver is an animation displayed onscreen after a set time period of 

inaction has passed on your computer so that the Desktop image displayed will not be burned into the 

monitor permanently due to constant, unchanging display onscreen. Within this dialog box, use the “Screen 

saver” drop-down to pick the screen saver you want and then click the “Preview” button to see how it will 

appear. When previewing the screen saver, you can press the “Esc” key on your keyboard or move your 

mouse pointer to stop the preview. The screen saver that is currently selected can be adjusted by clicking 

the “Settings…” button. Depending on the screen saver selected, the options of what settings you can 

change, if any, will vary. Make any selections you would like within the settings dialog box and then click 

“OK” to return to the “Screen Saver Settings” dialog box. In the “Wait:” box, you can enter the number of 

minutes that the computer should be inactive before the screen saver starts. If the check box “On resume, 

display logon screen” is selected, the user’s login password will be required to return to the Desktop after 

the screen saver has been activated. Once you have finished setting the screen saver, click the “OK” button 

within the “Screen Saver Settings” dialog box. 

 When you are finished using the “Personalize” screen within the Control Panel, you can then close 

the Control Panel window by clicking the “X” in the upper right corner of the window. Sa
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Control Panel Settings 

4.3- Changing Screen Resolution: 

 

 You can change the screen resolution used on your monitor in order to change the available number 

of pixels displayed onscreen. Note that the settings available will depend on the monitor used as well as the 

display driver installed. Changing the screen resolution changes the quality of the images displayed by 

increasing resolution as well as allowing for more display area onscreen. Many applications and features 

have a minimum or optimal screen resolution setting to use. For example, if you choose to use the “App 

snapping” feature in Windows 8, you must have a minimum screen resolution of 1366 x 768. These 

numbers represent the number of pixels used to display the width and height of the onscreen display. In this 

lesson, you will learn how to access and change your screen resolution settings. 

 You can access your screen resolution settings by right-clicking in the empty area within your 

Desktop and then clicking the “Screen resolution” command in the pop-up menu that appears. Alternately, 

you can click the “Adjust screen resolution” hyperlink under the “Appearance and Personalization” category 

within the Control Panel window. 

 In the “Screen Resolution” screen that then appears, you can select a display to adjust, if needed, 

from the display icons shown at the top of the screen. If you have multiple monitors connected to your 

computer, you can adjust the display of each as needed. Note that you can also choose a display to adjust 

by making a selection from the “Display” drop-down menu. 

 Next, for the selected display, use the “Resolution” drop-down to select a screen resolution from the 

slider that then appears within the drop-down menu. You can then select a display orientation from the 

“Orientation” drop-down menu that appears. When you have finished changing your screen resolution, click 

the “OK” button to accept the changes. Windows will preview the changes and then allow you to either keep 

the changes or revert back to your previous display settings in a message box that appears onscreen. If you 

decide that you would like to keep the display settings, then click the “Keep changes” button. If you wish to 

revert back to the previously used display settings, then click the “Revert” button or simply wait until the 

timer expires at which point the settings will revert automatically. This is to safeguard against accidentally 

setting your display at a resolution that you cannot view or use. 
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4.4- Backup and Restore in Windows 7: 

 

 In order to ensure the preservation of your computer’s data, you should backup your data by copying 

your files to removable media, such as an external hard drive, DVD, or USB flash drive at least once a 

week. To perform a backup in Windows 7, open the Control Panel window and click the “Back up your 

computer” hyperlink. To start a backup for the first time, click the “Set up backup” hyperlink to start the 

“Windows Backup” program. 

 In the “Select where you want to save your backup” window, choose the removable media to which 

you wish to backup your data. You can save to a network location by selecting the “Save on a network…” 

button, and then entering the network pathway where you would like to save the backed up files. If you 

choose to do this, then click the “OK” button when finished. If you simply selected a removable media in the 

initial window, click the “Next” button to continue. 

 In the next window, check the types of files that you want to back up. You can select to “Let 

Windows choose (recommended)” or “Let me choose.” If you select the latter option, you will then need to 

specify which files to backup and also whether you wish to save a system image that can be used to restore 

your system. It is recommended that you select the “Let Windows choose” option, which also creates a 

regular backup schedule for the files. When you have made your selection, click the “Next” button to 

continue. 

 The next screen then allows you to view your backup setting, and also set when you want to create a 

backup file for your system. If you wish to set a different schedule, you can click the “Change schedule” 

hyperlink to set when the backup should be performed. 

 When you are ready, click the “Save settings and run backup” button to save your backup settings 

and begin the backup procedure. Note, that this whole process may take several minutes to hours 

depending on how much information you have selected to backup. 

 To restore files that you have saved to a backup file in Windows 7, first open the “Backup or restore 

your files” window again. Then either click the “Restore my files” choice or the “Restore all users’ files” 

choice. If you’re prompted for an administrator password or confirmation, type the password or provide 

confirmation. 

 Next, you select how to look for the files you wish to restore by clicking either “Browse for files” or 

“Browse for folders.” When you’re browsing for folders, you won’t be able to see the individual files in a 

folder. To view individual files, use the “Browse for files option,” instead. You can then select the files or 

folders to restore and then click the “Add files…” button to add the saved copy of the folder or file from the 

backup that you created to the list of items to be restored. Then click the “Next” button to continue. The next 

screen asks where you want to restore your files. You can select either “In the original location” or “In the 

following location.” If you choose the latter option, then you can click the “Browse…” button to select a new 

location. Then click the “OK” button after choosing the new location. When you have made your choice, 

click the “Restore” button to restore the item or items that you selected back to the chosen location. 
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4.5- Backup and Restore in Windows Vista: 

 

  In order to ensure the preservation of your computer’s data, you should backup your data by 

copying your files to removable media, such as an external hard drive, DVD, or USB flash drive at least 

once a week. To perform a backup in Windows Vista, select “Start| All Programs| Accessories| System 

Tools| Backup Status and Configuration” from the “Start” button in the Windows taskbar. This will launch the 

“Backup Status and Configuration” window. 

 Choose “Back Up Files” button from the left side of the window. Then you can click the “Set up 

automatic file backup” hyperlink at the right. That will open another window where you choose the media to 

which you wish to backup your data. You can save the backed up files to removable media or to a network 

location by selecting the desired option and then using the drop-down or the “Browse…” button to choose a 

removable media or network location to save the backed up files to. Once you have made a selection, click 

the “Next” button to continue. 

 In the next window, check the types of files that you want to back up. Then click the “Next” button. 

The next screen then allows you to set how often you want to create a backup file for your system. When 

you are ready, click the “Save settings and start backup” button to save your backup settings and begin the 

backup procedure. Note, however, that this whole process may take several minutes to hours depending on 

how much information you have selected to backup. 

 To restore your files from the backup file you created, select “Start| All Programs| Accessories| 

System Tools| Backup Status and Configuration” from the “Start” button in the Windows taskbar. This will 

launch the “Backup Status and Configuration” window. 

 To restore files that you have saved to a backup file, click “Restore Files” from the left side of this 

window. Then click the “Restore Files” hyperlink. On the next screen, select the backup file you want to 

restore and click “Next.” Then click “Finish” to start the restore process. 
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Control Panel Settings 

4.6- System Restore:  

 

 “System Restore” is a component of Windows that you can use to restore your computer to a 

previous state if a serious problem occurs. During a system restore, you will not lose personal data files. 

System Restore monitors changes to the system and automatically creates easily identifiable restore points 

during procedures such as software installation. These restore points allow you to revert the system to a 

previous time, as if you had never performed the procedure. Restore points are often created at the time of 

significant system events, such as when an application or driver is installed. You can also create and name 

your own restore points at any time. 

 To make sure System Restore is enabled, open the Control Panel. In the Control Panel, click the 

“System and Security” hyperlink, which is called “System and Maintenance” in Windows Vista. In this 

screen, click the “System” link at the right side of the screen. In the window that appears, click the “System 

protection” hyperlink at the left side of the window. That will open the “System Properties” dialog box and 

display the “System Protection” tab. You should ensure that your computer’s “C:” drive is shown at the 

bottom of this tab. In Windows 8 and 7, this setting for the “C:” drive should be “On” under the “Protection” 

column. In Windows Vista, it should be checked. If this is true, then Windows will create automatic restore 

points for the drive. 

 You can also manually create a restore point in this window by clicking the “Create…” button at the 

bottom of the tab to open the “Create a Restore Point” window. Here you enter a name for the restore point. 

The date and time will be automatically added. Then click the “Create” button to create a restore point. 

When Windows, is finished it will inform you in a small message box. Click “OK” to close the message. 

  If you need to restore your computer to an earlier time by performing a system restore, click the 

“System Restore…” button. That will open the “System Restore” window. Click “Next” to continue. 

 In the next screen, you select the restore point to which you want to restore your system back. Then 

click “Next” to continue. At that point, just click “Finish” to finish and restore your system. It is important that 

you do not shut down the computer or interfere with it in any way until it has completely finished performing 

the system restore. Windows will notify you when the system has been restored to the point selected. 
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Control Panel Settings 

4.7- Creating Users in Windows 7 and Vista: 

 

 One of the nice features about Windows 7 and Windows Vista is that you can create multiple user 

accounts so each person that uses the computer can log on and have their own individual settings. When 

you install Windows, you are asked if you want to create separate user accounts for other people who will 

be using the computer. You can create a user account for each person who will regularly use your 

computer. The first user account that you must create is an “Administrator” account and is usually is the 

owner of the computer. The other types of accounts are a “Standard User” account and a “Guest” account. 

The following table shows the permissions available for the three types of user accounts.  

You can: Administrator User Guest 

Create Accounts Yes No No 

Change System Files Yes No No 

Change System Settings Yes No No 

Read other user account files Yes No No 

Add or Remove hardware Yes No No 

Change other user account  

Passwords 

Yes No No 

Change your own account  

Passwords 

Yes Yes No 

Install any programs Yes No No 

Install most programs Yes Yes No 

Save Documents Yes Yes Yes 

Use installed programs Yes Yes Yes 

 
 To create or modify user accounts, open the Control Panel, in the “User Accounts and Family 

Safety” section, you can click the “Add or remove user accounts” hyperlink to create the new user account. 

The next window will display any user accounts that you have created, including the default account that is 

created when you set up Windows Vista. 

 To create a new user account, click the “Create a new account” hyperlink at the bottom of the 

window. Next, enter the name for the new account you are creating and select either the “Standard user” or 

“Administrator” option button, depending on what type of account you want. Next, click the “Create Account” 

button at the bottom of the window. This will return you to the “Manage Accounts” screen and you will see 

your new account on the screen. 

 Once the user account has been created, you can then modify it. To do that, first click on the name 

of the user account in the “Manage Accounts” window that you want to edit. 

 In the “Change an Account” window that appears for the selected account, you can perform activities 

such as changing the user account’s name, picture, password, and account type. If you are an 

“Administrator” account, you can also remove the accounts that have been created. To perform any of these 

activities, just click the associated hyperlink at the left side of the window to make the modifications to the 

selected account. When you are finished, click the “X” in the upper right corner of the window to close it. 
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4.8- Audio Adjustment:  

  

  There are many ways to adjust the volume of the computer. To adjust the settings for the volume for 

your computer, change the sound schemes, and adjust the properties for speakers and audio devices 

through Windows, open the Control Panel. Next, click the “Hardware and Sound” hyperlink. Then click the 

“Sound” hyperlink to open the “Sound” dialog box. The first tab, “Playback,” lets you select the desired 

output device for audio playback. To set the playback properties of the selected device, click the 

“Properties” button. In the next dialog box that appears, you can click the “Levels” tab and then set the 

volume levels using the sliders available. You can just click the “OK” button when you are done. 

 Back in the “Sound” dialog box, you can click the “Sounds” tab to select a sound scheme for 

Windows. A sound scheme is a set of sounds applied to Windows events. You can select “No Sounds” or 

“Windows Default” from the “Sound Scheme:” drop-down. You can change individual sounds in the scheme 

drop-down by clicking on the item you want to change in the “Program” box and changing the sound file 

used in the “Sounds” drop-down. When you are finished, click “OK” to apply the properties. 

 For most users, it is simply easiest to change the sound levels by clicking the “Volume Mixer” icon in 

the lower right corner of the Windows Desktop, and then simply clicking and dragging the slider up and 

down to set the audio playback levels of your default audio device. You can also click the small “Mute” 

button at the bottom of the slider to turn muting of the sound both on and off. 

4.9- Adding Devices and Printers: 

 

 Most printers and other types of external, peripheral devices such as external hard drives or USB 

drives will be recognized and installed automatically by Windows when you plug them into a computer. This 

is the “Plug and Play” feature of Windows that allows the operating system to recognize new hardware and 

immediately install the drivers for the new hardware if connected to the Internet. In Windows Vista, the 

operating system may open a wizard to assist you with the new hardware installation. However, if you need 

to manually install a printer or other peripheral device, that is also easy to do in Windows. 

 First, start by opening the Control Panel, then under the “Hardware and Sound” category, click the 

“Add devices and printers” hyperlink if using Windows 8. This link is called the “Add a device” hyperlink in 

Windows 7 and called the “Printer” hyperlink in Windows Vista. If using Windows Vista, you will next click 

the “Add a printer” button in the “Printers” window that appears to open the “Add Printer” wizard that will step 

you through the installation process. 

 In Windows 8 and 7, just ensure that the printer or other device is turned on and connected to the 

computer. The printer or other external device will then appear within the window, where you can select it 

and then click the “Next” button to step through the hardware installation process. If installing a printer, note 

that printer manufacturers will also include detailed instructions on how to install the printer as well. Make 

sure to read all the printer-specific instructions before you start the installation. 
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4.10- Installing and Uninstalling Software:  

  

 When you insert a disk into your computer to install new software, there is typically an executable file 

on the disk that will start the installation process for you. Starting in Windows 8, you can also download and 

install apps from the Windows Store if you are logged in using a Microsoft account. 

 If you need to manually uninstall Desktop software that is not an app that you downloaded from the 

Microsoft Store, you will need to open the Control Panel and click the “Uninstall a program” hyperlink under 

the “Programs” category. In the “Programs and Features” window, you can click on the name of the Desktop 

application that you want to uninstall or change. Then look in the toolbar at the top of the window for a list of 

the commands that you can select. You can always click the “Uninstall” hyperlink to begin uninstalling the 

software. Also, many programs may give you the option of changing the installation, or repairing the 

installation. You can click whichever button you would like to begin that process. 

 Note that the process for uninstalling an app from the Start screen in Windows 8 differs from this 

process. To uninstall an app within the Start screen, simply right-click on the app icon that you wish to 

uninstall. Then click the “Uninstall” button in the small bar that appears at the bottom of the window to 

remove the app from your computer. 
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ACTIONS- 

Control Panel Settings 
THE CONTROL PANEL: 

 

1. Warning: Making changes to some of the items in the control panel can seriously alter your computer 

and how it functions. It may even cause the computer to not function properly. Do not make changes to 

any of the settings if you do not fully understand the implications of changing the settings. 

2. To access the Control Panel in Windows 8, right-click in the blank area within the Start screen to display 

the “All apps” button in the bar at the bottom of the window. 

3. Then click the “All apps” button to display all of the apps in your computer. 

4. Under the “Windows System” category, click the Control Panel icon to open the Control Panel within the 

Desktop app. 

5. To access the Control Panel in Windows 7 and Vista, click on the Start button on the Windows taskbar 

and select “Control Panel” from the pop-up menu. 

6. When you first open the Control Panel, you will see some of the most commonly used Control Panel 

items, organized by category. To show more information about an item in the “Control Panel” while in 

category view, hold your mouse pointer over the icon or category name and read the text that appears. 

7. To open one of these items, click its icon or category name. 

8. If you open the Control Panel in Windows Vista and do not see the Control Panel item that you want to 

access, you can click the “Classic View” button at the left side of the Control Panel window. 

9. In Windows 8 and Windows 7, you can click the drop-down next to the words “View by:” in the upper-

right corner of the Control Panel window and then select to see all of the Control Panel items displayed 

as either “Large icons” or “Small icons” by selecting your desired choice from the drop-down menu. 

10. At this point in all versions of Windows, you can then see all of the individual Control Panel items that 

you can change. 

11. To open an item shown, double-click its Control Panel icon. 

12. To find out more about an item within the Control Panel window while viewing all of the available icons, 

hold your mouse pointer over the icon and read the text that appears. 

PERSONALIZING THE DESKTOP: 

 

1. To personalize the Desktop, right-click anywhere within the empty space on the Desktop and then click 

the “Personalize” command in the pop-up menu that appears. 

2. Alternately, you can click the “Appearance and Personalization” link within the Control Panel window 

and then click the “Personalization” link to display the same “Personalization” screen where you can 

change these Desktop settings. 

3. Within the “Personalization” screen in the Control Panel, you can click the “Desktop Background” icon to 

display the “Desktop Background” screen. 

4. You can select a choice from the “Picture location” drop-down, which is called the “Location” drop-down 

in Windows Vista, to select from the pictures shown. 

5. You can also click the “Browse…” button to open a window that allows you to navigate to the folder that 

contains the image that you want to use as the background. Once you have selected the folder, the 

images will display in the listing within this screen. You can then select the desired image to use for the 

background. 

6. At the bottom of the window, you can select the desired option to choose how to position the picture or 

video in the Desktop background. 

7. When you are done, you can click the “Save Changes” button in Windows 8 and 7 or the “OK” button in 

Windows Vista to apply the background. 
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ACTIONS- 

Control Panel Settings 
PERSONALIZING THE DESKTOP (CONT'D.): 

 

8. You can then click the “Back” button at the top of the screen to return to the “Personalization” screen. 

9. In the “Personalization” screen, you can click the “Color” icon, which is called “Window Color and 

Appearance” in Windows Vista, to select a color to use in the Desktop. 

10. If your PC is capable of enabling transparency, then you can check the “Enable transparency” hyperlink 

to enable transparent window display within Windows. 

11. You can also use the “Color intensity:” slider to set the intensity of color selected. 

12. When you are finished, you can click the “Save Changes” button in Windows 8 and 7 or the “OK” button 

in Windows Vista to apply the changes to the color scheme. 

13. You can then click the “Back” button at the top of the screen to return to the “Personalization” screen. 

14. You can click the “Sounds” icon within the “Personalization” screen to open the “Sounds” tab within the 

“Sounds” dialog box. 

15. You can use the “Sound scheme:” drop-down within this dialog box to set a new default sound scheme 

to use for the events that occur within Windows. 

16. Simply click the “OK” button when you are done here to return to the “Personalization” screen. 

17. You can click the “Screen Saver” hyperlink within the “Personalization” screen to open the “Screen 

Saver Settings” dialog box. 

18. Within this dialog box, use the “Screen saver” drop-down to pick the screen saver you want and then 

click the “Preview” button to see how it will appear. 

19. When previewing the screen saver, you can press the “Esc” key on your keyboard or move your mouse 

pointer to stop the preview. 

20. The screen saver that is currently selected can be adjusted by clicking the “Settings…” button. 

Depending on the screen saver selected, the options of what settings you can change, if any, will vary. 

Make any selections you would like within the settings dialog box and then click “OK” to return to the 

“Screen Saver Settings” dialog box. 

21. In the “Wait:” box, you can enter the number of minutes that the computer should be inactive before the 

screen saver starts. 

22. If the check box “On resume, display logon screen” is selected, the user’s login password will be 

required to return to the Desktop after the screen saver has been activated. 

23. Once you have finished setting the screen saver, click the “OK” button within the “Screen Saver 

Settings” dialog box. 

24. When you are finished using the “Personalize” screen within the Control Panel, you can then close the 

Control Panel window by clicking the “X” in the upper right corner of the window. 

SETTING SCREEN RESOLUTION: 

 

1. You can access your screen resolution settings by right-clicking in the empty area within your Desktop 

and then clicking the “Screen resolution” command in the pop-up menu that appears. 

2. Alternately, you can click the “Adjust screen resolution” hyperlink under the “Appearance and 

Personalization” category within the Control Panel window. 

3. In the “Screen Resolution” screen that then appears, you can select a display to adjust, if needed, from 

the display icons shown at the top of the screen. If you have multiple monitors connected to your 

computer, you can adjust the display of each as needed. 

4. Note that you can also choose a display to adjust by making a selection from the “Display” drop-down 

menu. 
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ACTIONS- 

Control Panel Settings 
SETTING SCREEN RESOLUTION (CONT'D.): 

 

5. Next, for the selected display, use the “Resolution” drop-down to select a screen resolution from the 

slider that then appears within the drop-down menu. 

6. You can then select a display orientation from the “Orientation” drop-down menu that appears. 

7. When you have finished changing your screen resolution, click the “OK” button to accept the changes. 

8. Windows will preview the changes and then allow you to either keep the changes or revert back to your 

previous display settings in a message box that appears onscreen. 

9. If you decide that you would like to keep the display settings, then click the “Keep changes” button. 

10. If you wish to revert back to the previously used display settings, then click the “Revert” button or simply 

wait until the timer expires at which point the settings will revert automatically. This is to safeguard 

against accidentally setting your display at a resolution that you cannot view or use. 

BACKUP AND RESTORE IN WINDOWS 7: 

 

1. To perform a backup in Windows 7, open the Control Panel window and click the “Back up your 

computer” hyperlink. To start a backup for the first time, click the “Set up backup” hyperlink to start the 

“Windows Backup” program. 

2. In the “Select where you want to save your backup” window, choose the removable media to which you 

wish to backup your data. You can save to a network location by selecting the “Save on a network…” 

button, and then entering the network pathway where you would like to save the backed up files. If you 

choose to do this, then click the “OK” button when finished. If you simply selected a removable media in 

the initial window, click the “Next” button to continue. 

3. In the next window, you can select to “Let Windows choose (recommended)” or “Let me choose.” It is 

recommended that you select the “Let Windows choose” option, which also create a regular backup 

schedule for the files. When you have made your selection, click the “Next” button to continue. 

4. The next screen then allows you to view your backup setting, and also set when you want to create a 

backup file for your system. If you wish to set a different schedule, you can click the “Change schedule” 

hyperlink to set when the backup should be performed. 

5. When you are ready, click the “Save settings and run backup” button to save your backup settings and 

begin the backup procedure. 

6. To restore your files from the backup file you created, select “Start| All Programs| Accessories| System 

Tools| Backup Status and Configuration” from the “Start” button in the Windows taskbar. This will launch 

the “Backup Status and Configuration” window. 

7. To restore files that you have saved to a backup file, first open the “Backup or restore your files” window 

again. Then either click the “Restore my files” choice or the “Restore all users’ files” choice. If you’re 

prompted for an administrator password or confirmation, type the password or provide confirmation. 

8. Next, you select how to look for the files you wish to restore by clicking either “Browse for files” or 

“Browse for folders.” When you’re browsing for folders, you won’t be able to see the individual files in a 

folder. To view individual files, use the “Browse for files option,” instead. 

9. Select the files or folders to restore and click the “Add files…” button to add the saved copy of the folder 

or file to the list of items to be restored. Then click the “Next” button to continue. 

10. The next screen asks where you want to restore your files. You can select either “In the original 

location” or “In the following location.” If you choose the latter option, then you can click the “Browse…” 

button to select a new location. Then click the “OK” button after choosing the new location. 

11. When you have made your choice, click the “Restore” button to restore the items you selected. Sa
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ACTIONS- 

Control Panel Settings 
BACKUP AND RESTORE IN WINDOWS VISTA: 

 

1. To perform a backup, select “Start| All Programs| Accessories| System Tools| Backup Status and 

Configuration” from the “Start” button in the Windows taskbar. This will launch the “Backup Status and 

Configuration” window. 

2. Choose “Back Up Files” button from the left side of the window. Then you can click the “Set up 

automatic file backup” hyperlink at the right. That will open another window where you choose the 

media to which you wish to backup your data. 

3. You can save the backed up files to removable media or to a network location by selecting the desired 

option and then using the drop-down or the “Browse…” button to choose a removable media or network 

location to save the backed up files to. 

4. Once you have made a selection, click the “Next” button to continue. 

5. In the next window, check the types of files that you want to back up. 

6. Then click the “Next” button. 

7. The next screen then allows you to set how often you want to create a backup file for your system. 

8. When you are ready, click the “Save settings and start backup” button to save your backup settings and 

begin the backup procedure. Note, however, that this whole process may take several minutes to hours 

depending on how much information you have selected to backup. 

9. To restore your files from the backup file you created, select “Start| All Programs| Accessories| 

System Tools| Backup Status and Configuration” from the “Start” button in the Windows taskbar. This 

will launch the “Backup Status and Configuration” window. 

10. To restore files that you have saved to a backup, click “Restore Files” from the left side of this window. 

11. Then click the “Restore Files” hyperlink. 

12. On the next screen, select the backup file you want to restore and click “Next.” 

13. Then click “Finish” to start the restore process. 

USING SYSTEM RESTORE: 

 

1. To make sure System Restore is enabled, open the Control Panel and click the “System and Security” 

hyperlink, which is called “System and Maintenance” in Windows Vista. 

2. In this screen, chose click the “System” hyperlink at the right side of the window. 

3. In the window that appears, click the “System protection” hyperlink at the left side of the window. That 

will open the “System Properties” dialog box and display the “System Protection” tab. 

4. You should ensure that your computer’s “C:” drive is shown at the bottom of this tab. In Windows 8 and 

7, this setting for the “C:” drive should be “On” under the “Protection” column. In Windows Vista, it 

should be checked. If this is true, then Windows will create automatic restore points for the drive. 

5. You can also manually create a restore point here by clicking the “Create…” button at the bottom of the 

tab to open the “Create a Restore Point” window. Here you enter a name for the restore point. The date 

and time will be automatically added. Then click the “Create” button to create a restore point. When 

Windows, is finished it will inform you in a small message box. Click “OK” to close the message. 

6. If you need to restore your computer to an earlier time by performing a system restore, click the “System 

Restore…” button. That will open the “System Restore” window. Click “Next” to continue. 

7. In the next screen, you select the restore point to which you want to restore your system back. Then 

click “Next” to continue. At that point, just click “Finish” to finish and restore your system. 

8. It is important that you do not shut down the computer or interfere with it in any way until it has 

completely finished performing the system restore. Windows will notify you when the system has been 

restored to the point selected. Sa
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ACTIONS- 

Control Panel Settings 
CREATING USERS IN WINDOWS 7 AND VISTA: 

 

1. To create or modify user accounts, open the “Control Panel.” 

2. Under the “User Accounts and Family Safety” category, click the “Add or remove user accounts” 

hyperlink to create the new user account. 

3. The next window will display any user accounts that you have created, including the default account that 

is created when you set up Windows. 

4. To create a new user account, click the “Create a new account” hyperlink at the bottom of the window. 

5. Next, enter the name for the new account you are creating and select either the “Standard user” or 

“Administrator” option button, depending on what type of account you want. 

6. Next, click the “Create Account” button at the bottom of the window. This will return you to the “Manage 

Accounts” screen and you will see your new account on the screen. 

7. Once the user account has been created, you can then modify it. To do that, click on the name of the 

user account in the “Manage Accounts” window that you want to edit. 

8. In the “Change an Account” window that appears for the selected account, you can perform activities 

such as changing the user account’s name, picture, password, and account type. If you are an 

“Administrator” account, you can also remove the accounts that have been created. To perform any of 

these activities, just click the associated hyperlink at the left side of the window to make the 

modifications to the selected account. 

9. When you are finished, click the “X” in the upper right corner of the window to close it. 

MAKING AUDIO ADJUSTMENTS: 

 

1. To adjust the settings for the volume for your computer, change the sound schemes, and adjust the 

properties for speakers and audio devices through Windows, open the Control Panel. 

2. Next, click the “Hardware and Sound” hyperlink. 

3. Then click the “Sound” hyperlink to open the “Sound” dialog box. 

4. The first tab, “Playback,” lets you select the desired output device for audio playback. To set the 

playback properties of the selected device, click the “Properties” button. 

5. In the next dialog box that appears, you can click the “Levels” tab and then set the volume levels using 

the sliders available. You can just click the “OK” button when you are done. 

6. Back in the “Sound” dialog box, you can click the “Sounds” tab to select a sound scheme for Windows. 

A sound scheme is a set of sounds applied to Windows events. 

7. You can select “No Sounds” or “Windows Default” from the “Sound Scheme:” drop-down. You can 

change individual sounds in the scheme drop-down by clicking on the item you want to change in the 

“Program” box and changing the sound file used in the “Sounds” drop-down. When you are finished, 

click “OK” to apply the properties. 

8. For most users, it is simply easiest to change the sound levels by clicking the “Volume Mixer” icon in the 

lower right corner of the Windows Desktop, and then simply clicking and dragging the slider up and 

down to set the audio playback levels of your default audio device. 

9. You can also click the small “Mute” button at the bottom of the slider to turn muting both on and off. 
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ACTIONS- 

Control Panel Settings 
ADDING DEVICES AND PRINTERS: 

 

1. Most printers and other types of external, peripheral devices will be recognized and installed 

automatically by Windows when you plug them into a computer if connected to the Internet. 

2. However, if you need to manually install a printer or other peripheral device, start by opening the Control 

Panel. 

3. Under the “Hardware and Sound” category, click the “Add devices and printers” hyperlink if using 

Windows 8. This link is called the “Add a device” hyperlink in Windows 7 and called the “Printer” 

hyperlink in Windows Vista. 

4. If using Windows Vista, you will next click the “Add a printer” button in the “Printers” window that 

appears to open the “Add Printer” wizard that will step you through the installation process. 

5. In Windows 8 and 7, just ensure that the printer or other device is turned on and connected to the 

computer. The printer or external device will then appear within the window, where you can select it and 

then click the “Next” button to step through the installation process. 

6. Printer manufacturers will also include detailed instructions on how to install the printer as well, so make 

sure to read all the printer-specific instructions before you start the installation. 

INSTALLING AND UNINSTALLING SOFTWARE: 

 

1. When you insert a disk into your computer to install new software, there is typically an executable file on 

the disk that will start the installation process for you. 

2. Starting in Windows 8, you can also download and install apps from the Windows Store if you are 

logged in using a Microsoft account. 

3. If you need to manually uninstall Desktop software that is not an app that you downloaded from the 

Microsoft Store, you will need to open the Control Panel and click the “Uninstall a program” hyperlink 

under the “Programs” category. 

4. In the “Programs and Features” window, you can click on the name of the Desktop application that you 

want to uninstall or change. Then look in the toolbar at the top of the window for a list of the commands 

that you can select. 

5. You can always click the “Uninstall” hyperlink to begin uninstalling the software. 

6. Also, many programs may give you the option of changing the installation, or repairing the installation. 

You can click whichever button you would like to begin that process. 

7. Note that the process for uninstalling an app from the Start screen in Windows 8 differs from this 

process. To uninstall an app within the Start screen, simply right-click on the app icon that you wish to 

uninstall. 

8. Then click the “Uninstall” button in the small bar that appears at the bottom of the window to remove the 

app from your computer. 
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EXERCISES- 

Control Panel Settings 
Purpose: 

 

1. To locate the Control Panel and change a basic color setting. 

Exercises: 

 

1. If using Windows 8, click the “Desktop” app within the “Start” screen to open the “Desktop.” 

2. Then click the “Windows Explorer” icon within the Windows Taskbar in the lower-right corner of the 

“Desktop” window to open “Windows Explorer.” 

3. Within the “Windows Explorer” window, click the “Computer” icon shown within the “Navigation Bar” 

at the left side of the “Windows Explorer” window. 

4. Click the “Open Control Panel” button within the “System” button group on the “Computer” tab that 

appears within the Ribbon at the top of the “Windows Explorer” window to open the “Control Panel” 

window. 

5. If using Windows 7 or Vista, click the “Start” button in the lower-left corner of the “Desktop” and 

then click the “Control Panel” command within the pop-up menu that appears to open the “Control 

Panel” window. 

6. Use the “View by:” drop-down in the upper-right corner of the “Control Panel” window to select 

“Category.” This will then display the content within the “Control Panel” by categories. 

7. Click the “Appearance and Personalization” link within the “Control Panel” window. 

8. Click the “Personalization” link within the “Control Panel” window. 

9. If using Windows 8 or 7, click the “Color” icon (called “Windows Color and Appearance” in Windows 

Vista) to open the “Color and Appearance” screen within the “Control Panel” window. 

10. Within the “Change the color of your window borders and taskbar” category, you can click on a color 

that you would like to apply in order to select it. 

11. Then click the “Save changes” or “OK” button that appears at the bottom of the “Control Panel” 

window to save your choice. 

12. Click the red “X” button in the far upper-right corner of the “Control Panel” window to close it. 
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CHAPTER 5- 

Windows Management 

5.1- Searching for a File or Folder in Windows 7 and Vista 

 

5.2- The Recycle Bin 

 

5.3- Creating Desktop Shortcuts 

 

5.4- Pinning Items to the Taskbar or the Quick Launch 

Toolbar 

 

5.5- Windows Help 

 

5.6- Moving and Resizing the Windows Taskbar 

 

5.7- Setting the Date and Time Display 

 

5.8- Windows Updates 

 

5.9- Customizing the Start Menu in Windows 7 and Vista 
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Windows Management 

5.1- Searching for a File or Folder in Windows 7 and Vista: 

 

 “File Search” is a handy feature of Windows 7 and Vista. If you forget the name of a file or folder, 

and cannot remember its location, Windows can search for you. If you can only remember part of the file or 

folder name, you can use that for the search. 

 To find a file click the “Start” button in the lower left corner of the Desktop. Then type the words for 

which you are looking into the search box at the bottom of the “Start” menu. Windows will display matching 

results as you enter the word for which you are looking. You can then click on any listing shown to open it. 

5.2- The Recycle Bin: 

 

 If you make a mistake and delete a file you didn’t want to from your computer’s “C:” drive, you can 

retrieve the file through the Recycle Bin. Windows has a file deletion safeguard, called the Recycle Bin, 

which holds files and folders deleted from your computer’s hard drive until you decide to empty it, at which 

point Windows permanently deletes the items. However, if you haven’t emptied the Recycle Bin yet, than 

you can retrieve the file that you sent there when you deleted it from your hard drive. Think of the Recycle 

Bin as a paper-recycling bin. The paper that you toss into the recycling bin stays there until it is taken away. 

If you needed to find a real piece of paper you had accidentally tossed in, you’d have to rummage through 

the bin to find it. 

 To restore a deleted file, open the Recycle Bin by double-clicking the icon on your Windows 

Desktop. Select the file or files that you want to restore back to their original locations in your hard drive. 

Then click the “Restore selected items” command to move the files back. 

 You will want to empty items from your Recycle Bin periodically to save space on your computer. 

Once you delete items from the Recycle Bin, they are permanently removed from your computer and you 

will not be able to retrieve them! For this reason, only empty your Recycle Bin when you are absolutely sure 

you will never need any of the files in it again. 

 You can empty the Recycle Bin by double-clicking on its icon to open the Recycle Bin window, and 

then clicking the “Empty Recycle Bin” command button. Once again, Windows will ask you with a prompt if 

you are sure you want to permanently delete the items in the Recycle Bin. Click “Yes” to delete the items, or 

“No,” if you are unsure. 
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Windows Management 

5.3- Creating Desktop Shortcuts: 

 

 Instead of always using Windows Explorer to navigate through the computer’s folders to find files in 

your computer, you can create a desktop shortcut that allows you to quickly open or access files, folders or 

programs. A desktop shortcut is simply an icon on your Desktop that opens an associated program, file or 

folder when you double-click the icon. 

 To add a shortcut to the desktop, navigate to the folder, file, or program for which you want to create 

a desktop shortcut using Windows Explorer so that the item is displayed in the right pane within Windows 

Explorer. Then right-click on the item for which you want to create a desktop shortcut. Roll your mouse 

pointer over the “Send to” command in the pop-up menu that appears and then click the “Desktop (create 

shortcut)” from the side menu that appears. Windows will automatically add a shortcut to the selected item 

onto the desktop.  

 The icon for the desktop shortcut appears within your Desktop with a small arrow in the icon’s lower 

left corner. That is how you can tell that the icon is a desktop shortcut to a file, and not the actual file itself. 

It is fine to delete desktop shortcuts by dragging them into the Recycle Bin. That will not delete the file that 

the shortcut refers to, but rather the desktop shortcut itself. 

5.4- Pinning Items to the Taskbar or the Quick Launch Toolbar:  

 

 The Taskbar is the thin toolbar that appears at the bottom of the Desktop within Windows 8, 7 and 

Vista. Note that if using Windows Vista, the area within which you can pin application shortcuts is called the 

“Quick Launch” toolbar and it sits within your Windows taskbar to the right of the “Start” button. If the Quick 

Launch toolbar is not shown in your taskbar in Windows Vista, right-click on the taskbar, roll up to the 

“Toolbars” command, and then select “Quick Launch.” Starting in Windows 7, this area is simply where 

items that have been pinned to your Windows Taskbar will appear. It is no longer considered to be a 

separate toolbar as it was in previous versions of Windows. 

 You can add shortcuts to the taskbar or Quick Launch toolbar in Windows so that you can have 

single-click access to the programs that you use the most. In Windows 8 and 7, this process is referred to as 

pinning programs to the Taskbar. To pin an item, just click and drag the item from the Desktop, or from the 

“Start” menu if using Windows 7 or Vista, onto the Windows Taskbar or Quick Launch toolbar, to place a 

copy of it within the taskbar. Note that in Windows 8, you may also be able to right-click on an app within the 

“Start” screen and then click the “Pin to taskbar” command within the app toolbar that appears at the bottom 

of the screen to pin desktop apps to the Windows taskbar, if available. 

 To remove shortcuts that you have added to the taskbar, right-click on the unwanted icon and select 

the “Unpin this program from taskbar” command, called the “Delete” command in Windows Vista, from the 

pop up menu that appears. 

5.5- Windows Help: 

 

 The Windows “Help” feature is an extremely useful and often highly underused tool within Windows. 

If you forget how to do something, or want to learn how to do something new, Windows Help can usually 

assist you in finding out how to perform an activity within Windows. 

 To access the “Help” feature in Windows 8, you can open the Charm Bar at the right side of the 

Desktop app and then click the “Settings” icon within the Charm Bar. In the “Settings” panel that then 

appears, you can click the “Help” hyperlink to open the “Windows Help and Support” window. You can then 

use this window to browse through the help files or to search for information. Sa
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Windows Management 

5.5- Windows Help (cont'd.): 

 

 To use the Windows help in Windows 7 and Vista, click the “Start” button to display the pop-up menu 

of choices. From there, roll over the “Help and Support” command, and click it to display the Windows help 

dialog box. 

 Within the “Windows Help and Support” window in all of the versions of Windows, you can click into 

the “Search” text box and type the subject about which you want to read the help files. Then click the 

“Search” button at the right end of the “Search” bar to display related help files as hyperlinks displayed 

within the “Help” window. You can then click on the listing of hyperlinks to read the associated help file. You 

can also use the “Back” and “Forward” buttons to navigate through the help files that you read. You can also 

click the “Print” button at the top of the window to print the current help file shown, if desired. 

5.7- Setting the Date and Time Display: 

 

 Your computer has a built-in clock that keeps track of the date and time, even when your computer is 

turned off. You can see the time displayed in the lower right corner of the Windows taskbar. If you rest your 

mouse pointer over that time display for a moment, the date will appear in a small pop-up window. 

 You can click on the time display in the Windows Taskbar to view the date and time settings for your 

computer in a small pop-up window. In this window, you can click the “Change date and time settings…” 

hyperlink to open the “Date and Time” dialog box where you can set the date and time. 

 You can click the “Change time zone…” button to open another dialog box where you can select the 

time zone for your computer. If you need to adjust your time for daylight saving’s changes, check that 

feature at the bottom of the dialog box to enable it. Then click the “OK” button. 

 You can click the “Change date and time…” button to open the “Date and Time Settings” dialog box. 

Here you select the month and year from the calendar control available there. If needed, in the “Time” area, 

enter the current time in the text box. Then click “OK” to apply the settings. 

 Note that if you prefer to synchronize your computer’s time with an internet server, then click the 

“Internet Time” tab within the “Date and Time” dialog box to set your computer’s clock to synchronize with 

an Internet time server. When you are finished, click “OK” to apply the new date and time settings. 

5.6- Moving and Resizing the Windows Taskbar: 

 

 You can move the Windows Taskbar to any side of the Desktop that you want. It is placed at the 

bottom of the screen by default, but you can easily move it or resize it if needed. To do this, right-click 

anywhere within the taskbar and look for the “Lock the taskbar” command within the pop-up menu that 

appears. If there is a check in front of “Lock the taskbar” command, the taskbar is locked in place and 

cannot be moved until the check is removed. Click the “Lock the taskbar” command to remove the check. 

 Once the taskbar is unlocked, you can click and drag the Windows Taskbar from its current location 

and drop it at any one of the sides of the screen. You may resize it by placing your mouse pointer over the 

edge of the Windows Taskbar until you see a double-pointed arrow appear. You can then click and drag to 

make the Windows Taskbar taller or shorter. If you accidentally resize it all the way to the bottom of the 

Desktop, simply hold your mouse pointer over the bottom edge of the Desktop until you see the top half of 

the double-pointed resizing icon appear. Click and drag upward to restore the Windows Taskbar. 

 Once you have made any modifications that you want to keep, right-click on the blank area in the 

Windows Taskbar again, and select the “Lock the taskbar” command to lock the taskbar back into place. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



83 Mastering Windows Made Easy v. 8-Vista ©TeachUcomp, Inc. 

Windows Management 

5.8- Windows Updates: 

 

 With Windows Updates, Windows routinely checks for updates that can help protect your computer 

against the latest security threats for your version of Windows. You can also configure it to look for updates 

to other Microsoft software, as well. When Windows updates are enabled, you can select when Windows 

should check to see if there are new updates, and what it should do when it finds them. For many users, it is 

best to turn on “Automatic Updates," so that you don’t have to search for updates online or worry that critical 

fixes might be missing. Windows automatically downloads and installs them using a schedule that you 

determine. If you prefer to download and install updates yourself, you can set up “Windows Updates” to 

simply notify you whenever any high-priority updates become available. 

 To configure your Windows Updates, open the “Control Panel.” If using Windows 8 or 7, click the 

“System and Security” hyperlink. In the next window that appears, you can then click the “Turn automatic 

updating on or off” hyperlink underneath the “Windows Update” section. If using Windows Vista, click 

“Security” and then click “Windows Update.” To change the configuration of Windows Update, click the 

“Change Settings” hyperlink at the left side of the window. 

 To enable automatic updates, select the “Install updates automatically (recommended)” option. If 

using Windows 7 or Vista, next to the text “Install new updates,” select the day and time you want Windows 

to install updates. If using Windows 8, click the “Updates will be installed automatically during the 

maintenance window” hyperlink, and then set a time for Windows to perform maintenance tasks in the 

windows that then appears. Then click the “OK” button to set the maintenance time. 

 You can also check the “Recommended updates” checkbox and the “Microsoft Update” checkbox to 

enable installation of recommended, but not critical, updates and to broaden the update service to look for 

updates to all Microsoft products on your PC, respectively. Once you have set your desired updating 

options, click the “OK” button to apply them. 
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Windows Management 

5.9- Customizing the Start Menu in Windows 7 and Vista: 

 

 The Start Menu displays a menu that lets you easily access the most useful items on your computer. 

You can click “Help and Support” to learn how to use Windows, obtain troubleshooting information, receive 

support, and more. Clicking “All Programs” opens a list of programs currently installed on your computer.  

 The list of programs on the Start Menu is divided into two parts: the programs that are displayed at 

the left side, and the commands and folders shown at the right side. Programs at the left side of the Start 

menu that are displayed above the separator line are known as the pinned items list. The programs 

displayed below the separator line are known as the most frequently used programs list. The programs on 

the pinned items list remain there and are always available for you to click to start them. You can add 

programs to the pinned items list by dragging their icon into the pinned list. Programs are added to the most 

frequently used programs list based on usage. Windows has a default number of programs that are 

displayed on the most frequently used programs list. When that number of programs is reached, the 

programs you use most frequently replace the programs you have not opened recently.   

 To customize the Start Menu, right-click the “Start” button, and then select “Properties” from the pop-

up menu that appears. This opens the “Taskbar and Start Menu Properties” dialog box. Click the “Start 

Menu” tab, then click the “Customize” button. This opens the “Customize Start Menu” dialog box where you 

can change the settings, as desired, and then click the “OK” button to apply them. Once you have set the 

appearance of the “Start” menu to your liking, click the “OK” button to apply your changes. 
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ACTIONS- 

Windows Management 
SEARCHING FOR A FILE OR FOLDER IN WINDOWS 7 AND VISTA: 

 

1. To find a file click the “Start” button in the lower left corner of the Desktop. 

2. Then type the words for which you are looking into the search box at the bottom of the “Start” menu. 

3. Windows will display matching results as you enter the word for which you are looking. You can then 

click on any listing shown to open it. 

USING THE RECYCLE BIN: 

 

1. To restore a deleted file, open the Recycle Bin by double-clicking the icon on your Windows Desktop. 

2. Select the file or files that you want to restore back to their original locations in your hard drive. 

3. Then click the “Restore selected items” command to move the files back. 

4. You can empty the Recycle Bin by double-clicking on its icon to open the Recycle Bin window, and then 

clicking the “Empty Recycle Bin” command button. 

5. Once again, Windows will ask you with a prompt if you are sure you want to permanently delete the 

items in the Recycle Bin. Click “Yes” to delete the items, or “No,” if you are unsure. 

CREATING DESKTOP SHORTCUTS: 

 

1. To add a shortcut to the desktop, navigate to the folder, file, or program for which you want to create a 

desktop shortcut using Windows Explorer so that the item is displayed in the right pane within Windows 

Explorer. 

2. Then right-click on the item for which you want to create a desktop shortcut. 

3. Roll your mouse pointer over the “Send to” command in the pop-up menu that appears and then click 

the “Desktop (create shortcut)” from the side menu that appears. 

4. Windows will automatically add a shortcut to the selected item onto the desktop.  

5. You can delete desktop shortcuts by dragging them into the Recycle Bin. Doing this will not delete the 

file that the shortcut refers to, but rather the desktop shortcut itself. 

PINNING ITEMS TO THE TASKBAR AND THE QUICK LAUNCH TOOLBAR: 

 

1. The Taskbar is the thin toolbar that appears at the bottom of the Desktop within Windows 8, 7 and Vista. 

Note that if using Windows Vista, the area within which you can pin application shortcuts is called the 

“Quick Launch” toolbar and it sits within your Windows taskbar to the right of the “Start” button. 

2. If the Quick Launch toolbar is not shown in your taskbar in Windows Vista, right-click on the taskbar, roll 

up to the “Toolbars” command, and then select “Quick Launch.” 

3. To pin an item to the Windows Taskbar or Quick Launch toolbar, just click and drag the item from the 

Desktop, or from the “Start” menu if using Windows 7 or Vista, onto the Windows Taskbar or Quick 

Launch toolbar. 

4. In Windows 8, you may also be able to right-click on an app within the “Start” screen and then click the 

“Pin to taskbar” command within the app toolbar that appears at the bottom of the screen to pin desktop 

apps to the Windows taskbar, if available. 

5. To remove shortcuts that you have added to the taskbar, right-click on the unwanted icon and select the 

“Unpin this program from taskbar” command, called the “Delete” command in Windows Vista, from the 

pop up menu that appears. Sa
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ACTIONS- 

Windows Management 
WINDOWS HELP: 

 

1. To access the “Help” feature in Windows 8, you can open the Charm Bar at the right side of the Desktop 

app and then click the “Settings” icon within the Charm Bar. 

2. In the “Settings” panel that then appears, you can click the “Help” hyperlink to open the “Windows Help 

and Support” window. 

3. To use the Windows help in Windows 7 and Vista, click the “Start” button to display the pop-up menu of 

choices. 

4. From there, roll over the “Help and Support” command, and click it to display the Windows help dialog 

box. 

5. Within the “Windows Help and Support” window in all of the versions of Windows, you can click into the 

“Search” text box and type the subject about which you want to read the help files. 

6. Then click the “Search” button at the right end of the “Search” bar to display related help files as 

hyperlinks displayed within the “Help” window. 

7. You can then click on the listing of hyperlinks to read the associated help file. 

8. You can also use the “Back” and “Forward” buttons to navigate through the help files that you read. 

9. You can also click the “Print” button at the top of the window to print the current help file shown, if 

desired. 

MOVING AND RESIZING THE WINDOWS TASKBAR: 

 

1. Right-click anywhere within the taskbar and look for the “Lock the taskbar” command within the pop-up 

menu that appears. 

2. If there is a check in front of “Lock the taskbar” command, the taskbar is locked in place and cannot be 

moved until the check is removed. Click the “Lock the taskbar” command to remove the check. 

3. Once the taskbar is unlocked, you can click and drag the Windows Taskbar from its current location and 

drop it at any one of the sides of the screen. 

4. You may resize it by placing your mouse pointer over the edge of the Windows Taskbar until you see a 

double-pointed arrow appear. You can then click and drag to make the Windows Taskbar taller or 

shorter. 

5. If you accidentally resize it all the way to the bottom of the Desktop, simply hold your mouse pointer 

over the bottom edge of the Desktop until you see the top half of the double-pointed resizing icon 

appear. Click and drag upward to restore the Windows Taskbar. 

6. Once you have made any modifications that you want to keep, right-click on the blank area in the 

Windows Taskbar again, and select the “Lock the taskbar” command to lock the taskbar back into place. 
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ACTIONS- 

Windows Management 
SETTING THE DATE AND TIME DISPLAY: 

 

1. You can click on the time display in the Windows Taskbar to view the date and time settings for your 

computer in a small pop-up window. 

2. In this window, you can click the “Change date and time settings…” hyperlink to open the “Date and 

Time” dialog box where you can set the date and time. 

3. You can click the “Change time zone…” button to open another dialog box where you can select the 

time zone for your computer. If you need to adjust your time for daylight saving’s changes, check that 

feature at the bottom of the dialog box to enable it. Then click the “OK” button. 

4. You can click the “Change date and time…” button to open the “Date and Time Settings” dialog box. 

Here you select the month and year from the calendar control available there. If needed, in the “Time” 

area, enter the current time in the text box. Then click “OK” to apply the settings. 

5. Note that if you prefer to synchronize your computer’s time with an internet server, then click the 

“Internet Time” tab within the “Date and Time” dialog box to set your computer’s clock to synchronize 

with an Internet time server. When you are finished, click “OK” to apply the new date and time settings. 

CONFIGURING WINDOWS UPDATES: 

 

1. To configure your Windows Updates, open the “Control Panel.” 

2. If using Windows 8 or 7, click the “System and Security” hyperlink. In the next window that appears, you 

can then click the “Turn automatic updating on or off” hyperlink underneath the “Windows Update” 

section. 

3. If using Windows Vista, click “Security” and then click “Windows Update.” To change the configuration of 

Windows Update, click the “Change Settings” hyperlink at the left side of the window. 

4. To enable automatic updates, select the “Install updates automatically (recommended)” option. 

5. If using Windows 7 or Vista, next to the text “Install new updates,” select the day and time you want 

Windows to install updates. 

6. If using Windows 8, click the “Updates will be installed automatically during the maintenance window” 

hyperlink, and then set a time for Windows to perform maintenance tasks in the windows that then 

appears. Then click the “OK” button to set the maintenance time. 

7. You can also check the “Recommended updates” checkbox and the “Microsoft Update” checkbox to 

enable installation of recommended, but not critical, updates and to broaden the update service to look 

for updates to all Microsoft products on your PC, respectively. 

8. Once you have set your desired updating options, click the “OK” button to apply them. 

CUSTOMIZING THE START MENU IN WINDOWS 7 AND VISTA: 

 

1. To customize the Start Menu, right-click the “Start” button, and then select “Properties” from the pop-up 

menu that appears. 

2. This opens the “Taskbar and Start Menu Properties” dialog box. 

3. Click the “Start Menu” tab, then click the “Customize” button. 

4. This opens the “Customize Start Menu” dialog box where you can change the settings, as desired, and 

then click the “OK” button to apply them. 

5. Once you have set the appearance of the Start Menu to your liking, click the “OK button to apply your 

changes. Sa
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EXERCISES- 

Windows Management 
Purpose: 

 

1. To change the display of the Windows Taskbar within the Windows Desktop. 

Exercises: 

 

1. If using Windows 8, click the “Desktop” app within the “Start” screen to open the “Desktop.” 

2. In all versions of Windows, right-click an empty space, meaning where there are no icons, within 

the Taskbar. 

3. Within the pop-up menu that appears, look for the “Lock the Taskbar” command. 

4. If there is a checkmark in front of the “Lock the Taskbar” command, then click the command within 

the pop-up menu to remove the checkmark. 

5. Click and drag the Taskbar to the top of your “Desktop” screen and release the left mouse button to 

relocate the Taskbar to the top of the “Desktop.” 

6. Click and drag the Taskbar back down to the bottom of the “Desktop.” 

7. To lock the Taskbar into place, right-click an empty space on the Taskbar. 

8. Click the “Lock the Taskbar” command to place a checkmark in front of it. 

9. Click the time displayed at the right end of the Taskbar. 

10. Review the date and time settings in the pop-up menu that appears. 

11. Click into the empty area within the Taskbar to hide the date and time settings pop-up. 
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CHAPTER 6-  

Using Apps in Windows 8 

6.1- Downloading Apps from the Windows Store 

 

6.2- Managing App Files 

 

6.3- Using SkyDrive 
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Using Apps in Windows 8 

6.1- Downloading Apps from the Windows Store: 

 

 One of the new features of Windows 8 is the ability to download apps for your computing devices 

from the Windows Store. Note that you must be signed-in to your computer using a Microsoft Account in 

order to download apps from the Windows Store. 

 To download an app once you have signed-in using a Microsoft Account, click the “Store” icon within 

the Start screen to open the Windows Store app. Here you can browse the available apps to download. You 

can browse apps by category or simply review the featured apps that are displayed. You can click on an 

app that is shown within the Windows Store to read more about the selected app. On the app page shown, 

you can click the “Back” button in the upper left corner to return to the last page shown. You can also click 

the hyperlinks shown at the top of the app page to read the “Overview,” “Details,” and “Review” of the app. 

 To download the app, click the “Buy,” “Try” or “Install” buttons at the left side of the page. Free apps 

will typically just show the “Install” button, and paid apps will often show the “Buy” and “Try” buttons. The 

“Try” button will allow you to install a trial version of the app, which you can later purchase if you wish to 

keep. You can also click the “Buy” button to buy and download the app immediately. You will need to 

provide some form of payment in order to download and purchase a paid app. 

 Be sure to read the “Terms of Use” before making purchases from the Windows Store app. Note that 

the apps you buy are licensed, not sold, for you to use. Typically, this license include the ability to install 

and use the apps on up to 5 Windows 8 computing devices, however, you should always read the Terms of 

Use from each individual app provider, which may vary. 

 After selecting an app to install, you will see your download information appear in the upper-right 

corner of the screen. Once your app has been downloaded and installed a message box will appear 

onscreen informing you of that fact. You can then close the Windows Store app by clicking at the top of the 

app window and then dragging the app all the way to the bottom of the screen. 

  Also note that the Windows Store will also provide updates to the apps that are installed on your 

computer. You may see a small number appear on the Live Tile icon of the “Store” within the Start screen. 

This number indicates the number of app updates that you can install. To download the updates, simply 

click the “Store” app icon to open the store and then click the “Updates” link within the app window to begin 

downloading and installing any app updates that are available. Note that if you are logged into multiple 

computers that share the same apps, then you may need to log out of any other computers that may be 

logged-in before some of the apps will be able to be updated. For example, if you are logged into a desktop 

computer and then try to update the “SkyDrive” app, it may not allow you to do this if you are concurrently 

logged into the same Microsoft account with your laptop. In this case, you must log out of any other devices 

that are preventing the update to occur, such as the laptop in the example mentioned, before you can 

successfully update the apps. 
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Using Apps in Windows 8 

6.2- Managing App Files: 

 

 You will often see a new “Files” screen appear within apps when you perform a functions such as 

saving an app file, opening an app file, or selecting a file within an app. The “Files” windows that appears 

within many apps allows you to quickly find, save, or open the selected type of file within your computer. 

 Within the “Files” window, you can click or tap the drop-down arrow next to the word “Files” to select 

a folder location or library within your computer. Within a selected location, you may also see other 

commands at the top of the window that will allow you to browse the folders and view files. For example, 

you can click the “Go up” command, if shown, to move one level higher within the folder hierarchy from the 

currently selected location. Often you will see another drop-down arrow that displays sorting options for the 

current folder. You can click or tap the drop-down arrow next to that command to change how the files within 

the folder are sorted. For some apps, you may also see another drop-down that filters that types of files 

shown within the window. You can click or tap the drop-down arrow next to that command to change or 

select the type of files to display. 

 You will also see any app file management commands shown at the bottom of the “Files” window. 

So, for example, if you are opening a file, you would select the file to open and then click the “Open” or 

“Select” button that appears at the bottom of the window. Note that the buttons available will change 

depending on the app. When saving an app file, you will most often enter the name that you want to give to 

the file into the text box shown at the bottom of the window, and then click the “Save” button. 

6.3- Using SkyDrive: 

 

 You can use the SkyDrive app to save files that you wish to share in the “cloud” computing network if 

you are signed-in to your computer using a Microsoft Account. The SkyDrive gives you 7 GB of free storage 

space to which you can upload documents, pictures, videos, Microsoft Office files, and many other types of 

files. You can access SkyDrive by clicking the “SkyDrive” app icon within the Start screen when you are 

signed-in using the associated Microsoft Account. 

 Within the SkyDrive app, you will see any files you have uploaded and any folders you have created 

in addition to the three default folders named “Documents,” “Pictures,” and “Public.” You can click on the 

folders shown to open either the “Documents,” “Pictures,” or “Public” folders. After entering a folder, you can 

click the “Back” arrow in the upper-left corner of the screen to return to the previous folder. Note that any 

items added to the “Public” folder are shared by default with the contacts that you choose to allow to view 

your Microsoft Account profile. You can change these settings within your Microsoft Account online, if 

desired. We will show you where to change your account settings online momentarily. 

 If you want to create a new folder within the selected SkyDrive folder, right-click into the blank area 

of the screen or swipe up from the bottom of the screen, to display an options bar at the bottom of the app 

window. Then click the “New Folder” button within the options bar. You can then type a name for the new 

folder into the text box that appears above the bar and click the “Create folder” button to create a new 

SkyDrive folder. 

 To add files within a folder, simply right-click in the empty area shown within the app window or 

swipe up from the bottom of the app window, to display an options bar at the bottom of the screen. Then 

click the “Upload” button within the options bar to open a “Files” window where you can select the files to 

upload to your selected SkyDrive folder. Simply click the files you want to upload within the “Files” window 

to mark them with a checkmark and add them to a listing shown at the bottom of the “Files” window. Once 

you have selected the files to upload, click the “Add to SkyDrive” button to upload the files to the SkyDrive 

folder that you selected. Sa
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Using Apps in Windows 8 

6.3- Using SkyDrive- (cont’d.): 

 

 You can refresh the view of your SkyDrive folder to display any files that you have added by clicking 

the “Refresh” button that appears in the options bar at the bottom of the SkyDrive app window. 

 You can open a document stored within SkyDrive by simply clicking the icon of the file shown within 

the SkyDrive folder window. Windows 8 will then open the file using the associated app or program. You 

can also right-click on a item within the SkyDrive folder, and then click the “Download” button in the options 

bar at the bottom of the window to save a local copy of the file to your computer by using the “Files” window 

that then appears. For some files that are selected, you can click an “Open with” button that appears within 

the options bar to display a pop-up listing of the available apps that you could use to open this type of file. 

You can click on the name of an app within this list to change the program used to open the selected file 

type. 

 You can manage the files that you upload to your SkyDrive by right-clicking on the file to manage in 

order to select it with a checkmark and display the options bar at the bottom of the app window. Then click 

the “Manage” button that appears within the options bar to display a pop-up menu of command choices. 

Your most common choices are “Rename,” “Delete,” and “Move.” If you select the “Rename” command 

within the pop-up menu, then you will need to type a new name for the selected item into the text box that 

appears and then click the “Rename” button to rename the item. If you select the “Delete” command, you 

will then need to click the “Delete” button in the box that appears to confirm that you want to delete the 

selected item. If you select the “Move” command then you will need to navigate to the folder you want to 

move the selected item into and then click the “Move here” button within the options bar to move the file to 

the selected location. You can click the “Cancel” button in the options bar to cancel the move. You can also 

click the “Manage” button again to hide the pop-up menu if you decide you do not want to select any of 

these choices. 

 You can also click the “Clear selection” button within the options bar to remove the checkmark from 

a selected SkyDrive file or folder, if needed. You can also click the “Select all” button within the options bar 

to select all files and folders within a displayed folder. You can click the “Thumbnails” or “Details” buttons 

within the options bar to switch the view of the current folder between these two views. 

 Note that if someone shares files with your account, you can click the drop-down arrow that appears 

next to your “SkyDrive” folder’s name, and then choose the “Shared” command to view items that people 

have shared with you. You can also select the “Recent documents” command to display a listing of recently 

opened documents. You can then select the name of your SkyDrive folder from the drop-down to return to 

your primary SkyDrive folder. 

 Note that to set default sharing preferences and other account preferences for your Microsoft 

account, you must sign-in to your Windows Live account that is associated with your Microsoft Account 

email. You can simply open Internet Explorer 10 and then visit https://profile.live.com to access your profile 

and account information. You can then click the drop-down in the upper-left side of the screen and the 

select the “SkyDrive” link at the top of the page to manage the files within your online SkyDrive folders, as 

well as other online information associated with your Microsoft account. 
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ACTIONS- 

Using Apps in Windows 8 
DOWNLOADING APPS FROM THE WINDOWS STORE: 

 

1. One of the new features of Windows 8 is the ability to download apps for your computing devices from 

the Windows Store. Note that you must be signed-in to your computer using a Microsoft Account in 

order to download apps from the Windows Store. 

2. To download an app once you have signed-in using a Microsoft Account, click the “Store” icon within the 

Start screen to open the Windows Store app. 

3. Here you can browse the available apps to download. You can browse apps by category or simply 

review the featured apps that are displayed. 

4. You can click on an app that is shown within the Windows Store to read more about the selected app. 

5. On the app page shown, you can click the “Back” button in the upper left corner to return to the last 

page shown. 

6. You can also click the hyperlinks shown at the top of the app page to read the “Overview,” “Details,” and 

“Review” of the app. 

7. To download the app, click the “Buy,” “Try” or “Install” buttons at the left side of the page. Free apps will 

typically just show the “Install” button, and paid apps will often show the “Buy” and “Try” buttons. 

8. The “Try” button will allow you to install a trial version of the app, which you can later purchase if you 

wish to keep. 

9. You can also click the “Buy” button to buy and download the app immediately. You will need to provide 

some form of payment in order to download and purchase a paid app. 

10. Be sure to read the “Terms of Use” before making purchases from the Windows Store app. Note that the 

apps you buy are licensed, not sold, for you to use. Typically, this license include the ability to install 

and use the apps on up to 5 Windows 8 computing devices, however, you should always read the 

Terms of Use from each individual app provider, which may vary. 

11. After selecting an app to install, you will see your download information appear in the upper-right corner 

of the screen. 

12. Once your app has been downloaded and installed a message box will appear onscreen informing you 

of that fact. 

13. You can then close the Windows Store app by clicking at the top of the app window and then dragging 

the app all the way to the bottom of the screen. 

14. Also note that the Windows Store will also provide updates to the apps that are installed on your 

computer. You may see a small number appear on the Live Tile icon of the “Store” within the Start 

screen. This number indicates the number of app updates that you can install. 

15. To download the updates, simply click the “Store” app icon to open the store and then click the 

“Updates” link within the app window to begin downloading and installing any app updates that are 

available. Note that some updates may not be able to be successfully installed if you are logged into 

multiple devices with the same Microsoft User ID. If this is the case, log out of all devices except for one 

device, and then try to perform the updates again from that logged-in device. 
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ACTIONS- 

Using Apps in Windows 8 
MANAGING APP FILES: 

 

1. You will often see a new “Files” screen appear within apps when you perform a functions such as 

saving an app file, opening an app file, or selecting a file within an app. 

2. Within the “Files” window, you can click or tap the drop-down arrow next to the word “Files” to select a 

folder location or library within your computer. 

3. Within a selected location, you may also see other commands at the top of the window that will allow 

you to browse the folders and view files. For example, you can click the “Go up” command, if shown, to 

move one level higher within the folder hierarchy from the currently selected location. 

4. Often you will see a drop-down arrow that displays sorting options for the current folder. You can click or 

tap the drop-down arrow next to that command to change how the files within the folder are sorted. 

5. For some apps, you may see a drop-down that filters that types of files shown. You can click or tap the 

drop-down arrow next to that command to change or select the type of files to display. 

6. You will also see any app file management commands shown at the bottom of the “Files” window. So, 

for example, if you are opening a file, you would select the file to open and then click the “Open” or 

“Select” button that appears at the bottom of the window. Note that the buttons available will change 

depending on the app. 

7. When saving an app file, you will most often enter the name that you want to give to the file into the text 

box shown at the bottom of the window, and then click the “Save” button. 

USING SKYDRIVE: 

 

1. You can access SkyDrive by clicking the “SkyDrive” app icon within the Start screen when you are 

signed-in using the associated Microsoft Account. 

2. Within the SkyDrive app, you will see any files you have uploaded and any folders you have created in 

addition to the three default folders named “Documents,” “Pictures,” and “Public.” 

3. You can click on the folders shown to open either the “Documents,” “Pictures,” or “Public” folders. After 

entering a folder, you can click the “Back” arrow in the upper-left corner of the screen to return to the 

previous folder. 

4. To create a new folder within the selected SkyDrive folder, right-click into the blank area of the screen 

or swipe up from the bottom of the screen, to display an options bar at the bottom of the app window. 

5. Click the “New Folder” button within the options bar. 

6. You can then type a name for the new folder into the text box that appears above the bar and click the 

“Create folder” button to create a new SkyDrive folder. 

7. To add files within a folder, right-click in the empty area shown within the app window or swipe up 

from the bottom of the app window, to display an options bar at the bottom of the screen. 

8. Click the “Upload” button within the options bar to open a “Files” window where you can select the files 

to upload to your selected SkyDrive folder. 

9. Click the files you want to upload within the “Files” window to mark them with a checkmark and add 

them to a listing shown at the bottom of the “Files” window. 

10. Click the “Add to SkyDrive” button to upload the files to the SkyDrive folder that you selected. 

11. To refresh the view of your SkyDrive folder, click the “Refresh” button that appears in the options bar at 

the bottom of the SkyDrive app window. 

12. To open a document stored within SkyDrive, click the icon of the file shown within the SkyDrive folder 

window.  

 (cont’d.) Sa
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ACTIONS- 

Using Apps in Windows 8 
USING SKYDRIVE- (CONT’D.): 

 

13. To download a local copy of a file, right-click on a item within the SkyDrive folder, and then click the 

“Download” button in the options bar at the bottom of the window to save a local copy of the file to your 

computer by using the “Files” window that then appears. 

14. For some files that are selected, you can click an “Open with” button that appears within the options bar 

to display a pop-up listing of the available apps that you could use to open this type of file. You can click 

on the name of an app within this list to change the program used to open the selected file type. 

15. To manage the files that you upload to your SkyDrive, right-click on the file to manage in order to 

select it with a checkmark and display the options bar at the bottom of the app window. 

16. Then click the “Manage” button that appears within the options bar to display a pop-up menu of 

command choices. Your most common choices are “Rename,” “Delete,” and “Move.” 

17. If you select the “Rename” command, within the pop-up menu, then you will need to type a new 

name for the selected item into the text box that appears and then click the “Rename” button to rename 

the item. 

18. If you select the “Delete” command, you will then need to click the “Delete” button in the box that 

appears to confirm that you want to delete the selected item. 

19. If you select the “Move” command, then you will need to navigate to the folder you want to move the 

selected item into and then click the “Move here” button within the options bar to move the file to the 

selected location. 

20. You can click the “Cancel” button in the options bar to cancel the move. 

21. You can also click the “Manage” button again to hide the pop-up menu if you decide you do not want to 

select any of these choices. 

22. You can also click the “Clear selection” button within the options bar to remove the checkmark from a 

selected SkyDrive file or folder, if needed. 

23. You can also click the “Select all” button within the options bar to select all files and folders within a 

displayed folder. 

24. You can click the “Thumbnails” or “Details” buttons within the options bar to switch the view of the 

current folder between these two views. 

25. Note that if someone shares files with your account, you can click the drop-down arrow that appears 

next to your “SkyDrive” folder’s name, and then choose the “Shared” command to view items that 

people have shared with you. You can also select the “Recent documents” command to display a listing 

of recently opened documents. You can then select the name of your SkyDrive folder from the drop-

down to return to your primary SkyDrive folder. 

26. Note that to set default sharing preferences and other account preferences for your Microsoft account, 

you must sign-in to your Windows Live account that is associated with your Microsoft Account email. 

You can simply open Internet Explorer 10 and then visit https://profile.live.com to access your profile 

and account information. You can then click the drop-down in the upper-left side of the screen and the 

select the “SkyDrive” link at the top of the page to manage the files within your online SkyDrive folders, 

as well as other online information associated with your Microsoft account. 
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EXERCISES- 

Using Apps in Windows 8 
Purpose: 

 

1. There are no exercises for this chapter. 

Exercises: 

 

1. None 
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CHAPTER 7-  

Creating Documents 

7.1- Starting WordPad 

 

7.2- Editing Text 

 

7.3- Formatting Text 

 

7.4- Saving a Document 

 

7.5- Opening a Document 

 

7.6- Printing a Document 

 

7.7- Closing a Document 
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Creating Documents 

7.1- Starting WordPad: 

 

 In this lesson, we will explore the skill set you must acquire to create basic documents with the 

WordPad program in Windows. While you will certainly have more flexibility in creating documents when 

using a more sophisticated program like Microsoft Word, WordPad is included with Windows to give all 

users basic document creation ability. This will also introduce you to some of the basic skills in word 

processing on a computer. We will explore creating new documents, opening documents we’ve created, 

editing text, saving changes and closing the documents. 

 First though, you must start the WordPad program. To open WordPad in Windows 8, right-click in 

the empty area within the “Start” screen and then click the “All apps” button in the toolbar that appears at 

the bottom of the screen to display all of the apps on your computer. You can then find the “WordPad” app 

under the “Windows Accessories” app group within the listing. You can click the app icon to start WordPad. 

If you prefer, you can right-click the app icon and then click either the “Pin to Start” or “Pin to taskbar” 

buttons in the app toolbar that appears at the bottom of the screen to pin the app to either location for easier 

access in the future. To open WordPad in Windows 7 or Windows Vista, click the “Start” button, select the 

“All Programs” command, and then click the “Accessories” folder in the “All Programs” window. In the listing 

of programs shown within that folder, click the “WordPad” application to open WordPad. 

 Once you open WordPad, you can instantly begin creating a new document by typing on your 

keyboard into the document window. In Windows 8, you can click the “File” tab within the Ribbon and then 

click the “New” command in the drop-down menu that appears to create a new WordPad document. In 

Windows 7, you can click the “WordPad” button in the upper-left corner of the application window and then 

click the “New” command to create a new WordPad document. In Windows Vista, you can click the “New” 

button on the toolbar at the top of the “WordPad” application to create a new document. 

  Within the WordPad document, the blinking cursor shown onscreen indicates where the text that 

you type into your document will appear. When the cursor comes to the end of a line, the text will wrap 

automatically down to the next line. Only when you want to begin a new paragraph is it necessary to press 

the “Enter” key on your keyboard. Holding down the “Shift” key while pressing one of the alphabetic keys 

will make uppercase letters. Holding down the “Shift” key while pressing one of the number keys will make 

the symbol listed at the top of the number key. You can delete characters to the left of your insertion mark, 

by pressing the “Backspace” key. You can delete letters to the right by pressing the “Delete” or “Del” key. 

You may also delete text by clicking and dragging over it to select it, and then pressing the “Delete” or “Del” 

key on your keyboard. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



99 Mastering Windows Made Easy v. 8-Vista ©TeachUcomp, Inc. 

Creating Documents 

7.2- Editing Text: 

 

 You may find it useful to copy text that you have already typed into a new document or move the text 

to another place within the current document. You can either move the text, or simply copy it and then paste 

the copy to a new location, leaving the original text intact. 

 To move document content from one place to another, you must first select the item or text to be 

moved. You can do this in WordPad by clicking and dragging over the text to select it. The selected text will 

appear highlighted. Within WordPad, you can then click the “Cut” button in the “Clipboard” group on the 

“Home” tab of the Ribbon in Windows 8 or 7, or the Standard toolbar in Windows Vista. The text will 

disappear. Then move the insertion point to the place within the document where you want to paste the text 

that you just cut. Then click the “Paste” button to paste the text that was cut. 

 If you wanted to leave a copy of the original text intact in its original place instead of cutting it and 

pasting it, you can instead copy and paste it to another location. Once again, start by selecting the text that 

you want to copy to a new location. Within WordPad, you can then click the “Copy” button in the “Clipboard” 

group on the “Home” tab of the Ribbon in Windows 8 or 7, or the Standard toolbar in Windows Vista. Next, 

move the insertion mark to the point within the document where you want to paste the copy of the text. 

Finally, click the “Paste” button to paste the text to the selected location. 

Cut Copy Paste 

WordPad in Windows Vista 

Cut 

Copy 

Paste 

WordPad in Windows 8 and 7 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



100 Mastering Windows Made Easy v. 8-Vista ©TeachUcomp, Inc. 

Creating Documents 

7.3- Formatting Text: 

 

 You can change many characteristics of the appearance of all or any part of the text within your 

document. You can change the font face and size of the text. You can also bold, italicize or underline text as 

well as change its alignment within your document. Before you can apply any of these changes, however, 

you must first select the text that you want to change. Click and drag over the text to select it. The text that 

is selected will then receive the changes that you make to its appearance. Non-selected text will not be 

changed. Once the text is selected, you can click any of the formatting buttons to apply changes to the text. 

 If using Windows 8 or 7, the formatting buttons all appear within the “Font” button group on the 

“Home” tab within the Ribbon above the document window. If using Windows Vista, the formatting buttons 

all appear within the Formatting toolbar above the document window. 

 “Font family” is the first drop-down choice. Click this drop-down box to see and select the particular 

font that you want to use for your text. Click the “Font Size” drop-down to select a font size, or click into the 

box and type the size of the font you want. Clicking the “Bold” button makes the selected text wider and 

darker. Clicking the “Italics” button will slant the selected text to the right. Clicking the “Underline” button will 

place a line under the selected text. By clicking the “Text Color” button, you can open the color selector and 

change the color of the selected text. 

 If using Windows 8 or 7, you can set text alignment using the buttons in the “Paragraph” button 

group on the “Home” tab in the Ribbon. These buttons still appear within the Formatting toolbar in Windows 

Vista. Clicking on any of the “Align” buttons will change the alignment or placement of the selected text. The 

three alignments buttons are “Left Align,” “Center Align,” and “Right Align.” In Windows 8 and 7, you also 

have the “Justify” alignment option, which aligns both the right and left sides of a paragraph. In this same 

grouping is the “Start a list” button, called “Bullets” button in Windows Vista. By highlighting text and clicking 

this button, you can add symbols that can be placed at the start of each item within a typed list of items. 

Formatting buttons in WordPad in Windows 8 and 7 (top) and Vista (bottom) 

Font Family Italic Bold Font Size Underline Text Color Left Align Center Right Align Bullets 
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Creating Documents 

7.4- Saving a Document: 

 

 After you have entered or edited text, or made any change to a document that you want to keep, you 

should save the document. When you save a document for the first time, you must use the “Save As” dialog 

box. Doing this gives WordPad a location to which the document will be saved and a file name. Give it a 

name that you will remember and be sure to remember where you saved it. 

 You can access the “Save As” dialog box by clicking the “Save” button in the Quick Access toolbar 

at the top of a previously unsaved document. In the “Save As” dialog box that then appears, navigate to the 

folder where you want to save the document. Then in the “File name:” text box, enter a name for the file. 

Then click the “Save” button in the dialog box to save it. 

 Once you’ve named the file and saved it, its name will appear in the title bar. When you go to save 

the document again by clicking the “Save” button in the Quick Access toolbar in the future, you will not have 

to re-enter the name and location. It will save itself automatically to the same place with the same name. 

7.5- Opening a Document: 

 

 To open a document in WordPad, you first must know where the file is located and the name of the 

file. If using Windows 8, click the “File” tab in the Ribbon, and then click the “Open” button. If using Windows 

7, click the “WordPad” tab in the Ribbon, and then click the “Open” button. If using Windows Vista, click the 

“Open” button in the toolbar at the top of the WordPad document. 

 In all versions, the “Open” dialog box will then appear. You use the “Open” dialog box to navigate to 

the folder that contains the file that you want to open. When you see the document file that you want to 

open in the main window of the dialog box, click it once to select it and then click the “Open” button in the 

lower right corner of the “Open” dialog box. The document will then open in WordPad. 

7.6- Printing a Document: 

 

 You can print a document that you have opened in WordPad. If using Windows 8, click the “File” tab 

within the Ribbon and then click the “Print” command button. If using Windows 7, click the “WordPad” button 

and then click the “Print” button. If using Windows Vista, click the “Print” button in the toolbar. 

 In all versions, at this point the “Print” dialog box will appear. In this dialog box, you can select the 

printer that you want to use, if you have more than one, from the “Select Printer” area. 

 In the “Print range” section, you can select either the option for “All,” which will print the entire 

document; “Pages,” which prints the pages that you type into the text box, or “Selection,” which prints only 

the text that you have highlighted before opening this dialog box. In the “Copies” section, enter the number 

of copies you wish to print, and check the “Collate” checkbox to print them collated. When you are ready to 

print, click the “Print” button to print the document with the settings that you specified. 

7.7- Closing a Document: 

 

 After you have saved your document, you can close it by simply clicking the “X” in the upper-right 

corner of the “WordPad” application window to close it. 
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ACTIONS- 

Creating Documents 
STARTING WORDPAD: 

 

1. To open WordPad in Windows 8, right-click in the empty area within the “Start” screen and then click the 

“All apps” button in the toolbar that appears at the bottom of the screen to display all of the apps on your 

computer. You can then find the “WordPad” app under the “Windows Accessories” app group and click 

the app icon to start WordPad. 

2. If you prefer, you can right-click the app icon and then click either the “Pin to Start” or “Pin to taskbar” 

buttons in the app toolbar that appears at the bottom of the screen to pin the app to either location for 

easier access in the future. 

3. To open WordPad in Windows 7 or Windows Vista, click the “Start” button, select the “All Programs” 

command, and then click the “Accessories” folder in the “All Programs” window. 

4. In the listing of programs shown within that folder, click the “WordPad” application to open WordPad. 

5. Once you open WordPad, you can instantly begin creating a new document by typing on your keyboard 

into the document window. 

6. In Windows 8, you can click the “File” tab within the Ribbon and then click the “New” command in the 

drop-down menu that appears to create a new WordPad document. 

7. In Windows 7, you can click the “WordPad” button in the upper-left corner of the application window and 

then click the “New” command to create a new WordPad document. 

8. In Windows Vista, you can click the “New” button on the toolbar at the top of the “WordPad” application 

to create a new document. 

9. Within the WordPad document, the blinking cursor shown onscreen indicates where the text that you 

type into your document will appear. 

10. When the cursor comes to the end of a line, the text will wrap automatically down to the next line. Only 

when you want to begin a new paragraph is it necessary to press the “Enter” key on your keyboard. 

11. Holding down the “Shift” key while pressing one of the alphabetic keys will make uppercase letters. 

12. Holding down the “Shift” key while pressing one of the number keys will make the symbol listed at the 

top of the number key. 

13. You can delete characters to the left of your insertion mark, by pressing the “Backspace” key. 

14. You can delete letters to the right by pressing the “Delete” or “Del” key. 

15. You may also delete text by clicking and dragging over it to select it, and then pressing the “Delete” or 

“Del” key on your keyboard. 

EDITING TEXT: 

 

1. To move document content from one place to another, you must first select the item or text to be 

moved. You can do this in WordPad by clicking and dragging over the text to select it. 

2. Within WordPad, you can then click the “Cut” button in the “Clipboard” group on the “Home” tab of the 

Ribbon in Windows 8 or 7, or the Standard toolbar in Windows Vista. 

3. Move the insertion point to the place within the document where you want to paste the text that you cut. 

4. Then click the “Paste” button to paste the text that was cut. 

5. To copy and paste, start by selecting the text that you want to copy to a new location. 

6. Within WordPad, you can then click the “Copy” button in the “Clipboard” group on the “Home” tab of the 

Ribbon in Windows 8 or 7, or the Standard toolbar in Windows Vista. 

7. Move the insertion mark to the point within the document where you want to paste the copy of the text. 

8. Finally, click the “Paste” button to paste the text to the selected location. Sa
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ACTIONS- 

Creating Documents 

SAVING A WORDPAD DOCUMENT: 

 

1. When you save a document for the first time, you must use the “Save As” dialog box. Doing this gives 

WordPad a location to which the document will be saved and a file name. 

2. You can access the “Save As” dialog box by clicking the “Save” button in the Quick Access toolbar at 

the top of a previously unsaved document. 

3. In the “Save As” dialog box that then appears, navigate to the folder where you want to save the 

document. 

4. Then in the “File name:” text box, enter a name for the file. 

5. Then click the “Save” button in the “Save As” dialog box to save it. 

6. Once you’ve named the file and saved it once, its name will appear in the title bar. When you go to save 

the document again by clicking the “Save” button in the Quick Access toolbar in the future, you will not 

have to re-enter the name and location. It will save itself automatically to the same place with the same 

name. 

OPENING A WORDPAD DOCUMENT: 

 

1. To open a document in WordPad, you first must know where the file is located and the name of the file. 

2. If using Windows 8, click the “File” tab in the Ribbon, and then click the “Open” button. 

3. If using Windows 7, click the “WordPad” tab in the Ribbon, and then click the “Open” button. 

4. If using Windows Vista, click the “Open” button in the toolbar at the top of the WordPad document. 

5. In all versions, the “Open” dialog box will then appear. You use the “Open” dialog box to navigate to the 

folder that contains the file that you want to open. 

6. When you see the document file that you want to open in the main window of the “Open” dialog box, 

click it once to select it and then click the “Open” button in the lower right corner of the “Open” dialog 

box. 

7. The document will then open in WordPad. 

FORMATTING TEXT: 

 

1. First select the text that you want to change. 

2. Click and drag over the text to select it. The text that is selected will then receive the changes that you 

make to its appearance. Unselected text will not be changed. 

3. If using Windows Vista, you can click any of the buttons in the “Formatting” toolbar to apply the selected 

formatting to the selected text. If using Windows 8 or 7, you can click the buttons that appear in the 

“Font” and “Paragraph” groups of the “Home” tab in the Ribbon to apply formatting changes. 
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ACTIONS- 

Creating Documents 
PRINTING A DOCUMENT: 

 

1. If using Windows 8, click the “File” tab within the Ribbon and then click the “Print” command button. 

2. If using Windows 7, click the “WordPad” button and then click the “Print” button. 

3. If using Windows Vista, click the “Print” button in the toolbar. 

4. In all versions, at this point the “Print” dialog box will appear. In this dialog box, you can select the 

printer that you want to use, if you have more than one, from the “Select Printer” area. 

5. In the “Print range” section, you can select either the option for “All,” which will print the entire document; 

“Pages,” which prints the pages that you type into the text box, or “Selection,” which prints only the text 

that you have highlighted before opening this dialog box. 

6. In the “Copies” section, enter the number of copies you wish to print, and check the “Collate” checkbox 

to print them collated. 

7. When you are ready to print, click the “Print” button to print the document. 

CLOSING A DOCUMENT: 

 

1. After you have saved your document, you can close it by simply clicking the “X” in the upper-right corner 

of the “WordPad” application window to close it. 
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EXERCISES- 

Creating Documents 
Purpose: 

 

1. To create a basic document in WordPad. 

Exercises: 

 

1. Open the WordPad application using the method needed for your version of Windows. 

2. Type any text that you desire into the main document shown in WordPad. 

3. Highlight a portion of the text you entered and click the “Copy” button. 

4. Click into a different place in your document, and then click the “Paste” button. 

5. Highlight a portion of text and click the drop-down for “Font Family.” Select a different font from the 

drop-down list of fonts shown. 

6. Click the drop-down for “Font size.” Select a different size from the drop-down menu. 

7. Click on the rest of the formatting options to see the changes for the highlighted text.  

8. Click the “Save” button in the toolbar at the top of the application window to open the “Save As” 

dialog box. 

9. In the box “File name:” at the bottom of the “Save As” dialog box, type “Test.” 

10. Click the “Save” button in the “Save As” dialog box to save your document and close the dialog box. 

11. Click on the close button (“X”)  in the upper-right corner of the WordPad title bar. 

12. Open the WordPad application again within Windows. 

13. If using Windows 8, click the “File” tab in the Ribbon, and then click the “Open” button. 

14. If using Windows 7, click the “WordPad” tab in the Ribbon, and then click the “Open” button. 

15. If using Windows Vista, click the “Open” button in the toolbar at the top of the WordPad document. 

16. In all versions, the “Open” dialog box will then appear. Use the “Open” dialog box find the “Test” file 

and highlight it by clicking on it once. 

17. Click the “Open” button within the “Open” dialog box to open your file again. 

18. If using Windows 8, click the “File” tab within the Ribbon and then click the “Print” command button. 

19. If using Windows 7, click the “WordPad” button and then click the “Print” button. 

20. If using Windows Vista, click the “Print” button in the toolbar. 

21. In all versions, at this point the “Print” dialog box will appear. Make any selections necessary, and 

then click the “Print” button to send the document to your selected printer. 

22. Click the “X” in the upper right corner of the WordPad application to close it. 
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CHAPTER 8- 

Drawing Pictures 

8.1- Starting Paint 

 

8.2- Drawing Shapes and Lines 

 

8.3- Adding Text 

 

8.4- Erasing Parts of a Picture 

 

8.5- Saving a Picture 

 

8.6- Opening a Picture 
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Drawing Pictures 

8.1- Starting Paint: 

 

 In this lesson, we will explore the skill set you must acquire to create and edit basic images files with 

the Paint program in Windows. This will also introduce you to some of the basic skills in working with 

graphics on a computer. We will explore creating new images, editing images, saving changes and closing 

the image files. 

  First though, you must start the Paint program. To open Paint in Windows 8, right-click in the empty 

area within the “Start” screen and then click the “All apps” button in the toolbar that appears at the bottom of 

the screen to display all of the apps on your computer. You can then find the “Paint” app under the 

“Windows Accessories” app group within the listing. You can click the app icon to start Paint. If you prefer, 

you can right-click the app icon and then click either the “Pin to Start” or “Pin to taskbar” buttons in the app 

toolbar that appears at the bottom of the screen to pin the app to either location for easier access in the 

future. To open Paint in Windows 7 or Windows Vista, click the “Start” button, select the “All Programs” 

command, and then click the “Accessories” folder in the “All Programs” window. In the listing of programs 

shown within that folder, click the “Paint” application to open Paint. 

 Once you open Paint, you can begin creating a new image. In Windows 8, you can click the “File” 

tab within the Ribbon and then click the “New” command in the drop-down menu that appears to create a 

new Paint document. In Windows 7, you can click the “Paint” button in the upper-left corner of the 

application window, and then click the “New” command to create a new Paint image document. In Windows 

Vista, you can select “File| New” from the Menu Bar at the top of the “Paint” application to create a new 

image document. 

8.2- Drawing Shapes and Lines: 

 

 When opened, Paint shows a default blank image document. Here you can draw new shapes by first 

clicking the desired “Shapes” button that you want to draw. In Windows 8 and 7, these buttons are shown in 

the Ribbon and in Windows Vista they are shown in a toolbar at the left of the application. 

 Next, select the fill style of the object that you want to draw. If using Windows 8 or 7, you make this 

selection from the “Fill” button's drop-down menu of choices in the Ribbon. If using Windows Vista, you 

make this selection from the options shown in the “Properties” section. 

 If using Windows 8 or 7, click on “Color 1” in the Ribbon and then click on a color in the color palette 

at the top of the “Paint” application to set the foreground, or line color, of the shape that you are about to 

draw. You can then click on “Color 2” in the Ribbon and then click on a color in the color palette that you 

want to use as a background, or fill color, for the shape that you are about to draw. 

  If using Windows Vista, click on a color in the color palette at the top of the “Paint” application to set 

the foreground, or line color, of the shape that you are about to draw. You can then right-click on a color in 

the color palette that you want to use as a background, or fill color, for the shape you are about to draw. 

 Once you have selected the settings that you prefer, click and drag within the image file to draw a 

shape with the settings that you selected. 

 To draw a line, choose the “Line” button shown within the “Shapes” button group in either the 

Ribbon or the toolbar, depending on the version of Paint that you are using. Then set the foreground, or 

line, color as you would when drawing any other shape. Then click and drag from start to finish where you 

want the line to appear. 
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Drawing Pictures 

8.4- Erasing Parts of a Picture: 

 

 To erase parts of a picture that you have drawn, click the “Eraser” button in “Tools” button group 

within the Ribbon or toolbar, and select an eraser size from “Size” selector. Note that you should then 

choose the background color of the document, usually white, as the “Color 2” or fill color choice. Note that 

the “Eraser” tool really just applies the background color choice, versus actually erasing content. So pick the 

color that is the same as the background of the image file. Then click and drag over the parts of the picture 

that you want to “erase” to remove them. 

8.5- Saving a Picture: 

 

 To save your picture when you are finished, click the “Save” button in the Quick Launch toolbar at 

the top of the Paint application window. That will launch the “Save As” dialog box where you can navigate to 

the folder where you want to save the file. Then in the “File name:” text box, enter a name for the image file. 

When you are ready, click the “Save” button in the dialog box to save the file. 

8.6- Opening a Picture: 

 

 You can open a picture that you have saved to work on it again. If using Windows 8, click the “File” 

tab in the Ribbon, and then click the “Open” button. If using Windows 7, click the “Paint” button and then 

click the “Open” button in the drop-down menu that appears. If using Windows Vista, select “File| Open…” 

from the Menu Bar. That will launch the “Open” dialog box. 

 Use the “Open” dialog box to navigate to the folder that contains the image file that you want to 

open. When you see the image file that you want to open in the main window of the dialog box, click it once 

to select it, and then click the “Open” button in the lower right corner of the “Open” dialog box.  

8.3- Adding Text: 

 

 To add text to an image, click the “Text” button in the “Tools” button group in either the Ribbon or 

toolbar, depending on the version on Paint that you are using. Then click into the image at the point where 

you want the text to appear. This will make a small text box for the text, and place an insertion point in the 

text box. Type the text that you want, resizing the text box if needed. You can do that by placing your mouse 

pointer over the border of the text box until you see a double-pointed arrow appear. At that point, click and 

drag to resize the text box. 

 You can also click and drag over the text and set the font face, font size, bolding, italics, or underline 

by clicking on those buttons that appear in the “Text Tools” contextual tab within the Ribbon shown in 

Windows 8 and 7, or the “Font” toolbar in Windows Vista. When you are finished, click outside of the text 

box to set the text. 
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ACTIONS- 

Drawing Pictures 
STARTING PAINT AND CREATING NEW DOCUMENTS: 

 

1. To open Paint in Windows 8, right-click in the empty area within the “Start” screen and then click the “All 

apps” button in the toolbar that appears at the bottom of the screen to display all of the apps on your 

computer. 

2. You can then find the “Paint” app under the “Windows Accessories” app group within the listing. 

3. You can click the app icon to start Paint. 

4. If you prefer, you can right-click the app icon and then click either the “Pin to Start” or “Pin to taskbar” 

buttons in the app toolbar that appears at the bottom of the screen to pin the app to either location for 

easier access in the future. 

5. To open Paint in Windows 7 or Windows Vista, click the “Start” button, select the “All Programs” 

command, and then click the “Accessories” folder in the “All Programs” window. In the listing of 

programs shown within that folder, click the “Paint” application to open Paint. 

6. In Windows 8, you can click the “File” tab within the Ribbon and then click the “New” command in the 

drop-down menu that appears to create a new Paint document. 

7. In Windows 7, you can click the “Paint” button in the upper-left corner of the application window, and 

then click the “New” command to create a new Paint image document. 

8. In Windows Vista, you can select “File| New” from the Menu Bar at the top of the “Paint” application to 

create a new image document. 

DRAWING LINES AND SHAPES: 

 

1. When opened, Paint shows a default blank image document. Here you can draw new shapes by first 

clicking the desired “Shapes” button that you want to draw. In Windows 8 and 7, these buttons are 

shown in the Ribbon and in Windows Vista they are shown in a toolbar at the left of the application. 

2. Next, select the fill style of the object that you want to draw. If using Windows 8 or 7, you make this 

selection from the “Fill” button's drop-down menu of choices in the Ribbon. If using Windows Vista, you 

make this selection from the options shown in the “Properties” section. 

3. If using Windows 8 or 7, click on “Color 1” in the Ribbon and then click on a color in the color palette at 

the top of the “Paint” application to set the foreground, or line color, of the shape that you are about to 

draw. 

4. You can then click on “Color 2” in the Ribbon and then click on a color in the color palette that you want 

to use as a background, or fill color, for the shape that you are about to draw. 

5. If using Windows Vista, click on a color in the color palette at the top of the “Paint” application to set the 

foreground, or line color, of the shape that you are about to draw. 

6. You can then right-click on a color in the color palette that you want to use as a background, or fill color, 

for the shape you are about to draw. 

7. Once you have selected the settings that you prefer, click and drag within the image file to draw a shape 

with the settings that you selected. 

8. To draw a line, choose the “Line” button shown within the “Shapes” button group in either the Ribbon or 

the toolbar, depending on the version of Paint that you are using. 

9. Then set the foreground, or line, color as you would when drawing any other shape. 

10. Then click and drag from start to finish where you want the line to appear. 
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ACTIONS- 

Drawing Pictures 

SAVING A PICTURE: 

 

1. To save your picture when you are finished, click the “Save” button in the Quick Launch toolbar at the 

top of the Paint application window. 

2. That will launch the “Save As” dialog box where you can navigate to the folder where you want to save 

the file. 

3. Then in the “File name:” text box, enter a name for the image file. 

4. When you are ready, click the “Save” button in the dialog box to save the file. 

OPENING A PICTURE: 

 

1. You can open a picture that you have saved to work on it again. If using Windows 8, click the “File” tab 

in the Ribbon, and then click the “Open” button. 

2. If using Windows 7, click the “Paint” button and then click the “Open” button in the drop-down menu that 

appears. 

3. If using Windows Vista, select “File| Open…” from the Menu Bar. 

4. Use the “Open” dialog box to navigate to the folder that contains the image file that you want to open. 

5. When you see the image file that you want to open in the main window of the dialog box, click it once to 

select it, and then click the “Open” button in the lower right corner of the “Open” dialog box.  

ERASING PARTS OF A PICTURE: 

 

1. To erase parts of a picture that you have drawn, click the “Eraser” button in “Tools” button group within 

the Ribbon or toolbar. 

2. Select an eraser size from “Size” selector. 

3. Note that you should then choose the background color of the document, usually white, as the “Color 2” 

or fill color choice. Note that the “Eraser” tool really just applies the background color choice, versus 

actually erasing content. So pick the color that is the same as the background of the image file. 

4. Then click and drag over the parts of the picture that you want to “erase” to remove them. 

ADDING TEXT: 

 

1. To add text to an image, click the “Text” button in the “Tools” button group in either the Ribbon or 

toolbar, depending on the version on Paint that you are using. 

2. Then click into the image at the point where you want the text to appear. This will make a small text box 

for the text, and place an insertion point in the text box. 

3. Type the text that you want, resizing the text box if needed. You can do that by placing your mouse 

pointer over the border of the text box until you see a double-pointed arrow appear. At that point, click 

and drag to resize the text box. 

4. You can also click and drag over the text and set the font face, font size, bolding, italics, or underline by 

clicking on those buttons that appear in the “Text Tools” contextual tab within the Ribbon shown in 

Windows 8 and 7, or the “Font” toolbar in Windows Vista. 

5. When you are finished, click outside of the text box to set the text. 
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EXERCISES- 

Drawing Pictures 
Purpose: 

 

1. To create a basic image in Windows Paint. 

Exercises: 

 

1. Open Windows Paint using the method required by your version of Windows. 

2. Click the “Oval” shape (“Ellipse” shape in Windows Vista) in the “Shapes” section. 

3. Click and drag a circle in the screen. 

4. Click on any color from the color palette at the top of the screen. 

5. Click the “Fill with color” button (“Fill” button in Windows Vista), then click inside circle to fill it with 

the color. 

6. Click the “Text” button. 

7. Click the color that you want to make the text within the color palette.  

8. Click drag a box in the area of the image where you want the text to appear. 

9. Type the text you want to have appear. 

10. Click the “Save” button in the toolbar at the top of the “Paint” application to open the “Save As” 

dialog box. 

11. In the box “File name:” text box at the bottom of the “Save As” dialog box, type a name for the file. 

12. Click the “Save” button to save your image file and exit the “Save As” dialog box. 

13. Click the “X” button in the upper right corner of the “Paint” window’s title bar to close it. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



112 Mastering Windows Made Easy v. 8-Vista ©TeachUcomp, Inc. 

CHAPTER 9- 

Using the Internet 

9.1- About the Internet  

 

9.2- Using the Desktop Internet Explorer 10 

 

9.3- Using the Internet Explorer 10 App  

 

9.4- Connecting to the Internet 

 

9.5- Windows Defender in Windows 8 
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Using the Internet 

9.1- About the Internet: 

 

 The Internet is a collection of connected networks around the globe that share a common address 

scheme. The Internet began in 1962 as a computer network for the U.S. military, and over time has grown 

into a global communication tool. By design the Internet is decentralized. Each computer on the Internet is 

independent of each other. The operators of these computers can choose which Internet services to use 

and which local services to make available to the Internet community as a whole. There are a variety of 

ways to access the Internet. Most gain access through a commercial Internet Service Provider (ISP).  

 The World Wide Web is one part of the Internet, and the one with which most people are familiar. 

The World Wide Web is a collection of connected computers that store documents that are known as web 

pages. A collection of web pages for one topic, person, or company is called a web site. Web pages can 

contain images, animations, interactive forms, games, links (called “hyperlinks”) that can take you to other 

web sites or web pages, and programming scripts that can allow you to enter, store, and manipulate data 

and information from a remote location. 

 When you want to jump to a new web page on the World Wide Web, you usually click some form of 

a hyperlink to go to the new web page. Hyperlinks are often text descriptions that are usually of a different 

font style and color (often blue and underlined) than most of the normal informative text on a web page. 

When you click a hyperlink, you actually are invoking a URL address. URL stands for “Uniform Resource 

Locator." This URL address is where the document that you want to view is stored on the World Wide Web. 

So, when you click on a hyperlink, it uses the associated URL address to take you to the web page 

designated by that URL address, which then displays itself in your web browser, like Internet Explorer. 

 This process of jumping to interrelated web sites is known as browsing the Internet, or more 

typically: “surfing the net.” You use a web browser to view these different pages, and to translate the web 

language (which are usually written in HTML, XML, or DHTML) into the displayed information that you see 

on your web browser’s screen. HTML and its related languages are the interactive document languages 

used to display web pages. HTML documents, which stands for “Hyper Text Markup Language,” support 

what is called HTTP (Hyper Text Transport Protocol) to make linking and viewing multiple web pages 

possible. 
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Using the Internet 

9.2- Using the Desktop Internet Explorer 10: 

 

  A “web browser” is a software application used to make navigating the Internet easy for the user by 

providing a graphical user interface, so the user can click menus, icons, or buttons rather than learning 

difficult computer commands. It is also called a “web client” because the browser application resides on the 

client computer, or the computer of the individual using it, rather than residing on a web server. 

  Internet Explorer is a web browser made by Microsoft that allows the user to view Web pages when 

they are connected to the Internet. Internet Explorer is installed on most computers with a Windows 

operating system. You can easily identify the browser by its icon. Internet Explorer’s icon is a large blue “e.” 

You will see a button for it appear in your Windows taskbar in the Desktop app within Windows 8. To open 

the desktop version of Internet Explorer 10 in Windows 8, click the button in the Windows taskbar. 

 When the browser window opens you will find the window to be similar to many of the other windows 

you have opened. There is a “Title Bar” at the very top of the window that will tell you what page you are 

looking at. At the far right there are three buttons to “Minimize," “Maximize,” and “Close” the browser. 

 The next bar contains the navigation buttons that allow you move back and forward through the web 

pages that you have visited. The large white text box to the right is the “Address Bar.” This bar displays the 

web page address of the page on your screen. You can type in the address of any page you want to go to 

here and either click the “Go” button, which is displayed as an arrow button that then appears at the end of 

the bar, or press “Enter” on your keyboard to go to the web page address that you have entered.  

 In the center of the window is where you will view the web page. Often you will find scroll bars at the 

right and bottom of this area, so you can scroll through to see the entirety of the web page. 

 While you may often enter web page addresses into the address bar in order to visit web sites that 

you are familiar with, you may also need to search the web for web pages that may contain content that you 

are looking for. To do this in Internet Explorer 10, which comes with Windows 8 computers, you can simply 

enter the words or phrases for which you want to find matching web pages directly into the “Address Bar.” 

Then click the “Go” button, or press the “Enter” key on your keyboard, in order to display a listing of related 

hyperlinks that you can click in order to view the associated  web page. As you move from page to page, 

you can use the “Back” and “Forward” button in the upper left corner of the window to move back to the 

results of the web search. You can also click on a tab shown at the top of the page and then open a new 

web page on a separate tab within Internet Explorer 10. You can then click between the open tabbed 

windows in the program, so that you can easily keep information in view. You can close any tabbed page 

within the program by clicking the small “x” button at the right end of any tab shown. 

 Also note that if you are trying to find specific text within a web page that is displayed within Internet 

Explorer, click the “Tools” button that is displayed as a cog button in the upper-right corner of the window, 

roll over the “File” command in the drop-down menu that appears, and then click the “Find on this page” 

command from the side menu that appears. Doing that will open a “Find” bar at the top of the window, 

below the “Address Bar,” where you can enter the text to find on the page. You can then click the “Previous” 

and “Next” buttons to jump to the different occurrences of the text within the page. You can then click the “x” 

button at the left end of the “Find” bar to close it when you are finished. 
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Using the Internet 

9.3- Using the Internet Explorer 10 App: 

 

  Internet Explorer 10 behaves differently as an app that you can access from the Start screen than 

its Desktop counterpart. The app cannot install “add-ons” that enable the display of some web content, such 

as Adobe Flash. Therefore, if you cannot view a web page correctly using the Internet Explorer 10 app, then 

you can open the web page using the Desktop version which will allow you to install the “add-ons” 

necessary in order to correctly view the web page content. 

 You can click the Internet Explorer 10 app icon in the Start screen in order to open a new browser 

window. At the bottom of the browser window you will see a black bar that contains the buttons that you will 

need to use in order to view web pages. The buttons you will see from left to right are the “Back” button, the 

application or web page icon, the “Address Bar,” the “Refresh” button, the “Pin to Start” button, the “Page 

tools” button, and the “Forward” button. 

 To view a web page, you type the desired URL address (example: http://www.teachucomp.com) into 

the “Address Bar.” When you have finished typing the URL, you can either press the “Enter” key on your 

keyboard or tap or click the “Go” button that will appear at the right end of the “Address Bar” when you 

begin typing the URL. Also note that as you begin typing the URL address, Internet Explorer 10 will display 

web pages that it thinks you may want to visit, based on what you type and web pages that you have 

previously visited, as icons shown above the address bar. If one of these suggestions shows the URL that 

you wish to visit, you can simply click or tap on the icon shown within the window to display that web page 

in the web browser window instead of typing the URL address. 

 As you view the different web pages within the browser window, you can use the buttons in the 

black bar at the bottom of the page to help you navigate through the pages you have visited. You can click 

the “Back” button to return to the previously viewed web page. If you click the “Back” button, you can click 

the “Forward” button to move forward to the web page that you left. You can click the “Refresh” button to 

refresh the content shown within the web page, if needed. If you wish to pin a particular web page that you 

are viewing to your Start screen so that you will not have to enter the address again, you can display the 

web page to pin within the browser window and then click the “Pin site” button. You can then select either 

“Pin to Start” or “Add to favorites” to either pin the page to your “Start” screen or add the page to your 

“Favorites” site list. 

 You can click the “Page tools” button to display a small pop-up menu of commands that assist you 

with your web pages. You can click the “Find on page” command to display a search bar within the black 

bar at the bottom of the page that will allow you to search for specific text within a web page. Simply enter 

the text to find within the “Find” text box. The text that you type will appear highlighted within the web page. 

You can then click the “Previous” and “Next” buttons to search for previous and next occurrences of that 

text within the web page. When you are finished, you can click the “Close” button. 

 You can also click the “View on the Desktop” command to open the selected web page using the 

Desktop version of Internet Explorer 10. This will allow you to view the web page using a copy of Internet 

Explorer that allows for “add-ins” to be installed, so that you can view web pages that use Flash content and 

other web page extensions. 

 Note that when you are viewing a web page, you can click into the page to make the small black bar 

at the bottom disappear. You can then scroll through the page with an unobstructed view. 

 You can also place your mouse pointer at the top of the page and right-click or swipe in from the top 

of the app to view the small black bar at the bottom, as well as a new black bar at the top of the page. The 

black bar at the top of the page allows you to view any opened web browser windows as tabs shown within 

the bar. You can open a new web browser window by clicking the “+” button at the right side of the bar. You 

can then enter a new URL address into the new window that opens. You can switch between the opened 

tabbed windows by clicking the tab icon shown at the top of the page in the black bar. You can close an 

open tabbed web page by clicking the “X” button shown on the tab icon. Sa
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Using the Internet 

9.3- Using the Internet Explorer 10 App (cont'd.): 

 

 You can click the “…” button to display a menu of commands. You can select the “New InPrivate 

tab” command to open a new browser window that will not store any data about your browsing session, 

such as which web sites you have visited. You can read about InPrivate browsing within the new window 

that opens. 

 You can select the “Close tabs” command in order to close all open browser windows, except for the 

last window opened. 

 You can right-click at the top of the app, or swipe up from the black bar, when the black bar is 

displayed to close the black bars shown at the top and bottom of the app window. 

 When you want to close the app, click and drag from the top of the app window to the bottom of the 

window to close the app by clicking and dragging it off screen. 
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Using the Internet 

9.4- Connecting to the Internet: 

 

 In order to use many features within Windows, you must establish a connection to the Internet. Many 

offices and business computers will already have a connection to the Internet. At work, you can check with 

your Network Administrator to find out how you would connect. At home, you will have to set up your own 

connection to your ISP, or “internet service provider.” 
 Without a connection you will not be able to bring up web pages, download information, send or 

receive email. You can, however, look at emails you have already received and type up new email to send 

out once you are connected to the Internet using an email application, such as Windows Mail. 

 There are many different types of both wired and wireless internet connections that are available. 

The primary difference between them is whether you need to connect a cable to your computer to access 

the internet connection or not. The secondary difference is the speed with which information is transmitted 

and received over the connection. The exact steps used to create your computer’s connection to the 

Internet will be provided to you by your Internet Service Provider. Most often, you will create the internet 

connection for the PC when you first perform the set up of Windows. 

 Once you have created the connection, you can view your connection information by opening the 

“Control Panel” and then clicking the “Network and Internet” hyperlink to open a listing of hyperlinks in the 

“Network and Internet” section that allow you to create or view the network and Internet connection settings 

for your computer. 

9.5- Windows Defender in Windows 8: 

 

 While the Internet provides instant communication and information, there is a risk for your computer. 

Computers can transmit and receive computer viruses and other harmful types of malware (bad software) 

that can damage your computer or pose information security risks when connected to the Internet. For this 

reason, it is absolutely essential that your computer be up-to-date with its Windows Updates and also 

protected by some type of anti-virus program. 

 Windows Defender, previously known as Microsoft Security Essentials, is a free anti-virus, anti-

spyware, and anti-malware program that is installed by default in Windows 8. Note that you should not have 

any other type of anti-virus program installed if you choose to use this program in order to avoid conflicts 

with the software. 

 With Windows Defender, you download periodic updates to the program through Windows Update 

so that it stays current with its anti-virus information. You can also use it to scan your computer’s file and 

folders on a regular basis for any viruses or malware threats that are present. 

 To access Windows Defender, right-click in the empty area within the “Start” screen, click the “All 

apps” button, and then click the “Windows Defender” app icon to open Windows Defender. On the “Home” 

tab, you can select a type of scan to perform and then click the “Scan now” button to scan the files on your 

computer for infection. You can click the “Update” tab to view your virus definitions and then click the 

“Update” button to manually update the software, if needed. You can click the “History” tab to view any 

items that have been detected as malicious by Windows Defender. You can click the “Settings” tab to set 

the default settings and behaviors of the program. Here you can select a setting at the left side of the tab, 

and then choose your desired settings for that category at the right. When you are done, you can click the 

“Save changes” button at the bottom of the program to save your changes or you can simply click the “x” in 

the upper-right corner to close without saving changes if you did not make any. 
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ACTIONS- 

Using the Internet 
USING THE DESKTOP INTERNET EXPLORER 10 IN WINDOWS 8: 

 

1. Connect to the Internet. 

2. To open the desktop version of Internet Explorer 10 in Windows 8, click the Internet Explorer 10 button 

in the Windows taskbar. 

3. When the browser window opens you will find the window to be similar to many of the other windows 

you have opened. There is a “Title Bar” at the very top of the window that will tell you what page you are 

looking at. At the far right there are three buttons to “Minimize," “Maximize,” and “Close” the browser. 

4. The next bar contains the navigation buttons that allow you move back and forward through the web 

pages that you have visited. 

5. The large white text box to the right is the “Address Bar.” This bar displays the web page address of the 

page on your screen. You can type in the address of any page you want to go to here and either click 

the “Go” button, which is displayed as an arrow button that then appears at the end of the bar, or press 

“Enter” on your keyboard to go to the web page address that you have entered.  

6. In the center of the window is where you will view the web page. Often you will find scroll bars at the 

right and bottom of this area, so you can scroll through to see the entirety of the web page. 

7. While you may often enter web page addresses into the address bar in order to visit web sites that you 

are familiar with, you may also need to search the web for web pages that may contain content that you 

are looking for. To do this in Internet Explorer 10, which comes with Windows 8 computers, you can 

simply enter the words or phrases for which you want to find matching web pages directly into the 

“Address Bar.” 

8. Then click the “Go” button, or press the “Enter” key on your keyboard, in order to display a listing of 

related hyperlinks that you can click in order to view the associated  web page. 

9. As you move from page to page, you can use the “Back” and “Forward” button in the upper left corner of 

the window to move back to the results of the web search. 

10. You can also click on a tab shown at the top of the page and then open a new web page on a separate 

tab within Internet Explorer 10. 

11. You can then click between the open tabbed windows in the program, so that you can easily keep 

information in view. 

12. You can close any tabbed page within the program by clicking the small “x” button at the right end of 

any tab shown. 

13. Also note that if you are trying to find specific text within a web page that is displayed within Internet 

Explorer, click the “Tools” button that is displayed as a cog button in the upper-right corner of the 

window, roll over the “File” command in the drop-down menu that appears, and then click the “Find on 

this page” command from the side menu that appears. 

14. Doing that will open a “Find” bar at the top of the window, below the “Address Bar,” where you can enter 

the text to find on the page. 

15. You can then click the “Previous” and “Next” buttons to jump to the different occurrences of the text 

within the page. 

16. You can then click the “x” button at the left end of the “Find” bar to close it when you are finished. 
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ACTIONS- 

Using the Internet 
USING THE INTERNET EXPLORER 10 APP IN WINDOWS 8: 

 

1. Click the Internet Explorer 10 app icon in the Start screen in order to open a new browser window. 

2. At the bottom of the browser window you will see a black bar that contains the buttons that you will need 

to use in order to view web pages. The buttons you will see from left to right are the “Back” button, the 

application or web page icon, the “Address Bar,” the “Refresh” button, the “Pin to Start” button, the 

“Page tools” button, and the “Forward” button. 

3. To view a web page, you type the desired URL address into the “Address Bar.” When you have finished 

typing the URL, you can either press the “Enter” key on your keyboard or tap or click the “Go” button 

that will appear at the right end of the “Address Bar” when you begin typing the URL. 

4. Note that as you begin typing the URL address, Internet Explorer 10 will display web pages that it thinks 

you may want to visit, based on what you type and web pages that you have previously visited, as icons 

shown above the address bar. If one of these suggestions shows the URL that you wish to visit, you can 

simply click or tap on the icon shown within the window to display that web page in the web browser 

window instead of typing the URL address. 

5. As you view the different web pages within the browser window, you can use the buttons in the black 

bar at the bottom of the page to help you navigate through the pages you have visited. 

6. You can click the “Back” button to return to the previously viewed web page. 

7. If you click the “Back” button, you can click the “Forward” button to move forward to the web page that 

you left. 

8. You can click the “Refresh” button to refresh the content shown within the web page, if needed. 

9. If you wish to pin a particular web page that you are viewing to your Start screen so that you will not 

have to enter the address again, you can display the web page to pin within the browser window and 

then click the “Pin site” button. 

10. You can then select either “Pin to Start” or “Add to favorites” to either pin the page to your “Start” screen 

or add the page to your “Favorites” site list.. 

11. You can click the “Page tools” button to display a small pop-up menu of commands that assist you with 

your web pages. 

12. You can click the “Find on page” command to display a search bar within the black bar at the bottom of 

the page that will allow you to search for specific text within a web page. 

13. Simply enter the text to find within the “Find” text box. 

14. The text that you type will appear highlighted within the web page. 

15. You can then click the “Previous” and “Next” buttons to search for previous and next occurrences of that 

text within the web page. 

16. When you are finished, you can click the “Close” button. 

17. You can also click the “View on the Desktop” command to open the selected web page using the 

Desktop version of Internet Explorer 10. This will allow you to view the web page using a copy of 

Internet Explorer that allows for “add-ins” to be installed, so that you can view web pages that use Flash 

content and other web page extensions. 

18. Note that when you are viewing a web page, you can click into the page to make the small black bar at 

the bottom disappear. You can then scroll through the page with an unobstructed view. 

19. You can also place your mouse pointer at the top of the page and right-click or swipe in from the top of 

the app to view the small black bar at the bottom, as well as a new black bar at the top of the page. The 

black bar at the top of the page allows you to view any opened web browser windows as tabs. 

20. You can open a new web browser window by clicking the “+” button at the right side of the bar. 

21. You can then enter a new URL address into the new window that opens. 

 (cont'd.) Sa
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ACTIONS- 

Using the Internet 
USING THE INTERNET EXPLORER 10 APP IN WINDOWS 8 (CONT'D.): 

 

22. You can switch between the opened tabbed windows by clicking the tab icon shown at the top of the 

page in the black bar. 

23. You can close an open tabbed web page by clicking the “X” button shown on the tab icon. 

24. You can click the “…” button to display a menu of commands. 

25. You can select the “New InPrivate tab” command to open a new browser window that will not store any 

data about your browsing session, such as which web sites you have visited. You can read about 

InPrivate browsing within the new window that opens. 

26. You can select the “Close tabs” command in order to close all open browser windows, except for the 

last window opened. 

27. You can right-click at the top of the app, or swipe up from the black bar, when the black bar is displayed 

to close the black bars shown at the top and bottom of the app window. 

28. When you want to close the app, click and drag from the top of the app window to the bottom of the 

window to close the app by clicking and dragging it off screen. 

VIEWING NETWORK AND INTERNET CONNECTION SETTINGS: 

 

1. Once you have created an internet connection, you can view your connection information by opening 

the “Control Panel” and then clicking the “Network and Internet” hyperlink to open a listing of hyperlinks 

in the “Network and Internet” section that allow you to create or view the network and Internet 

connection settings for your computer. 

USING WINDOWS DEFENDER IN WINDOWS 8: 

 

1. Windows Defender, previously known as Microsoft Security Essentials, is a free anti-virus, anti-spyware, 

and anti-malware program that is installed by default in Windows 8. Note that you should not have any 

other type of anti-virus program installed if you choose to use this program in order to avoid conflicts 

with the software. 

2. With Windows Defender, you download periodic updates to the program through Windows Update so 

that it stays current with its anti-virus information. You can also use it to scan your computer’s file and 

folders on a regular basis for any viruses or malware threats that are present. 

3. To access Windows Defender, right-click in the empty area within the “Start” screen, click the “All apps” 

button, and then click the “Windows Defender” app icon to open Windows Defender. 

4. On the “Home” tab, you can select a type of scan to perform and then click the “Scan now” button to 

scan the files on your computer for infection. 

5. You can click the “Update” tab to view your virus definitions and then click the “Update” button to 

manually update the software, if needed. 

6. You can click the “History” tab to view any items that have been detected as malicious by Windows 

Defender. 

7. You can click the “Settings” tab to set the default settings and behaviors of the program. Here you can 

select a setting at the left side of the tab, and then choose your settings for that category at the right. 

8. When you are done, you can click the “Save changes” button at the bottom of the program to save your 

changes or you can simply click the “x” in the upper-right corner to close without saving changes if you 

did not make any. Sa
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EXERCISES- 

Using the Internet 
Purpose: 

 

1. To see the basics of finding and opening a web page on the Internet.  

Exercises: 

 

Note: Your computer must be connected to the Internet in order to complete this Exercise. 

 

1. If using Windows 8, click the “Desktop” app tile within the “Start” screen to open the “Desktop.” 

2. Click the “Internet Explorer” button shown in the Windows Taskbar in the “Desktop.” 

3. Click into the “Search” text box and then enter “Windows 8.” 

4. Click the “Search” button at the right end of the “Search” text box. 

5. Click on any desired entry in the list to visit the selected page. 

6. Click into the “Address Bar” and then type www.teachucomp.com. 

7. Then press the “Enter” key on your keyboard. 

8. Click the “Back” button to return to the previous web page. 

9. Click the “X” button in the upper right corner of the “Internet Explorer” window’s title bar to close it. 
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CHAPTER 10- 

Printing Information 

10.1- Selecting a Printer  

 

10.2- General Printing Options 

 

10.3- Managing Print Jobs 
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Printing Information 

10.1- Selecting a Printer: 

 

 If you have more than one printer or are on a network, you may have the option of printing to more 

than one printer. When you are using a program like Microsoft Word, you may want to print a hard copy of 

your document. In most Windows-based programs, you can print the current document by clicking the 

“Print” button in the toolbar or Ribbon. This will often display a “Print” dialog box or “Print” page, where you 

can change your printer choice. 

 You can also set a “default” printer in Windows, which is the printer that all print jobs will be sent to if 

you don’t make a specific choice in the matter when printing. To do this, you must access the “Devices and 

Printers” folder in Windows 8 and 7 or the “Printers” folder in Windows Vista. You can open this folder by 

opening the “Control Panel” and then clicking the “View devices and printers” hyperlink in Windows 8 and 7 

or the “Printer” hyperlink in Windows Vista in order to open a window where you can see all the printers 

installed and available. Then right-click on the icon of the printer that you want to make the “default” printer, 

and click the “Set as default printer” command from the pop-up menu that appears. This should place a 

check mark next to the printer that you selected. At that point, you can close the window. 

10.2- General Printing Options: 

 

 Depending on which program you are printing from, the options that you may have for printing can 

vary slightly, but in general there are some things that you can almost always change about the printing 

options. 

 You may see the choice of setting a “Print Range.” Most programs allow you to print all pages, some 

pages, or just a single page of your document. Another common option is the “Number of copies.” You may 

also be able to “Collate” your copies by checking a checkbox for that feature. This allows you to print 

multiple collated copies. Once you have set any available printing options that you may have through your 

program, simply click the “Print” or “OK” button to start printing your document. 

 When you print from Internet Explorer, you follow the same general pattern as when you print from 

other Windows programs. Within Internet Explorer, you often have additional options for printing that you 

can set on the “Options” tab. If you elect to “Print all linked documents,” you can print any pages that are 

linked to the page that you are currently printing. Choosing the “Print frames” option allows you to print 

selected frames within a framed site. Just know that if this is an option, it would be best to select “All frames 

individually,” if you are worried about the information not appearing when you print it. You can also check 

the checkbox for “Print table of links” to print a table of the hyperlinks within the page. 

10.3- Managing Print Jobs: 

 

 Sometimes you need to check the status of a print job that you have sent to a printer. To do this, 

double-click the “Printer” icon that often appears in the lower right corner notification area of the Windows 

Taskbar when the print job is being sent. In the “Printer” window that appears, select you print job from the 

list and you will be able to see its status. 

 If you need to cancel the print job, right-click on it and select “Cancel” from the pop-up menu that 

appears. In a few moments the print job will disappear. You can then close the “Printer” window, and the 

little printer icon that was in the lower right corner of the Windows taskbar will disappear as well. 
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ACTIONS- 

Printing Information 
SELECTING A DEFAULT PRINTER: 

 

1. You can also set a “default” printer in Windows, which is the printer that all print jobs will be sent to if 

you don’t make a specific choice in the matter when printing. To do this, you must access the “Devices 

and Printers” folder in Windows 8 and 7 or the “Printers” folder in Windows Vista. 

2. You can open this folder by opening the “Control Panel” and then clicking the “View devices and 

printers” hyperlink in Windows 8 and 7 or the “Printer” hyperlink in Windows Vista in order to open a 

window where you can see all the printers installed and available. 

3. Then right-click on the icon of the printer that you want to make the “default” printer, and click the “Set 

as default printer” command from the pop-up menu that appears. This should place a check mark next 

to the printer that you selected. 

4. At that point, you can close the window. 

GENERAL PRINTING OPTIONS: 

 

1. Depending on which program you are printing from, the options that you may have for printing can vary 

slightly, but in general there are some things that you can almost always change about the printing 

options. 

2. You may see the choice of setting a “Print Range.” Most programs allow you to print all pages, some 

pages, or just a single page of your document. 

3. Another common option is the “Number of copies.” This setting determines the number of copies of the 

current document to print. 

4. You may also be able to “Collate” your copies by checking a checkbox for that feature. This allows you 

to print multiple collated copies. 

5. Once you have set any available printing options that you may have through your program, simply click 

the “Print” or “OK” button to start printing your document. 

6. When you print from Internet Explorer, you follow the same general pattern as when you print from other 

Windows programs. When you print from Internet Explorer, you follow the same general pattern as 

when you print from other Windows programs. Within Internet Explorer, you often have additional 

options for printing that you can set on the “Options” tab. 

7. If you elect to “Print all linked documents,” you can print any pages that are linked to the page that you 

are currently printing. 

8. Choosing the “Print frames” option allows you to print selected frames within a framed site. Just know 

that if this is an option, it would be best to select “All frames individually,” if you are worried about the 

information not appearing when you print it. 

9. You can check the checkbox for “Print table of links” to print a table of the hyperlinks within the page. 

MANAGING PRINT JOBS: 

 

1. To check the status of a print job that you have sent, double-click the “Printer” icon that appears in the 

lower right corner notification area of the Windows Taskbar when the print job is being sent. 

2. In the “Printer” window, select you print job from the list and you will be able to see its status. 

3. If you need to cancel the print job, right-click on it and select “Cancel” from the pop-up menu that 

appears. In a few moments the print job will disappear. 

4. You can then close the “Printer” window. Sa
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EXERCISES- 

Printing Information 
Purpose: 

 

1. There are no exercises for this chapter.  
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Windows 8, 7 & Vista Keyboard Shortcuts 

General Commands Key 

Copy Ctrl + C or Ctrl + Insert 

Cut Ctrl + X or Shift + Del 

Paste Ctrl + V or Shift + Insert 

Undo Ctrl + Z or Alt + Backspace 

Delete  Delete 

Delete Permanently, 

Bypassing the Recycle Bin 

Shift + Delete 

Copy Selected Item Ctrl while dragging an item 

Create Shortcut to Selected 

Item 

Ctrl + Shift while dragging an item 

Rename Selected Item F2 

Move the Insertion Point to 

the Beginning of the Next 

Word 

Ctrl + Right Arrow 

Move the Insertion Point to 

the Beginning of the 

Previous Word 

Ctrl + Left Arrow 

Move the Insertion Point to 

the Beginning of the Next 

Paragraph 

Ctrl + Down Arrow 

Move the Insertion Point to 

the Beginning of the 

Previous Paragraph 

Ctrl + Up Arrow 

 

Highlight a Block of Text Ctrl + Shift with any of the Arrow 

Keys 

Select Multiple Items in a 

Window or on the Desktop, 

or Select Text within a 

Document 

Shift with any of the Arrow Keys 

Select All Ctrl + A 

Search for a File or Folder F3 

View Properties for the 

Selected Item 

Alt + Enter 

Close the Active Item, or 

Quit the Active Program 

Alt + F4 

Display Properties of a 

Selected Object 

Alt + Enter 

General Commands Key 

Open the Shortcut Menu 

for the Active Window 

Alt + Spacebar 

Close the Active 

Documents in Programs 

that Allows Multiple 

Documents to be Opened 

Ctrl + F4 

Switch Between Open 

Windows 

Alt + Tab 

Cycle Through Items in the 

Order They were Opened 

Alt + Esc 

Cycle Through Screen 

Elements in a Window or 

on the Desktop 

F6 

Display the Address bar list 

in “Computer” or “Windows 

Explorer” 

F4 

Display the Shortcut Menu 

for the Selected Item 

Shift + F10 

Display the System Menu 

for the Active Menu 

Alt + Spacebar 

Display the “Start” Menu Ctrl + Esc 

Display a Corresponding 

Menu 

Alt + Underlined Letter in a 

Menu Name 

Carry Out the 

Corresponding Command 

Underlined Letter in a 

Command Name on an Open 

Menu 

Activate the Menu Bar in 

the Active Program 

F10 

Open the Next Menu to the 

Right, or Open a Submenu 

Right Arrow 

Open the Next Menu to the 

Left, or Close a Submenu 

Left Arrow 

Refresh the Active Window F5 

View the Folder One Level 

Up in “Computer” or 

“Windows Explorer” 

Backspace 

Cancel the Current Task Esc 

Prevent the CD from 

Automatically Playing 

Shift when Inserting CD into 

CD-ROM Drive Sa
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Windows 8, 7 & Vista Keyboard Shortcuts 

Dialog Box Commands Key 

Move Forward Through Tabs Ctrl + Tab 

Move Backward Through 

Tabs 

Ctrl + Shift + Tab 

Move Forward Through 

Options 

Tab 

Move Backward Through 

Options 

Shift + Tab 

Carry Out the Corresponding 

Command or Select the 

Corresponding Option 

Alt + Underlined Letter 

Carry Out the Command for 

the Active Option or Button 

Enter 

Select or Clear the Check 

Box if the Active Option is a 

Check Box 

Spacebar 

Select a Button if the Active 

Option is a Group of Option 

Buttons 

Arrow Keys 

Display Help F1 

Display the Items in the 

Active List 

F4 

Open a Folder one Level Up 

if a Folder is Selected in the 

“Save As” or “Open” Dialog 

Box 

Backspace 

Create a new program 

instance in Taskbar 

Middle mouse button click OR 

Shift + Left Click 

Show classic right-click 

program menu in Taskbar 

Shift + Right Click 

Pop-up System Functions in 

8 

         + X 

Display options in 8          + P 

Ease of Access in 8          + U 

Take Desktop Screenshot in 

8 

         + PrtSc (Print Screen key) 

Unlock Lock Screen in 8 Ctrl 

Shut Down Options Alt + F4 

Natural Keyboard 

Shortcuts 

Key 

Display or hide the “Start” 

Menu in Win Vista & 7 or 

Start screen in Win 8 

Show the Desktop         + D 

Minimize All Windows         + M 

Restores Minimized 

Windows 

        + Shift + M 

Open Windows Explorer         + E 

Search for a File or Folder         + F 

Display Windows Help         + F1 

Open the “Run” Dialog Box         + R 

Display Shortcut Menu for 

the Selected Item 

       

Flip Windows in 3D in Vista 

and 7 

         + TAB 

Aero Peek (Temporarily 

Shows Desktop) 

         + Spacebar (in Vista & 7) 

         + , (comma in Windows 8) 

Snap Window Left          + Left Arrow 

Snap Window Right          + Right Arrow 

Zoom Desktop In          + ’+’ (Plus sign) 

Zoom Desktop Out          + ’-’ (Minus sign) 

Open Charm Bar in 8          + C 

Open Settings in 8          + I 

Search Settings in 8          + W 

Search Apps in 8          + Q 

Show App Bar when in 

Start Screen in 8 

         + Z 

Show Devices in 8          + K 

Lock Screen in 8          + L 

Share options in 8          + H 

Task Manager Ctrl + Alt + Del 
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